
 

Business Portal for Microsoft Dynamics® GP 2010
Administrator’s Guide

Release 5.0



Copyright Copyright © 2010 Microsoft. All rights reserved.

Limitation of liability This document is provided “as-is”. Information and views expressed in this document, including 
URL and other Internet Web site references, may change without notice. You bear the risk of using 
it.

Some examples depicted herein are provided for illustration only and are fictitious. No real 
association or connection is intended or should be inferred.

Intellectual property This document does not provide you with any legal rights to any intellectual property in any 
Microsoft product.

You may copy and use this document for your internal, reference purposes.

Trademarks Microsoft, Active Directory, ActiveX, Excel, Internet Explorer, Microsoft Dynamics, Outlook, 
SharePoint, SQL Server, Windows, and Windows Server are trademarks of the Microsoft group of 
companies. FairCom and c-tree Plus are trademarks of FairCom Corporation and are registered in 
the United States and other countries.

All other trademarks are property of their respective owners.

Warranty disclaimer Microsoft Corporation disclaims any warranty regarding the sample code contained in this 
documentation, including the warranties of merchantability and fitness for a particular purpose.

License agreement Use of this product is covered by a license agreement provided with the software product. If you 
have any questions, please call the Microsoft Dynamics GP Customer Assistance Department at 
800-456-0025 (in the U.S. or Canada) or +1-701-281-6500.

Publication date May 2010



A D M I N I S T R A T O R ’ S G U I D E i

Contents

Introduction .................................................................................................................................................2
What’s in this manual...................................................................................................................................2

Symbols and conventions ............................................................................................................................3

Additional resources ....................................................................................................................................4

Technical support..........................................................................................................................................4

Send us your documentation comments ...................................................................................................5

Part 1: Getting started ..................................................................................................................8

Chapter 1: Business Portal overview ................................................................................. 9
Business Portal features ...............................................................................................................................9

Business Portal site structure ....................................................................................................................10

Business Portal navigation ........................................................................................................................ 11

Business Portal pages .................................................................................................................................12

Content management .................................................................................................................................14

Chapter 2: Before you begin.................................................................................................... 17
Administrator considerations ...................................................................................................................17

Plan content .................................................................................................................................................17

Business Portal setup checklist .................................................................................................................18

Start Business Portal ...................................................................................................................................18

Chapter 3: General settings ..................................................................................................... 21
Specify the SMTP server and Business Portal e-mail address..............................................................21

Set up Microsoft Dynamics GP Terminal Server access ........................................................................21

Change Business Portal regional settings................................................................................................22

Chapter 4: Managing e-mail notifications .................................................................. 25
Notifications ................................................................................................................................................25

Automatic substitutions.............................................................................................................................25

Add or modify an e-mail notification ......................................................................................................25

Part 2: Security ...................................................................................................................................28

Chapter 5: Security overview ................................................................................................. 29
Elements of Business Portal security .......................................................................................................29

Windows SharePoint Services security overview ..................................................................................30

Microsoft Business Framework security overview................................................................................30

Web service security overview..................................................................................................................31

User setup checklist ....................................................................................................................................32

Suggested role and group mapping.........................................................................................................32

The Microsoft Dynamics Security Synchronization Utility ..................................................................33

Chapter 6: Managing page security ................................................................................. 35
The Business Portal subsite .......................................................................................................................35

Security inheritance for pages and page libraries ..................................................................................36



ii A D M I N I S T R A T O R ’ S G U I D E

C O N T E N T S

Guidelines for assigning page permissions ............................................................................................38

Page security and navigation ....................................................................................................................38

Chapter 7: Managing SharePoint groups and permissions ........................ 39
SharePoint groups for Business Portal.....................................................................................................39

SharePoint permission levels for Business Portal ..................................................................................40

Add users to SharePoint groups...............................................................................................................40

View or modify a SharePoint group.........................................................................................................41

Chapter 8: Managing Microsoft Business Framework users..................... 43
Add users to MBF roles..............................................................................................................................43

How matching works in the Add Users wizard ....................................................................................45

Modify MBF user information ..................................................................................................................46

Change a user’s MBF role assignments ...................................................................................................47

Modify a user’s permissions .....................................................................................................................48

Remove MBF users .....................................................................................................................................48

Chapter 9: Managing Microsoft Business Framework roles ...................... 49
Roles overview ............................................................................................................................................49

Portal roles ...................................................................................................................................................50

Advanced roles............................................................................................................................................50

Create a portal role......................................................................................................................................51

Modify a role description...........................................................................................................................52

Modify the users associated with a portal role.......................................................................................52

Modify the permissions associated with a role ......................................................................................53

Copy a portal role .......................................................................................................................................53

Remove a portal role...................................................................................................................................54

Chapter 10: Managing data permissions ..................................................................... 55
Data permissions overview .......................................................................................................................55

Row-level restrictions.................................................................................................................................56

Data permission naming conventions .....................................................................................................57

Create a data permission............................................................................................................................57

Modify a data permission description.....................................................................................................58

Modify the roles associated with a data permission..............................................................................58

Modify access to individual entity properties ........................................................................................59

Change row-level restrictions for a data permission.............................................................................60

Look up queries based on a data permission .........................................................................................60

Check for and repair invalid queries .......................................................................................................61

Remove a data permission.........................................................................................................................62

Chapter 11: Managing web service users ................................................................... 63
Add users to web service roles .................................................................................................................63

Assign back office IDs for data access .....................................................................................................64



A D M I N I S T R A T O R ’ S G U I D E iii

C O N T E N T S

Part 3: Portal elements.............................................................................................................68

Chapter 12: Creating queries.................................................................................................. 69
Create a new query on a query page........................................................................................................69

Query operators ..........................................................................................................................................70

Advanced query restriction options.........................................................................................................71

Modify a query on a query page ..............................................................................................................71

View query page results.............................................................................................................................72

Change the appearance of query page results........................................................................................72

Print or export query page results............................................................................................................73

The result viewer query menu..................................................................................................................73

Create a new result viewer web part query ............................................................................................74

Modify a result viewer web part query ...................................................................................................74

Chapter 13: Organizing queries............................................................................................ 77
How queries are organized .......................................................................................................................77

Share a query among users........................................................................................................................78

Move a query...............................................................................................................................................79

Delete a query..............................................................................................................................................80

Rename a query...........................................................................................................................................80

Set query permissions ................................................................................................................................81

Set query folder permissions.....................................................................................................................81

Chapter 14: Managing web parts........................................................................................ 83
Web parts overview ....................................................................................................................................83

Web part connections overview................................................................................................................84

The web part gallery...................................................................................................................................84

Adding web parts to a page ......................................................................................................................85

Types of result viewer web parts ..............................................................................................................85

Result viewer configuration options........................................................................................................86

Configure a result viewer web part..........................................................................................................89

Create a SharePoint web part ....................................................................................................................90

Back Office Tasks web parts ......................................................................................................................90

Configure a tab web part ...........................................................................................................................91

Dynamics GP report viewer configuration options...............................................................................92

Configure a Dynamics GP report viewer web part ...............................................................................93

Result viewer communication behaviors ................................................................................................94

Connect result viewer web parts to one another....................................................................................94

Web part menu options..............................................................................................................................96

Part 4: Reports administration .................................................................................. 100

Chapter 15: Reports Catalog................................................................................................ 101
Assign report sets to centers....................................................................................................................101

Publish Microsoft Dynamics GP reports to Reports Catalog .............................................................102

How users view reports ...........................................................................................................................102

Assigned/not assigned reports...............................................................................................................103



iv A D M I N I S T R A T O R ’ S G U I D E

C O N T E N T S

Change the center site assigned to a report ..........................................................................................103

Change the MBF roles assigned to a report ..........................................................................................103

Chapter 16: Report Center ..................................................................................................... 105
Report Center overview...........................................................................................................................105

Microsoft Dynamics GP report libraries................................................................................................107

Security for Microsoft Dynamics GP report libraries ..........................................................................107

Publishing reports to the Report Center site.........................................................................................108

Viewing reports with versioning or content approval ........................................................................109

Part 5: The Business Data Catalog and Search ....................................112

Chapter 17: Business Data Catalog concepts ...................................................... 113
Business Data Catalog overview ............................................................................................................ 113

Business data web parts........................................................................................................................... 115

List pages and dashboard pages............................................................................................................. 115

Business data profiles ............................................................................................................................... 116

Assign the application pool identity to the BDC Administrator role ............................................... 117

Chapter 18: Search concepts................................................................................................119
Search overview ........................................................................................................................................ 119

Microsoft Dynamics GP data that can be searched..............................................................................120

About crawling content ...........................................................................................................................120

Crawl schedule guidelines ......................................................................................................................121

Making Search available to users ...........................................................................................................122

Chapter 19: Search setup and maintenance .......................................................... 123
Give the crawl account access to Microsoft Dynamics GP data.........................................................123

Adjust logging ...........................................................................................................................................124

Activate Search for a company ...............................................................................................................125

Securing search data .................................................................................................................................128

Repair or remove search data for a selected company........................................................................129

Remove search data for all companies...................................................................................................130

Change the default crawl schedule ........................................................................................................131

Part 6: Customizations ......................................................................................................... 134

Chapter 20: Customizing Business Portal ............................................................... 135
Create a new center site ...........................................................................................................................135

Create a page .............................................................................................................................................135

Customize navigation ..............................................................................................................................136

Remove access to a center site.................................................................................................................136

Chapter 21: Setting up a customer portal............................................................... 137
Customer portal checklist ........................................................................................................................137

Set up user accounts for external users..................................................................................................138

Restrict data for customers ......................................................................................................................138



A D M I N I S T R A T O R ’ S G U I D E v

C O N T E N T S

Part 7: Tuning, troubleshooting, and maintenance ....................... 142

Chapter 22: Performance tuning...................................................................................... 143
Performance-tuning overview ................................................................................................................143

Restrict access to long queries.................................................................................................................144

Page tuning ................................................................................................................................................144

Publish scheduled reports at off-peak times.........................................................................................144

Allow sufficient space for temporary Internet pages ..........................................................................145

Tune Windows SharePoint Services .......................................................................................................145

Application domain recycling.................................................................................................................145

Antivirus software and ASP.NET ...........................................................................................................146

SQL optimization ......................................................................................................................................146

Hardware requirements...........................................................................................................................147

Load balancing with multiple web servers...........................................................................................147

Chapter 23: Troubleshooting ............................................................................................... 149
Error message: An unexpected error has occurred..............................................................................149

Error message: Only one usage of each socket address is normally permitted...............................149

Domains aren’t listed in the Add Users wizard ...................................................................................150

Extending the query time-out value ......................................................................................................150

Configuration file not set up properly for the Add Users wizard.....................................................151

Chapter 24: Maintenance ........................................................................................................ 153
Change passwords....................................................................................................................................153

Back up Business Portal ...........................................................................................................................155

Repair Business Portal files .....................................................................................................................155

Initialize databases....................................................................................................................................155

Remove Business Portal ...........................................................................................................................156

Chapter 25: Configuration changes .............................................................................. 157
Configure Business Portal to use Secure Sockets Layer ......................................................................157

Disable Secure Sockets Layer for Business Portal ................................................................................160

Update SQL logon information for a moved database .......................................................................163

Part 8: Role and group reference ........................................................................... 166

Chapter 26: Default SharePoint groups and security permissions .. 167
BP Accounting Specialist .........................................................................................................................167

BP Administrator ......................................................................................................................................167

BP Employee..............................................................................................................................................167

BP Executive ..............................................................................................................................................168

BP Executive Reports - Company Name ..................................................................................................168

BP Field Service Reports - Company Name.............................................................................................168

BP Financial Reports - Company Name ...................................................................................................168

BP HR Administrator ...............................................................................................................................168

BP Human Resources Reports - Company Name ...................................................................................169

BP Internal User ........................................................................................................................................169

BP Inventory Manager .............................................................................................................................169



vi A D M I N I S T R A T O R ’ S G U I D E

C O N T E N T S

BP Inventory Reports - Company Name ..................................................................................................169

BP Manager................................................................................................................................................169

BP Manufacturing Reports - Company Name.........................................................................................170

BP Operations Manager ...........................................................................................................................170

BP Order Entry Clerk ...............................................................................................................................171

BP Payroll Administrator ........................................................................................................................171

BP Payroll Reports - Company Name.......................................................................................................171

BP Production Manager ...........................................................................................................................172

BP Purchasing Manager...........................................................................................................................172

BP Purchasing Reports - Company Name ...............................................................................................172

BP Report Publisher..................................................................................................................................172

BP Reports Catalog Administrator.........................................................................................................172

BP Sales Manager......................................................................................................................................173

BP Sales Reports - Company Name ..........................................................................................................173

BP Salesperson...........................................................................................................................................174

Chapter 27: Default portal roles and security permissions .................... 175
Accounting Specialist ...............................................................................................................................175

Administrator ............................................................................................................................................176

Executive ....................................................................................................................................................176

Fixed Assets Stakeholder .........................................................................................................................176

Human Resources Administrator...........................................................................................................177

Inventory Manager ...................................................................................................................................178

Operations Manager.................................................................................................................................179

Order Entry Clerk .....................................................................................................................................181

Payroll Administrator ..............................................................................................................................182

Production Manager.................................................................................................................................182

Purchasing Manager.................................................................................................................................183

Reports Catalog Administrator...............................................................................................................183

Sales Manager............................................................................................................................................184

User .............................................................................................................................................................185

Chapter 28: Default advanced roles and security permissions ........... 187
Customer....................................................................................................................................................187

Employee....................................................................................................................................................188

Manager......................................................................................................................................................188

Salesperson ................................................................................................................................................189

Vendor ........................................................................................................................................................190

Index ............................................................................................................................................................... 191



IN
T

R
O

D
U

C
T

IO
N



2 A D M I N I S T R A T O R ’ S  G U I D E

Introduction
Welcome to Business Portal for Microsoft Dynamics® GP, a web-based business 
application that you can use for your company intranet or as an extension to your 
company intranet. It provides users with secure and easy access to Microsoft 
Dynamics GP information, and to additional, browser-based applications that 
operate in Business Portal.

This guide is intended for administrators who:

• Set up Business Portal
• Provide company employees with access to Business Portal
• Manage daily use of Business Portal
• Create Microsoft Dynamics GP queries
• Generate reports

Depending on your organization, this may be one person or several.

The guide occasionally refers to the Business Portal Installation Guide, which is 
located in the Documentation folder on the Business Portal media. An 
understanding of that information is recommended. Also, it is important that you 
have a good understanding of concepts and administrative procedures for Internet 
Information Services (IIS) and Microsoft® Windows® SharePoint® Services or 
Microsoft Office SharePoint Server 2007.

Check for updated instructions
This information was current as of April 13, 2010. The documentation may be 
updated as new information becomes available. Check the Microsoft Dynamics GP 
online web sit e (http://go.microsoft.com/fwlink/?LinkId=185513) for the most 
current documentation.

This introduction includes the following sections:

• What’s in this manual
• Symbols and conventions
• Additional resources
• Technical support
• Send us your documentation comments

What’s in this manual

This documentation is divided into the following parts:

• Part 1, Getting started, provides an overview of Business Portal and its pages, 
and helps you understand your role as the administrator. This part also explains 
how to change global settings and manage Business Portal notification 
messages.

• Part 2, Security, provides procedures for setting up and maintaining Business 
Portal security through users, roles, and data permissions.

• Part 3, Portal elements, explains the types of queries and web parts that are 
available in Business Portal, and how you can maintain them for users.

http://go.microsoft.com/fwlink/?LinkId=185513
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• Part 4, Reports administration, contains information about storing and 
managing Microsoft Dynamics GP reports using either the Reports Catalog or 
the Office SharePoint Server Report Center site.

• Part 5, The Business Data Catalog and Search, explains how the Business Data 
Catalog allows Microsoft Dynamics GP data to be displayed and searched for in 
Office SharePoint Server.

• Part 6, Customizations, explains how to customize Business Portal. Information 
about creating a customer portal is included.

• Part 7, Tuning, troubleshooting, and maintenance, contains procedures you 
can use to improve Business Portal performance and to maintain and 
troubleshoot the installation.

Symbols and conventions

This manual uses the following symbols to make specific types of information stand 
out.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts, and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks. Typically, this 
includes cautions about performing steps in their proper order, 
or important reminders about how other information in 
Business Portal or Microsoft Dynamics GP may be affected.

Convention Description

Modifying user 
information

Italicized type indicates the name of a section or procedure.

File > Print The (>) symbol indicates a sequence of actions, such as 
choosing items from a menu or toolbar or clicking buttons in a 
window. This example directs you to go to the File menu and 
click Print.

Bold Bold type indicates navigation, tab names, menus, commands, 
buttons, field names, keywords, and functions.

TAB or ENTER Small capital letters indicate a key or a key sequence.

Business Data Catalog 
is available only if 
you’re using Business 
Portal with Office 
SharePoint Server 
2007, Enterprise 
Edition

Margin notes indicate when a topic applies only if you’re using 
a specific product or technology.
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Additional resources

In addition to this manual, the following documentation is included with this 
release of Business Portal.

Manuals
The following PDF manuals are included in the Documentation folder on the 
Business Portal installation media. 

After you’ve installed Business Portal, you can find links to these manuals and 
other printable Business Portal documentation in the Documentation Resources 
web part on the Administration Resources page (Site Actions > Site Settings > 
under Business Portal Administration, click Administration Resources).

Business Portal Installation Guide The Installation Guide 
(BusinessPortalInstallation.pdf) provides step-by-step instructions for installing 
Business Portal.

Business Portal User’s Guide The User’s Guide 
(BusinessPortalUsersGuide.pdf) helps users complete day-to-day tasks in Business 
Portal.

Application manuals User and Administrator manuals for each application 
installed in Business Portal are available in the Documentation folder.

Help
Help is available by clicking the Help icon button, located in the upper-right corner 
of any page. The help that is displayed depends on whether you open help from a 
Business Portal page, or a Windows SharePoint Services page, or Office SharePoint 
Server page.

Business Portal help When you click the Help icon button on a Business Portal 
page, the relevant help topic for that page is displayed. You can use the search field 
on the help page to search for information. You also can click the Home icon button 
to browse the contents of the help.

SharePoint help  Many of the features included in Business Portal—such as 
document libraries, lists, announcements, links, and alerts—are provided by 
Windows SharePoint Services. General information about these features is provided 
in the Administering Business Portal help. For more detailed information, refer to 
the Windows SharePoint Services help, which can be accessed by clicking the Help 
icon button in the upper-right corner of any Windows SharePoint Services page. If 
you’re using Office SharePoint Server, additional help related to the Office 
SharePoint Server features also will be available.

Technical support

You can contact Microsoft Dynamics GP Technical Support online or by telephone. 
Go to www.microsoft.com/dynamics and click the CustomerSource link or call 888-
477-7877 (in the U.S. and Canada) or 701-281-0555.

http://www.microsoft.com/dynamics
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Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Part 1: Getting started
This part of the documentation explains fundamental concepts you need to know to 
use Business Portal. Information about general Business Portal settings also is 
included.

• Chapter 1, “Business Portal overview,” contains general information about 
Business Portal.

• Chapter 2, “Before you begin,” contains a checklist for setting up Business 
Portal, and includes information that will help you understand your role as 
administrator.

• Chapter 3, “General settings,” contains information about global Business 
Portal settings. You can specify the e-mail server and set up Terminal Services 
access to Microsoft Dynamics GP.

• Chapter 4, “Managing e-mail notifications,” explains how to define the content 
of e-mail messages that are automatically generated and sent to customers or 
employees. (The notification system is used with and Requisition Management 
only.)
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Chapter 1: Business Portal overview
Overview information about Business Portal is provided in the following sections:

• Business Portal features
• Business Portal site structure
• Business Portal navigation
• Business Portal pages
• Content management

Business Portal features

Business Portal gives employees in your organization access to business 
information and allows them to participate in business processes using a web-based 
portal. Business Portal can be used as the basis for your company’s intranet. 
Business Portal provides the following features:

Windows SharePoint Services Business Portal is a collection of Windows 
SharePoint Services sites. All the functionality of Windows SharePoint Services web 
parts and web part pages are available, with additional features that are unique to 
Business Portal. SharePoint document libraries, lists, sites, and workspaces are used 
for content management.

Business Portal can be installed with Windows SharePoint Services only, or with 
Office SharePoint Server, which is based on Windows SharePoint Services. If 
Business Portal is installed with Office SharePoint Server, additional features, such 
as Search, are available.

To learn more about Windows SharePoint Services or Office SharePoint Server 
features, refer to your SharePoint documentation.

Role-based desktop Information and applications are organized by role, which 
means that users see only information that is relevant to their jobs.

Ad-hoc query capabilities Query pages provide the ability to search for and 
organize back office data through Business Portal. Links in the query results enable 
you to find related information quickly.

For more information about queries, refer to Chapter 12, “Creating queries.”

Browser navigation to Microsoft Dynamics GP windows With Business 
Portal, you can give users access to Microsoft Dynamics GP through Internet 
Explorer® (using Windows Terminal Services technology). Users can browse 
directly to a Microsoft Dynamics GP window without leaving Business Portal.

You may want to set up Terminal Services for remote users or users who need access 
to Microsoft Dynamics GP only occasionally. For more information, see Set up 
Microsoft Dynamics GP Terminal Server access on page 21.

Integrated web-based applications Business Portal applications expand the 
business tasks users can perform without having access to a full Microsoft 
Dynamics GP client installation. In Business Portal, web-based applications share 
data, a common logon, a common look and feel, and uniform navigation. 
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There are various integrating applications for Business Portal, which can be 
purchased and installed separately. For example, Key Performance Indicators (KPI) 
is an application that helps you calculate business metrics such as your company’s 
total sales, gross profit margin, and current ratio.

Business Portal site structure

Business Portal is composed of multiple web sites. The top-level site contains the 
main home page and the administration pages for Business Portal and its 
applications. Each Business Portal center is a subsite that contains pages related to a 
particular department or role.

The following illustration shows the Business Portal site structure. (You may have 
additional center subsites in your implementation.)

Each site in the Business Portal site collection has its own Site Settings page, 
accessed by clicking Site Actions > Site Settings.

To administer Business Portal or its applications, such as Key Performance 
Indicators, you must use the Site Settings page on the top-level Business Portal site. 
(The Business Portal Home page is on the top-level Business Portal site; from the 
Home page, you can access the top-level Site Settings page.) 

Because SharePoint groups exist across the entire site collection, you can administer 
users and groups from any site in the collection. For more information about 
SharePoint settings, refer to the Windows SharePoint Services Administrator’s 
Guide.

Finance

Center site

Human 

Resources 

Center site

Purchasing 

Center site

Sales

Center site

Top-level 

Business 

Portal site

Top-level 

SharePoint 

site

Search

Center site 

(Office

SharePoint 

Server only)

Report 

Center site 

(Office

SharePoint 

Server only)
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Business Portal navigation

To locate a page in Business Portal, use the horizontal menu at the top of the page 
and the Quick Launch on the left side of the page.

The top link bar
The top link bar contains links to Business Portal center sites. The top link bar works 
in one of the following ways:

• If you’re using Business Portal with Windows SharePoint Services only, the top 
level menu contains links to all Business Portal center sites. Click a center site 
link to go to that site’s home page.

• If you’re using Business Portal with Office SharePoint Server, Enterprise 
Edition, a Business Portal item appears in the top level of the menu. When you 
hold the mouse pointer over the Business Portal heading, links to center sites 
are displayed. 

If you click the Business Portal heading, the Business Portal Home page is 
displayed. Links to Center sites appear in the Quick Launch on the Home page. 
Click a center site link, either in the menu or in the Quick Launch, to go to that 
site’s home page.
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The Quick Launch
A Quick Launch is displayed on most pages in Business Portal. The Quick Launch 
provides navigation to the pages on a center site.

Business Portal pages

Business Portal comes with many pages set up and ready to use in your business. 
These predefined pages include the Business Portal Home page, center site home 
pages, information pages, list pages, dashboard pages, reports pages, and query 
pages.

Business Portal Home page
The Home page is the first page users see. It provides an overview of what is 
available to users in Business Portal, such as company information. You control 
which web parts appear on the Home page.

Center site home pages
A center site home page displays a summary of Microsoft Dynamics GP 
information related to the roles and groups that can view the center. Users see links 
to only the center sites associated with their specific SharePoint groups. For 
example, a user who is a member of the Salesperson SharePoint group will see the 
Sales site link.

Center site home pages provide a starting point for similar types of users to access 
information and tasks. Each center site home page includes web parts containing 
tasks, announcements, and center-related information. Center site home pages for 
functional areas such as Purchasing and Inventory may also include a Top 5 
Reports web part and links to query and reports pages.
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Information pages
Information pages combine a number of web parts—mainly result viewer web 
parts—to present current data from Microsoft Dynamics GP.

Typically, information pages display a list of related master records in a result 
viewer web part on the left, along with several related result viewer web parts to the 
right that display detail information related to the records in the list. For example, 
the Customer Summary information page contains result viewer web parts that 
show the following information:

• A list of customers
• Name, address, and contact information
• Balance information
• Sales history

When a customer is selected in the web part on the left side of the Customer 
Summary page, the other web parts on the page display contact information and 
current balances for the selected customer. 

List pages
List pages are available 
only if you’re using 
Business Portal with 
Office SharePoint 
Server, Enterprise 
Edition. 

List pages use the Office SharePoint Server Business Data List web part and the 
Microsoft Dynamics GP web service to present current back office data. For 
example, the Customer List page displays a current list of customers. List pages 
appear on most Business Portal center sites, and can be identified by the word “list” 
in their names.

You can click an item in the list to show detailed information about the selected 
object. For example, on the Salesperson List page, you can click on a salesperson in 
the list to view the business data profile, or detailed information, for that 
salesperson.

For more information about list pages, see List pages and dashboard pages on page 115.

Dashboard pages
Dashshboards bring together related information to help people perform their jobs 
effectively. Each dashboard may consist of a number of pages. For more information 
about dashboard pages, see List pages and dashboard pages on page 115.

The Executive Center site has dashboard pages for key performance indicators and 
metrics created using Microsoft SQL Server® Reporting Services 2008. Pages are 
organized for executives to show information in the following areas: Company 
Overview, Financial, Sales, Inventory, Manufacturing, Project, and Human 
Resources.

If you’re using Business Portal with Office SharePoint Server, Enterprise Edition, 
the My Sales Dashboard is available from the Sales Center site. The My Sales 
Dashboard includes the Sales and Commissions page, the Customer Balances page, 
and the Customer Documents page. These dashboards are available for salespeople 
and sales managers. The Sales Dashboard dashboard pages use Office SharePoint 
Server business data web parts to display data.
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Reports pages
Reports pages are 
available only if you’re 
using Business Portal 
with Windows 
SharePoint Services.

Reports pages display Microsoft Dynamics GP reports. These reports include .pdf, 
.txt, or .htm files that are updated and published regularly on a shared network 
location; they don’t provide real-time data. Reports pages are available on 
functional area center sites, such as Sales, Purchasing, Inventory, and Finance.

Users with access to Microsoft Dynamics GP choose which reports to publish and 
how often. The date and time a report was last updated appears in the Top 5 
Reports web part on the corresponding center site home page.

Query pages
You can use query pages to create customized ad-hoc queries that provide easy 
access to information stored in Microsoft Dynamics GP. Each Business Portal 
functional area center site has a related query page with a series of default data 
categories, called entities, to make searching easy. For example, the Sales center 
site’s query page includes entities such as Order and Customer. You can use queries 
on query pages or in result viewer web parts.

For more information about creating queries, refer to Chapter 12, “Creating 
queries.” For information about organizing queries for use in Business Portal, see 
Chapter 13, “Organizing queries.” 

Content management

Business Portal web parts are used to display data that originates in Microsoft 
Dynamics GP. In addition to this data, you may want to display other content that is 
used by your organization, but that is not stored in the accounting system. For 
example, you may want to create a web part that displays your company’s 
employee handbook and related Human Resources documents.

To display these other types of content, use Windows SharePoint Services content 
management features. The following Windows SharePoint Services content types 
can be used in Business Portal. You can add these content types to your pages as 
web parts.

For more information about any of the SharePoint content types listed here, refer to 
the SharePoint documentation.

• Libraries—A library is a folder where a collection of files is stored. The files 
often use the same template.

To help make your server more secure, we recommend not allowing libraries to contain 
.htm files. For details about blocking files with certain extensions from libraries, refer to 
the SharePoint documentation.

• Lists—A list is a collection of information that you share with team members. 
For example, you can create a sign-up sheet for an event, or you can create a list 
of ideas. A site can include a variety of lists—from contacts and calendars to 
announcements and issues.
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• Discussion boards—Discussion boards provide a forum for conversing about 
topics that interest your team. Team members can post comments and reply to 
each others’ comments, reducing the need for widely distributed e-mail 
threads. 

• Surveys—Surveys provide a way of polling team members. All you need to do 
is specify the questions and define how team members will enter their answers.

Users can set up SharePoint alerts, to be notified by e-mail of any changes made to 
applicable site content. Alerts are managed using the My Alerts on this Site page 
under Welcome [Your Name] > My Settings > My Alerts.

To manage document libraries, lists, and other SharePoint content, you’ll use 
SharePoint administration pages, available from the Site Actions menu.
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Chapter 2: Before you begin
As the Business Portal administrator, you’ll be setting up and organizing many 
elements: users, roles, permissions, pages, web parts, and customizable Business 
Portal settings. Administrative information and tasks associated with each of these 
elements are located on the Site Settings page of the top-level Business Portal site. 

It is important to understand SharePoint site management, content management, 
and web part functionality as you set up and implement Business Portal. Because 
Business Portal is a collection of Windows SharePoint Services sites, some Business 
Portal administration must be done through SharePoint. 

Review this documentation before proceeding with Business Portal setup. This 
information will help you understand your role as the administrator, and will help 
you get started with Business Portal.

The information is divided into the following sections:

• Administrator considerations
• Plan content
• Business Portal setup checklist
• Start Business Portal

Administrator considerations

The Business Portal administrator manages the entire Business Portal, including 
page and data access for all users. Following are considerations to keep in mind 
about the Business Portal administrator:

• In order to administer Business Portal, users must belong to both the 
Administrator MBF role and the BP Administrator SharePoint group.

• The user who installs Business Portal automatically is assigned to all Business 
Portal SharePoint groups.

Users assigned to the BP Administrator SharePoint group have the Full Control 
permission level for all pages in Business Portal.

• The user who installs Business Portal automatically is assigned to the 
Administrator MBF role for All Companies.

Users who are assigned to the Administrator MBF role for All Companies can 
run all queries and access all pages and data in Business Portal. If a user is 
assigned to the Administrator role for only one company, that user will not be 
able to run queries for other companies.

• The Administrator MBF role cannot be copied or removed.

Plan content

The first step in planning content for Business Portal is to do a content inventory. 
Create a list of the information, web applications, and web sites you already have 
that you want to make available. Identify the content, where it’s currently located, 
what format it’s in, and who maintains it.
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The next step is to identify the portal elements you’ll need to create and set up. You 
should identify:

• New pages that you need to create
• The location of each page in the site structure
• Web parts that will be on each page
• Who will create each page

You should also determine which users will need access to each page, and which 
users should be allowed to edit the content.

Business Portal setup checklist

After installing Business Portal, complete the following setup procedures, in the 
following order. Some items are optional, depending on your implementation.

Refer to the Business Portal Installation Guide for information about installing 
Business Portal and required software.

Start Business Portal

Start Business Portal by typing the Business Portal URL in the address field of 
Internet Explorer. Type http://<ServerName>/BP, where <ServerName> is the name 
of the web server where you’ve installed Business Portal. If you’ve configured 
Business Portal to use Secure Sockets Layer (SSL), the URL is https://ServerName/
BP. Depending on your Internet Explorer security settings, you may be required to 
log on.

Task For more information, see

1. Specify global Business Portal 
settings.

Chapter 3, “General settings”

2. Add users and assign them to roles 
and groups.

Add users to SharePoint groups on page 40
Add users to MBF roles on page 43
Add users to web service roles on page 63

3. Create shared queries. Chapter 12, “Creating queries”
Share a query among users on page 78

4. Create pages. Windows SharePoint Services or Office SharePoint 
Server documentation

5. Create document libraries, lists, and 
other content.

Content management on page 14
Windows SharePoint Services or Office SharePoint 
Server documentation

6. Set up Reports Catalog or Report 
Center and publish reports.

Chapter 15, “Reports Catalog”
Chapter 16, “Report Center”

7. Set up the Business Data Catalog, if 
you’re using Office SharePoint Server, 
Enterprise Edition.

Assign the application pool identity to the BDC 
Administrator role on page 117

8. Set up Search, if you’re using Office 
SharePoint Server, Enterprise Edition.

Give the crawl account access to Microsoft Dynamics 
GP data on page 123
Activate Search for a company on page 125
Change the default crawl schedule on page 131

9. Set up Business Portal applications. The .pdf files in the Documentation folder on the 
Business Portal installation media. You can view 
online help after you’ve installed the applications.

10. Prepare client workstations to run 
Business Portal, if you didn’t do so 
during the installation process.

Business Portal Installation Guide (available in the 
Documentation folder on the Business Portal CD)
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When you launch Business Portal for the first time, you will be prompted to install 
ActiveX® components that are needed to use certain Business Portal web parts.

On each client computer, the user who launches Business Portal for the first time 
must have access privileges to view and use cabinet (.cab) files. This user also must 
have access rights to the Downloaded Program Files folder. (The folder is typically 
in the Windows or the Winnt folder.) Typically, members of the Administrators and 
the Power Users groups have these rights.

For information about installing ActiveX components on workstations for members 
of the Users group, refer to the Business Portal Installation Guide.
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Chapter 3: General settings
This documentation describes how to set up Microsoft Dynamics GP access through 
Microsoft Windows Terminal Services. It also explains how to set up the e-mail 
address that Business Portal will send notifications from. Information about these 
settings is divided into the following sections:

• Specify the SMTP server and Business Portal e-mail address
• Set up Microsoft Dynamics GP Terminal Server access
• Change Business Portal regional settings

Specify the SMTP server and Business Portal e-mail 
address

If you are going to use e-mail notifications for Business Portal, use the E-Mail and 
Terminal Services page to specify the Simple Mail Transfer Protocol (SMTP) server 
that will manage these messages. You also must enter the address that Business 
Portal messages will be sent from. For more information, see Chapter 4, “Managing 
e-mail notifications.”

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click E-mail and Terminal Services. 
The E-mail and Terminal Services page appears.

3. Under the E-Mail heading, type the path to the SMTP server that will manage 
e-mail notifications for Business Portal.

4. Enter the originating e-mail address that Business Portal will use when sending 
e-mail notifications (the address in the From line of notification e-mails).

5. Click Save.

Set up Microsoft Dynamics GP Terminal Server access

Business Portal users can access Microsoft Dynamics GP windows through Business 
Portal using Windows Terminal Services (WTS), even if the Microsoft Dynamics GP 
client software isn’t installed directly on the computer. This is useful for remote 
users or users who need access to Microsoft Dynamics GP windows only 
occasionally. 

Most center site home pages include a Back Office Tasks web part that displays links 
to windows in Microsoft Dynamics GP. Clicking a task link opens a new Terminal 
Services session. For more information about these web parts, see Back Office Tasks 
web parts on page 90.

Use the E-mail and Terminal Services page to select options for Microsoft Dynamics 
GP access. When you use this page to set up Terminal Server access, Microsoft 
Dynamics GP opens by default only for those users who access the SQL server 
through Business Portal. We don’t recommend specifying the initial program and 
working directory through Windows Terminal Services; this opens Microsoft 
Dynamics GP by default for every user who logs on to the SQL server.

Use the following steps to set up Terminal Services access to Microsoft Dynamics 
GP.
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1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click E-mail and Terminal Services. 
The E-mail and Terminal Services page appears.

3. Specify the Windows Terminal Server to use for Internet Explorer access to 
Microsoft Dynamics GP.

4. Type the path and filename of the initial program to start when a user logs on to 
WTS, using the following format:

“C:\PathName\dynamics.exe” “C:\PathName\dynamics.set”

where PathName is the path to the Microsoft Dynamics GP application. (Be sure 
to include the quotation marks.)

5. Type the path to the working directory where the initial application should run, 
using the following format:

C:\PathName

where PathName is the path to the Microsoft Dynamics GP application.

6. Click Save.

Change Business Portal regional settings

Use the Regional Settings page to select a geographic region for Business Portal. The 
region you select determines how numbers, dates, times, and phone numbers are 
displayed. For example, if you select English (Australia), the information will 
displayed as shown in the following table.

The region you select does not affect how currency amounts are displayed in 
Business Portal. Currency amounts use the currency format (symbol, separators, 
and decimal places) defined in Microsoft Dynamics GP for each company. The 
region you select also does not affect the language in which text is displayed; text is 
always displayed in U.S. English.

The same regional settings apply to all users of Business Portal; individual users 
can’t have unique regional settings.

We don’t recommend changing anything on the Windows SharePoint Services Regional 
Settings page. Changes made on the Business Portal Regional Settings page affect the way 
information is displayed in SharePoint lists and document libraries, as well as in Business 
Portal result viewers. Changes made on the SharePoint Regional Settings page will affect 
only SharePoint lists and document libraries.

Number 123,456,789.00

Time 10:55:06 AM

Short Date 30/06/05

Long Date Thursday, 30 June 2005
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1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Regional Settings. The Regional 
Settings page appears.

3. Select a region.

Business Portal provides regional settings for only the countries displayed in 
the Region list.

4. Click Save.

When you change your region selection in Business Portal, the setting also is 
changed in SharePoint for the Business Portal web site. If you’re using multiple 
web servers, you need to select the region on only one server; the other servers 
will be updated automatically.
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Chapter 4: Managing e-mail notifications
If you’ve installed Requisition Management, the Notifications page is available to 
you. Use this page to set up and manage message templates that contain the 
information that will appear in e-mail messages that are automatically generated 
and sent to customers or employees.

Before you can send notifications, you must specify a mail server and the address 
that will appear in the From line on notification messages. For more information, 
refer to Specify the SMTP server and Business Portal e-mail address on page 21.

Information about notifications is divided into the following sections:

• Notifications
• Automatic substitutions
• Add or modify an e-mail notification

Notifications

Notifications are message templates; they contain the information that will appear 
in e-mail messages that are automatically generated and sent to customers or 
employees. The types of notifications that you can send depend on whether you 
have Requisition Management installed.

If you’ve installed Requisition Management, you can use the Notifications page to 
define the content of e-mail messages sent to employees who have submitted 
purchase requests.

For more information about the types of notifications available with each 
application, see the Requisition Management documentation.

Automatic substitutions

Use automatic substitutions to create e-mail messages that are automatically 
personalized for each recipient.

Automatic substitutions are variables you can use in your notifications. When 
messages are generated, the variables are replaced with the appropriate data for the 
recipient. For example, the variable “Customer Name” would be replaced with the 
specific customer name.

The type of notification you’re creating determines which automatic substitutions 
are available for the subject line and message body. For more information about 
each notification type, refer to the Requisition Management documentation.

For more information about setting up notifications, refer to Add or modify an e-mail 
notification on page 25.

Add or modify an e-mail notification

Notifications are message templates; they contain the information that is used to 
automatically generate e-mail messages you send to customers or employees. For 
each notification, you can specify a From address, subject line, and message body.
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1. Go to the Administration Home page on the Business Portal web site.

2. Under Requisition Management, click Notifications. The Notifications page 
appears.

3. To create a new notification, click Add. The Add E-mail Notification page is 
displayed.

To make changes to an existing notification, select the notification in the list and 
click Modify. The Modify E-mail Notification page is displayed.

4. Enter or change the name for the notification.

5. For a new notification, select the notification type.

For specific information about each notification type, see the Requisition 
Management documentation.

6. Enter or change the description for the notification.

7. Enter or change the e-mail address that will appear in the From line for 
messages that use this notification.

8. Enter or change the subject line for messages that use this notification.

You can insert variables from the Automatic Substitutions list. Click in the 
subject line where you want the variable to appear, then select the variable and 
click Insert in Subject.

Variables are substituted with the appropriate data when each e-mail message 
is generated. The notification type you selected determines which substitutions 
are available. For more information, refer to Automatic substitutions on page 25.

9. Compose the message body for messages that use this notification. 

You can insert variables from the Automatic Substitutions list. Click in the 
message body where you want the variable to appear, then select the variable 
and click Insert in Message.

10. Click Save.
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Part 2: Security
This part of the documentation explains how Business Portal security is set up and 
maintained through MBF roles, SharePoint groups, and web service roles. Because 
Business Portal uses Windows SharePoint Services functionality, you’ll be referred 
to information about managing SharePoint site users, groups, and permission 
levels.

The following information is included:

• Chapter 5, “Security overview,” describes the elements of Business Portal 
security.

• Chapter 6, “Managing page security,” explains how page security works in 
Business Portal.

• Chapter 7, “Managing SharePoint groups and permissions,” gives an overview 
of SharePoint permissions and how they’re used in Business Portal.

• Chapter 8, “Managing Microsoft Business Framework users,” describes setting 
up domain users as MBF users and mapping them to back office IDs.

• Chapter 9, “Managing Microsoft Business Framework roles,” explains how 
MBF roles are used to control access to Business Portal data. 

• Chapter 10, “Managing data permissions,” describes how to create and modify 
the data permissions used with MBF roles.

• Chapter 11, “Managing web service users,” provides instructions for setting up 
web service users and mapping them to back office IDs.
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Chapter 5: Security overview
This information is divided into the following sections:

• Elements of Business Portal security
• Windows SharePoint Services security overview
• Microsoft Business Framework security overview
• Web service security overview
• User setup checklist
• Suggested role and group mapping
• The Microsoft Dynamics Security Synchronization Utility

Elements of Business Portal security

There are two types of information to secure in Business Portal: SharePoint content 
and back office data. Windows SharePoint Services security is used to administer 
access to pages and other content stored in SharePoint, such as document libraries 
and announcements. The Microsoft Business Framework (MBF) is used to control 
access to data from Microsoft Dynamics GP. In some configurations, Web Services 
for Microsoft Dynamics GP also is used to control access to back office data.

For example, to grant access to the Vendors page on the Purchasing Center site, you 
could assign a user to the BP Purchasing Manager SharePoint group. To grant access 
to the data displayed in the web parts on the Vendors page, you would need to add 
the same user to an MBF role, such as the Purchasing Manager role.

Windows SharePoint Services
Business Portal is built on Windows SharePoint Services, and all page access and 
navigation is handled through WSS. Using WSS, you can give users and groups 
access to:

• Site collections
• Sites
• Page libraries
• Folders within page libraries
• Pages

Microsoft Business Framework
Most Microsoft Dynamics GP data in Business Portal is retrieved using the 
Microsoft Business Framework (MBF). To grant access to this data, you must assign 
users to MBF roles and data permissions. SharePoint groups and MBF roles 
correspond in many cases, but are not automatically synchronized. You must assign 
users to MBF roles and SharePoint groups using two separate procedures.

Web Services for Microsoft Dynamics GP
Business Data Catalog 
is available only if 
you’re using Business 
Portal with Office 
SharePoint Server, 
Enterprise Edition. 

The Business Data Catalog can retrieve back office data through Web Services for 
Microsoft Dynamics GP. To grant access to this data, you must assign users to web 
service roles. SharePoint groups, web service roles, and MBF roles are not 
automatically synchronized; you must assign users to web service roles, MBF roles, 
and SharePoint groups using three separate procedures.
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Windows SharePoint Services security overview

Windows SharePoint Services uses groups and permission levels to grant access to 
pages and content.

For more information about SharePoint groups and permission levels, and how 
they’re used in Business Portal, see Chapter 7, “Managing SharePoint groups and 
permissions,” and Chapter 26, “Default SharePoint groups and security 
permissions.”

SharePoint groups for Business Portal
SharePoint groups are used to grant access to Business Portal sites and pages. A 
number of predefined SharePoint groups are created when you install Business 
Portal. For example, the BP Salesperson and BP Sales Manager groups are installed 
by default and grant access to pages on the Sales Center site.

SharePoint permission levels for Business Portal
SharePoint permission levels define the level of control users have over securable 
items. Default SharePoint permission levels include Full Control, Design, 
Contribute, Read, and Limited Access.

Most Business Portal groups need only Read access to pages and other content. 
However, if a particular group must have the ability to add content, such as 
announcements, that group would require the Contribute permission level for the 
page or content.

SharePoint permission levels do not affect data entry on Business Portal pages. For 
example, users with Read access to the page where requisitions are entered can still 
enter requisitions. The ability to enter requisitions is controlled by the user’s MBF 
role assignments. The Read permission level applies only to modifying the page 
itself and any SharePoint content on the page.

Microsoft Business Framework security overview

In order to access the data and functionality on certain Business Portal pages, users 
must be assigned to MBF roles, which are sets of data permissions. Users in the 
Business Portal Administrator MBF role can add users to roles using the 
administration pages provided with Business Portal.

Data permissions
MBF uses business entities to retrieve data from the Microsoft Dynamics GP 
database. A business entity is a representation of a record from the Microsoft 
Dynamics GP back office. Customer, purchase order, and item are examples of 
entities.

Entities contain properties, or attributes, that refer to specific data. For example, 
customer ID, customer name, and customer contact are attributes of the customer 
entity. Data permissions allow users to see only certain properties or attributes of an 
entity.

For more information about data permissions, see Chapter 10, “Managing data 
permissions.”
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Roles
Use MBF roles to control access to data by assigning data permissions to them. 
When a data permission is assigned to a role, users in that role can access business 
entity data through that data permission. You can assign a user to a role in a specific 
company, multiple companies, or all companies.

There are two types of MBF roles: portal roles and advanced roles. A portal role is 
used to grant users who share job functions access to the same data. An advanced 
role identifies a specific user with an ID from Microsoft Dynamics GP, such as an 
employee, salesperson, customer, or vendor.

For more information about MBF roles, see Chapter 9, “Managing Microsoft 
Business Framework roles.”

Microsoft Dynamics GP IDs
Users in advanced roles are mapped to Microsoft Dynamics GP IDs, which provides 
access to specific information. For example, you can map Business Portal users to 
their employee IDs so they can access their own information, such as paystubs and 
available time off. Similarly, you can map a salesperson, customer, or vendor to a 
salesperson ID, customer ID, or vendor ID.

For more information, see Advanced roles on page 50.

Web service security overview

Web service security is 
used only if you’re 
using Business Portal 
with Office SharePoint 
Server, Enterprise 
Edition.

The Office SharePoint Server, Enterprise Edition version of Business Portal includes 
additional pages that retrieve data using Web Services for Microsoft Dynamics GP. 
If you’re using Business Portal with Office SharePoint Server, Enterprise Edition, 
you must set up users in web service roles, which are sets of web service operations 
and tasks, in addition to assigning them to MBF roles and SharePoint groups.

Security for the Microsoft Dynamics GP web service is controlled through the 
Microsoft Dynamics Security console, which is a snap-in for Microsoft Management 
Console (MMC). You must be designated as a Security Administrator for the 
security service in order to access the Dynamics Security Console and configure 
security settings.

For more information about web services or about using the Dynamics Security 
Console, see the Microsoft Dynamics GP Web Services Installation and 
Administration Guide.

A brief overview of web service security is provided below. 

Tasks and operations
Operations are the individual actions that can be performed by the Dynamics GP 
web service. Tasks provide a way to group related operations together.

The Dynamics GP Web Services application has multiple predefined tasks. For 
example, the View Commissions task contains the Query Salesperson Commissions 
and View Salesperson Commissions operations.

Roles
A web service role contains a set of operations, tasks, or other roles. Roles are used 
to group together the actions that can be performed by users who will be assigned 
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to the role. You can assign a user to a web service role in a specific company, 
multiple companies, or all companies.

The Dynamics GP Web Services application has multiple predefined roles. For 
example, the Sales Representative role contains tasks that would be performed by 
sales representatives, such as Manage All Sales Transactions and Manage 
Customers.

Microsoft Dynamics GP IDs
You can assign web service users to entity IDs to identify a specific user with an ID 
from Microsoft Dynamics GP, such as a salesperson or a customer. You must be 
designated as a Business Object User Assignment Administrator for the security 
service in order to assign users to entity IDs.

User setup checklist

Perform the following steps to give domain users access to Business Portal. 
Business Portal uses Windows authentication, so domain users will log on using 
domain user names and passwords.

Before setting up users, you should make a list of the names and domain aliases of 
the users you want to add, along with the information they need access to. This will 
help you determine which roles and groups to assign to each user.

Suggested role and group mapping

SharePoint groups provide access to pages; MBF and web service roles provide 
access to data. In Business Portal, SharePoint groups, web service roles, and MBF 
roles are not automatically synchronized. You must assign users to SharePoint 
groups, web service roles, and MBF roles separately or use the Security 
Synchronization Utility. For more information, see The Microsoft Dynamics Security 
Synchronization Utility on page 33.

The following table shows default SharePoint groups and the corresponding MBF 
roles and web service roles that users should be assigned to in order to effectively 
access default Business Portal pages. 

Task For more information, see

1. Set up users in Windows SharePoint 
Services.

Add users to SharePoint groups on page 40

2. Set up users in MBF. Add users to MBF roles on page 43

3. Set up users in web services, if 
necessary.

Add users to web service roles on page 63

SharePoint group MBF role Web service roles

BP Accounting Specialist Accounting Specialist AP Coordinator
AR Coordinator

BP Administrator Administrator Superuser

BP Employee Employee N/A

BP Executive Executive N/A

BP HR Administrator HR Administrator N/A

BP Internal User User N/A

BP Inventory Manager Inventory Manager WMS

BP Manager Manager N/A
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For more detailed information about page access for each SharePoint group, refer to 
Chapter 26, “Default SharePoint groups and security permissions.”

For more detailed information about data access for each MBF role, refer to Chapter 
27, “Default portal roles and security permissions,” and Chapter 28, “Default 
advanced roles and security permissions.”

For more detailed information about data access for web service roles, refer to the 
web service documentation.

The Microsoft Dynamics Security Synchronization 
Utility

Because Business Portal users must be given access to back office data and 
SharePoint content separately, you may want to use the Microsoft Dynamics 
Security Synchronization Utility to make setup easier.

The Security Synchronization Utility is a Microsoft Management Console snap-in 
that enables you to synchronize role membership between applications with 
different security infrastructures and different administration experiences.The 
following applications can be synchronized:

• Microsoft Dynamics GP
• Web Services for Microsoft Dynamics GP
• Business Portal (MBF roles)
• Windows SharePoint Services

You can synchronize from any supported application to any other supported 
application. For example, you can synchronize members of an MBF role with 
members of a SharePoint group, or vice versa.

You must have administrative permissions to the source and destination 
applications in order to perform the synchronization. You can run the 
synchronization manually, or you can set up a Windows scheduled task to run on a 
regular basis.

The Security Synchronization Utility is available as a download on CustomerSource 
(https://mbs.microsoft.com/customersource). For more information, refer to the 
documentation provided with the utility.

BP Operations Manager Operations Manager WMS
Purchasing Manager

BP Order Entry Clerk Order Entry Clerk Sales Representative

BP Payroll Administrator Payroll Administrator N/A

BP Production Manager Production Manager N/A

BP Purchasing Manager Purchasing Manager Purchasing Manager

BP Reports Catalog Administrator Reports Catalog Administrator N/A

BP Sales Manager Sales Manager Sales Manager - Self

BP Salesperson Salesperson Salesperson - Self

SharePoint group MBF role Web service roles

https://mbs.microsoft.com/customersource
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Chapter 6: Managing page security
This information is divided into the following sections.

• The Business Portal subsite
• Security inheritance for pages and page libraries
• Guidelines for assigning page permissions
• Page security and navigation

The Business Portal subsite

The Business Portal sites belong to a site collection—a hierarchical set of sites that can 
be managed together. Sites within a site collection have common features, such as 
shared permissions, galleries for templates, content types, and web parts, and they 
often share a common navigation. All sites in a site collection are stored together in 
the same Microsoft SQL Server database. For more information about site 
collections, see the Windows SharePoint Services documentation.

The top-level Business Portal site is a subsite of the top-level site in the collection. 
The Business Portal center sites are subsites of the top-level Business Portal site. For 
an illustration of the Business Portal site structure, see Business Portal site structure 
on page 10.

The Business Portal sites interact with the site collection in the following ways.

Navigation Navigation inheritance depends on how Business Portal was 
implemented.

• If you’re using Business Portal with Windows SharePoint Services only, the 
Business Portal sites have their own navigation that is not inherited from the 
site collection, as in the following illustration.
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• If you’re using Business Portal with Office SharePoint Server, Enterprise 
Edition, the Business Portal sites inherit navigation from the top-level site in the 
site collection, as in the following illustration.

For more information about Business Portal navigation, see Business Portal 
navigation on page 11.

Permissions The Business Portal sites do not inherit permissions from the top-
level site in the site collection. For more information about Business Portal 
permissions, see Security inheritance for pages and page libraries on page 36.

Galleries Template galleries, content type galleries, and web part galleries are 
shared between Business Portal sites and other sites in the collection.

Security inheritance for pages and page libraries

By default, permissions for securable objects in SharePoint (such as document 
libraries and lists) are inherited from the parent site, list, or library. In Business 
Portal, this means that users and groups automatically get access to page libraries 
when they get access to the site those page libraries belong to. In turn, users and 
groups automatically get access to pages when they get access to the page libraries 
those pages belong to.

To help make Business Portal more secure, in some cases it is necessary to set 
different permissions at the library or page level rather than inherit from the parent 
site or library. When you set permissions at the page library or page level, 
permission inheritance from the parent site or library is broken. The parent 
permissions are duplicated, and from that point forward, changes made to the 
parent do not roll down. 

For example, assume the Business Portal Sales Center site has two page libraries: 
Sales Pages 1 and Sales Pages 2. All groups that access the Sales Center site need 
access to the pages in the Sales Pages 1 library, which means that permissions can be 
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inherited from the Sales Center site. However, the Sales Pages 2 library contains a 
mix of pages for salespeople and sales managers. For the Sales Pages 2 library, page-
level permissions should be set on pages that must be restricted. 

In the illustration below, shaded items show where permission inheritance has been 
broken.

When you set page-level permissions on a particular page in a library, all of the 
other pages in the library can continue to inherit permissions.

You can’t break inheritance for a single user or group for a page. When you break 
inheritance for a page, no users or groups will automatically get access to the item; 
you must set permissions manually. 

You can return to inheriting permissions from the parent site or library at any time. 
If you return to inheriting permissions, any customized permissions you set at the 
library or page level will be discarded.

Sales Center site

Top-level Business Portal web site

Sales Center 

Home page

Sales Pages 2Sales Pages 1

Commission 

Totals page

Customer 

Summary page
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Guidelines for assigning page permissions

Use the following guidelines when setting up new pages and page libraries in 
Business Portal.

• We recommend assigning permissions to specific pages only when necessary, in 
order to maximize performance and minimize setup.

• For common pages that should be accessible by everyone in a site, store the 
pages in a library named Common with no permissions directly assigned.

For example, the home page of a site would reside in the Common page library 
because every user needs access to that page. Be sure that everything in the 
common page library is truly common and shared by all roles that will access 
the site.

• We don’t recommend creating multiple page libraries just to provide different 
security rights. Having multiple page libraries for security reasons would likely 
result in having multiple copies of pages.

Page security and navigation

When a user logs on to Business Portal, items in the Quick Launch and the top link 
bar appear based on the SharePoint groups that user belongs to. (For more 
information about the top link bar and the Quick Launch in Business Portal, see 
Business Portal navigation on page 11.)

For example, if a user is in the BP Employee and BP Salesperson SharePoint groups, 
that user will see the Company Center, Employee Center, Inventory Center, and 
Sales Center in the top link bar. In the Quick Launch on the Sales Center site, that 
user would see links to only those pages assigned to the BP Salesperson group.

Be sure to assign users to the correct roles for data access in addition to assigning 
them to SharePoint groups. If a user isn’t assigned to both the correct SharePoint 
group and the correct MBF or web service role for a page, the user will get an error 
when navigating to the page.
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Chapter 7: Managing SharePoint groups and 
permissions
SharePoint groups and permissions help you maintain access to sites, pages and 
other SharePoint elements in Business Portal. When a user logs on to Business 
Portal, Quick Launch and menu options appear based on the SharePoint groups 
assigned to that user. Permission levels determine the level of access users have to a 
securable object, such as Read or Contribute.

Information about managing SharePoint groups and permission levels for Business 
Portal is divided into the following sections:

• SharePoint groups for Business Portal
• SharePoint permission levels for Business Portal
• Add users to SharePoint groups
• View or modify a SharePoint group

SharePoint groups for Business Portal

SharePoint groups are used to maintain role-based access to SharePoint content in 
Business Portal, including sites, pages, and document libraries. Use SharePoint 
groups to logically group Business Portal users based on job responsibilities.

A number of SharePoint groups are installed with Business Portal. Most groups 
grant access to pages and page libraries within role-based sites. For example, the BP 
Salesperson group grants access to pages on the Sales Center site. The BP 
Administrator group provides access to all sites and pages in Business Portal. The 
BP Internal User group provides access to pages that are accessible to all internal 
Business Portal users, such as the top-level home page. All internal Business Portal 
users must belong to the BP Internal User group. (External users, such as customers, 
should not belong to this group.)

SharePoint groups cannot be used to control access to data from Microsoft Dynamics 
GP. You must maintain data access separately, using MBF or web services. 
SharePoint groups and MBF or web service roles correspond in many cases, but are 
not automatically synchronized.

In most cases, the default Business Portal SharePoint groups are not limited to a 
particular company in the back office. This means that if a group has access to a 
page, users in that group will be able to view the page no matter which company 
has been selected in Business Portal. However, because back office data access is 
company-specific, users will see data only for companies they have access to.

Business Portal SharePoint groups for the Report Center in Office SharePoint Server are 
company-specific. For more information, refer to Security for Microsoft Dynamics GP report 
libraries on page 107.

Because it is not efficient to directly maintain large numbers of user accounts, we 
don’t recommend assigning permissions at the individual level for Business Portal. 
We recommend assigning users to SharePoint groups as much as possible to avoid 
having to track individual user accounts.

For more information about managing groups, refer to Windows SharePoint 
Services documentation.
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SharePoint permission levels for Business Portal

Windows SharePoint Services permission levels set the level of access for 
SharePoint users and groups. The default SharePoint permission levels, in order 
from least to most access, are:

• Limited Access
• Read
• Contribute
• Design
• Full Control

Because most Business Portal users don’t need to modify SharePoint content, such 
as document libraries or lists, most default Business Portal SharePoint groups are 
assigned the Read permission level for the sites and pages they have access to. Some 
groups, such as the BP Human Resources Administrator group, are assigned to the 
Contribute permission level for certain pages and page libraries by default, which 
gives them the ability to add content, such as announcements, to those pages. The 
BP Administrator group is assigned to the Full Control permission level for all 
Business Portal sites.

The BP Administration permission level is a custom permission level created for 
Business Portal. This permission level gives Business Portal application 
administrators, such as the Requisition Administrator, access to the Site Settings 
page on the top-level Business Portal web site, where application administration 
pages are available.

To make your server more secure, we recommend that you assign users and groups 
to the BP Administration, Full Control, Design, and Contribute permission levels 
only when necessary.

SharePoint permission levels do not affect data entry on Business Portal pages. For 
example, users with Read access to the page where requisitions are entered can still 
enter requisitions. The ability to enter requisitions is controlled by the user’s MBF 
role assignments. The Read permission level applies only to modifying the page 
itself and any SharePoint content on the page.

For more information about managing permission levels, refer to Windows 
SharePoint Services documentation.

Add users to SharePoint groups

SharePoint groups are used to grant access to Business Portal sites, document 
libraries, and pages. When a user logs on to Business Portal, menu options and 
Quick Launch items appear based on the SharePoint groups that user belongs to.

Adding users to SharePoint groups is only one step in giving them access to Business 
Portal. Users also must be added to MBF or web service roles for data access.

For more information about managing groups, see the Windows SharePoint 
Services Administrator’s Guide.

1. Go to the Site Settings page for any Business Portal site.

2. Under Users and Permissions, click People and groups. Click Groups in the 
Quick Launch to display all groups.
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3. Click the name of the group that you want to add users to. Click New > Add 
Users.

4. Follow the instructions on the page to enter user names and select permissions.

5. Click OK to save your changes.

View or modify a SharePoint group

Use the People and Groups page in Windows SharePoint Services to view or change 
the properties of a SharePoint group. For more information about managing groups, 
see the Windows SharePoint Services Administrator’s Guide.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Users and Permissions, click People and Groups. The People and 
Groups page appears.

3. Click Groups in the Quick Launch to display all groups. Click the name of the 
group you want to modify.

• To remove users, click Actions > Remove Users From Group.

• To change group settings, such as the name, description, owner, or 
permission level, click Settings > Group Settings.

• To view the items a group has permission to, click Settings > View Group 
Permissions.
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Chapter 8: Managing Microsoft Business 
Framework users
Use the Users page to view and modify user properties, and to remove Microsoft 
Business Framework (MBF) users.

Information about managing MBF users is divided into the following sections:

• Add users to MBF roles
• How matching works in the Add Users wizard
• Modify MBF user information
• Change a user’s MBF role assignments
• Modify a user’s permissions
• Remove MBF users

Add users to MBF roles

In order to access the Microsoft Dynamics GP data on certain Business Portal pages, 
users must be assigned to MBF roles, which are sets of MBF data permissions. 

The Add Users wizard guides you through the process of adding users to MBF and 
assigning them to portal roles. You can also assign users to advanced roles and back 
office IDs using the wizard. For some roles, the wizard can match users to back 
office IDs automatically. 

You can add domain users or local users (users on the Business Portal server) to 
MBF.

Adding users to MBF roles is only one step in giving them access to Business Portal. Users 
also must be added to SharePoint groups for site and page access.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Users. The Users page appears.

3. Select Add new users from the task area of the User List web part. 

4. On the Welcome page, click Next.

5. Select a domain.

Click Add Manually to add users from a domain that is not listed. To manually 
add users, you must know their domain names and user IDs.

6. Choose whether to display all users within the selected domain or a group of 
domain users, such as users in a particular geographic location.

7. Select domain users to add to MBF, then click Next.
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8. Select the advanced roles that you want to assign users to. For more information 
about advanced roles, see Advanced roles on page 50.

Selecting an advanced role here does not automatically assign it to any users. After you 
click Next, you will be able to assign individual users to the selected advanced roles.

Click Next.

9. Assign users to advanced roles and back office IDs. 

Back office IDs containing an ampersand (&) can’t be assigned to Business Portal users 
using MBF advanced roles.

For each advanced role you selected, a separate wizard page will be displayed. 
On each role page you must: 

• Select a company.

• Select the users you want to assign to the selected advanced role in the 
selected company.

• Assign back office IDs to users.

Selecting a back office ID provides the user with access to specific Microsoft 
Dynamics GP information. For example, a user in the Employee role and 
associated with an employee ID has access to personal employee 
information, such as paystubs and time off, but does not have access to any 
other employee’s information.

For some roles, you can use the Match <Role> IDs button to match users to 
back office IDs automatically. For more information, see How matching works 
in the Add Users wizard on page 45.

You can also select a user and choose the Look Up ID button to assign an 
individual ID. In some cases, only the lookup button is available.

• If you used the automatic matching process, verify that the correct IDs are 
assigned to users, and fix any errors using the Look Up ID button.

• If necessary, select another company and repeat the process.

Click Next. Repeat this step for each advanced role.

10. Assign users to portal roles. Select a role and company, then select the users you 
want to assign to that role and company. 

All users added to MBF are assigned automatically to the User role. For more 
information about portal roles, see Portal roles on page 50.

Repeat this step for each role and company that you want to add users to. Click 
Next.
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11. Review the selections you’ve made in the Add Users wizard. To save the list of 
users and role assignments as a Microsoft Office Excel® file, click Copy to 
Excel. A file called New Users.xls is created on your desktop.

12. Click Finish. The new users are added to MBF roles. 

How matching works in the Add Users wizard

When you use the Add Users wizard to assign users to advanced roles, you can 
click the Match <Role> IDs button to automatically search for the appropriate back 
office IDs.

The system will attempt to find a matching record for a domain user by comparing 
the user’s attributes in Microsoft Active Directory® with attributes in Microsoft 
Dynamics GP. Attributes are compared in the following order. The matching 
process is not case sensitive. 

• First, middle, and last name (match)
• First and last name (match)
• Last name (last name match)

If the last name and full name attributes for the selected users are blank in Active 
Directory, or if you’re adding local users, the Match <Role> IDs button will not be 
available.

The following table shows an example of the matching process.

Customer IDs and Vendor IDs must be assigned individually rather than using the 
matching process. First, middle, and last name information is not stored in 
Microsoft Dynamics GP for those IDs.

After you run the matching process, one of the following will happen.

A match is found If a match is found, the back office ID is displayed next to the 
user name, and the check box for that user is selected. If the automatically selected 
ID is incorrect, you can change it using the Look Up ID button.

Name in Active Directory Name in Microsoft 
Dynamics GP

Comparison Match?

Matthew Berg Matt Berg First, middle, and 
last name

No

First and last name No

Last name Last Name 
Match
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A last name match is found If a last name match is found, “Last Name Match 
Found” is displayed in the ID field, and the check box for that user is not selected. 

Use the Look Up ID button to view the match that was found. If the match is 
correct, select it and click OK. If the match is incorrect, select Show All from the 
Display Options list to display all IDs. Select the correct ID and click OK. 

More than one match is found If more than one match is found for a single 
user, “Multiple Matches Found” is displayed in the ID field. The check box for the 
user is not selected.

To select the correct ID for the user, click the Look Up ID button. The possible 
matches for that user are displayed in the lookup window. Select the appropriate ID 
and click OK.

An ID matches more than one user If the same ID matches multiple users, 
the ID is displayed for those users, but the check boxes are not selected. Click the 
Look Up ID button to select the correct ID for each user.

No matches are found “No Matches Found” is displayed in the ID field, and 
the check box for the user is not selected. Use the Look Up ID button to find the 
appropriate ID for the user.

Modify MBF user information

Use the following procedure to modify an MBF user’s name or default company.

The default company determines the information that is presented when the user 
first opens Business Portal. Companies are assigned to users when they are added 
to MBF or web services.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Users. The Users page appears.

3. Select a user name and click the Description tab. User information associated 
with the selected name appears in the User Properties web part.
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4. Click Modify to change the user’s name or default company.

5. The Modify User Information page appears. Type the modified information and 
click OK.

Change a user’s MBF role assignments

You can add or remove a user’s role assignments in a specific company or all 
companies.

Assigning a user to a portal role grants access to data. Assigning a user to an 
advanced role and ID provides the user with access to specific Microsoft Dynamics 
GP information. For example, a user in the Employee role and associated with an 
employee ID would have access to personal employee information, such as 
paystubs and time off, but would not have access to any other employee’s 
information.

For more information about portal and advanced roles, see Roles overview on 
page 49.

If you’re adding several users to a role, you may want to use the Roles page instead. For 
more information, see Modify the users associated with a portal role on page 52.

Use the following steps to change a user’s role assignments.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Users. The Users page appears.

3. Select a user name and click the Roles tab. Role information associated with the 
selected name appears in the User Properties web part.

4. Click Modify to change the user’s role assignments. The Modify Roles page 
appears.

5. Select a specific company or All Companies in the Company field.

6. Select portal roles for the user, or clear the check boxes for roles that you want to 
remove. 

You should not remove users from the User role. Users removed from this role will not 
be able to access Business Portal, regardless of their other role assignments.

7. Select an advanced role/company combination in the Role/Company field.

Enterprise refers to all companies in the Microsoft Dynamics GP system. 

8. Select or remove back office IDs to associate with the user in the selected 
advanced role and company. If you clear the ID for a role and don’t select 
another one, the user will be removed from the advanced role.

Select Unspecified to use the advanced role without assigning it to a specific 
ID. 

9. Click OK.
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Modify a user’s permissions

Users view Business Portal information based on the data permissions that are 
associated with the roles they are assigned to. For more information, see Chapter 10, 
“Managing data permissions.” 

Users can perform secured tasks in Business Portal based on secured task 
permissions. A secured task permission provides security on business logic. 

Because it is not efficient to directly maintain large numbers of user accounts, we 
don’t recommend assigning permissions at the individual level for Business Portal. 
We recommend assigning users to MBF roles as much as possible to avoid having to 
track individual user permissions.

Use the following procedure to add or remove data permissions or secured task 
permissions for a user.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Users. The Users page appears.

3. Select a user name.

4. Click the Permissions tab on the User Properties web part.

5. Click Modify. The Modify User Permissions page appears.

6. Select or remove the secured task permissions for the selected user.

7. To modify data permission access, first select a business entity. The data 
permissions associated with the selected entity appear.

8. Select or remove data permissions for the selected user.

9. Click OK.

Remove MBF users

You can remove most users from MBF. If a user is assigned to an active business 
process, that user cannot be removed.

You must remove users from Business Portal before removing them from Microsoft 
Dynamics GP or from Active Directory. If Business Portal users have been removed 
from Active Directory or from Microsoft Dynamics GP, you will encounter errors.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Users. The Users page appears.

3. Select Remove users from the task area of the User List web part. The Remove 
Business Portal Users page appears.

Do not delete the Network Service Account user. This account is used to run requisition 
processes in Business Portal.

4. Select users and click Remove.
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Chapter 9: Managing Microsoft Business 
Framework roles
Roles allow you to control access to Microsoft Dynamics GP data in Business Portal. 
You can use roles to logically group Business Portal users based on job 
responsibilities.

Many roles are provided with Business Portal. For example, Administrator, Sales 
Manager, and User are default Business Portal roles. You also can create specialized 
roles for your business.

Use the Roles page to create, copy, or remove roles and to view and modify role 
properties.

Information about managing Business Portal roles is divided into the following 
sections:

• Roles overview
• Portal roles
• Advanced roles
• Create a portal role
• Modify a role description
• Modify the users associated with a portal role
• Modify the permissions associated with a role
• Copy a portal role
• Remove a portal role

Roles overview

Roles help you set up and maintain access to Microsoft Dynamics GP data 
displayed in Business Portal. 

Roles control access to data through data permissions. If a Business Portal user’s 
role is assigned to a data permission, that user will be able to access business entity 
data through that data permission. For more information about entities and data 
permissions, see Chapter 10, “Managing data permissions.”

You can assign a user to a role in a specific company, multiple companies, or all 
companies. If a user is associated with a role in more than one company, you can 
specify a default company to determine the information that will first appear when 
the user logs on to Business Portal. See Modify MBF user information on page 46 for 
more information.

There are two types of roles in Business Portal: portal roles and advanced roles. A 
portal role is used to grant users who share job functions access to the same data. 
An advanced role identifies a specific user with an ID in Microsoft Dynamics GP, 
such as an employee, salesperson, customer, or vendor. You can associate users with 
multiple portal and advanced roles, depending on their job responsibilities. For 
example, a user might be assigned to both the Employee and Salesperson roles. For 
more information about portal and advanced roles, see Portal roles on page 50 and 
Advanced roles on page 50.

MBF roles correspond to SharePoint groups in many cases, but the two are not 
automatically synchronized. You must assign users to MBF roles and SharePoint 
groups separately.
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Portal roles

A portal role is used to grant users who share job functions access to the same data. 
Users that belong to different portal roles may have access to the same pages but see 
different information based on their data permissions. For example, a sales manager 
and order entry clerk will use the Sales Center site, but each may see a different set 
of data.

For most portal roles, the data is related to a specific Business Portal center site. In 
order to give users appropriate access, you must assign them to both SharePoint 
groups and portal roles. Following are some examples of portal roles, SharePoint 
groups, and the center sites they are associated with.

Default portal roles, such as Accounting Specialist, Sales Manager and 
Administrator, are installed with Business Portal. See Chapter 27, “Default portal 
roles and security permissions,” for more information about default portal roles.

You also can create specialized roles for your business. For information about 
creating portal roles, refer to Create a portal role on page 51.

Advanced roles

In MBF, an advanced role identifies a specific user with an ID in Microsoft Dynamics 
GP, such as an employee, salesperson, customer, or vendor. For example, you can 
map users to their employee IDs so they can access their own information, such as 
paystubs and available time off. Similarly, you can map a salesperson, customer, or 
vendor to a salesperson ID, customer ID, or vendor ID.

Back office IDs containing an ampersand (&) can’t be assigned to Business Portal users 
using MBF advanced roles.

Default advanced roles, such as the Salesperson and Vendor roles, are installed with 
Business Portal. See Chapter 28, “Default advanced roles and security permissions,” 
for a list of default advanced roles. You can’t create new advanced roles.

Portal role SharePoint group Associated center site

Accounting Specialist BP Accounting Specialist Finance

Purchasing Manager BP Purchasing Manager Purchasing

Inventory Manager BP Inventory Manager Inventory

Payroll Administrator BP Payroll Administrator Payroll

Human Resources 
Administrator

BP Human Resources 
Administrator

Human Resources

Sales Manager BP Sales Manager Sales

Order Entry Clerk BP Order Entry Clerk Sales

Administrator BP Administrator Site Settings

Manager BP Manager Manager
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The following table provides examples of users and their associated back office 
information.

Users may have multiple IDs, depending on the number of roles they hold in 
Microsoft Dynamics GP. For example, a user might be both an employee and a 
salesperson. Therefore, you may want to assign users to multiple IDs to give them 
access to all necessary Microsoft Dynamics GP information in Business Portal.

Assigning a user to an advanced role and ID does not automatically restrict the data 
available to that user. When you create new queries, web parts, and pages, you must use data 
permissions with row-level restrictions to limit the data based on user IDs. For more 
information, refer to Chapter 10, “Managing data permissions.”

Create a portal role

Use the Create a Role wizard to create a new portal role and grant a group of users 
access to Microsoft Dynamics GP data. (You can’t create new advanced roles.)

If the role you want to create is similar to an existing portal role, you can copy the existing 
role and modify it. For more information about copying a role, refer to Copy a portal role on 
page 53.

Use the following steps to create a portal role.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Roles. The Roles page appears.

3. Select Create a role from the task area of the Role List web part.

4. On the Welcome page, click Next.

5. Type a name and description for the role. 

You cannot change role names later; however, you can modify the description at any 
time. For more information, see Modify a role description on page 52. 

Click Next.

6. Specify the company that users in the role will be assigned to. You can also 
assign users to a role in all companies.

7. Select the users to assign to the role for the selected company. 

8. Assign users to the role in other companies by repeating steps 6 and 7.

Click Next.

User MBF role Back office ID Company

TestUser1 Employee ADAMPARK0001 Fabrikam, Inc.

TestUser2 Customer AARONFIT0001 Fabrikam, Inc.

TestUser3 Vendor Unspecified Fabrikam, Inc.
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9. Select a business entity and the related data permissions that users in the role 
will have access to. Specify additional data permissions for this role by 
repeating this step.

For more information, see Chapter 10, “Managing data permissions.” 

Click Next.

10. Review the selections you made, then click Finish.

Modify a role description

You can modify the description associated with a role at any time. The description 
should identify the purpose of the role or the users assigned to it.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Roles. The Roles page appears.

3. Select a role name and click the Description tab.

4. Click Modify. The Modify Role Description page appears.

5. Enter or modify the role description.

6. Click OK.

Modify the users associated with a portal role

Use the Roles page to add or remove users associated with a portal role.

This procedure applies only to portal roles. To modify users associated with an 
advanced role, such as Employee, use the Users page. For more information, see 
Change a user’s MBF role assignments on page 47.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Roles. The Roles page appears.

3. Select a role name and click the Users tab.

4. Click Modify. The Modify Users page appears.

5. From the Company list, select a specific company or All Companies.

6. Select the users to assign to the role, or clear the check boxes for users that you 
want to remove from the role.

You should not remove users from the User role. Users removed from this role will not 
be able to access Business Portal.

7. Click OK.
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Modify the permissions associated with a role

Use the following procedure to add or remove data permissions and secured task 
permissions for a selected role. For more information, see Chapter 10, “Managing 
data permissions.”

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Roles. The Roles page appears.

3. Select a role name and click the Permissions tab.

4. Click Modify. The Modify Role Permissions page appears.

5. Select the secured task permissions to assign to the role, or clear the check boxes 
for the task permissions that you want to remove.

6. To change the data permissions associated with the role, expand the node for a 
business entity. The data permissions associated with that entity appear.

7. Select the data permissions to assign to the role, or clear the check boxes for the 
data permissions that you want to remove.

8. Click OK.

Copy a portal role

Use the Copy a Role wizard to create a new portal role by copying and modifying 
an existing role. (You can’t copy advanced roles, the Administrator role, or the User 
role.)

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Roles. The Roles page appears.

3. Select the portal role to copy and click Copy a role in the task area of the Role 
List web part.

4. On the Welcome page, click Next.

5. Type a name and description for the role. You cannot change role names later; 
however, you can modify the description at any time. For more information, see 
Modify a role description on page 52.

Click Next.

6. Specify the company that users in the role will be assigned to. You can also 
assign users to a role in all companies.

7. Select the users to assign to the role for the selected company. By default, the 
users assigned to the role being copied are selected. 

8. Assign users to the role in other companies by repeating steps 6 and 7.

Click Next.
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9. Select a business entity and the related data permissions that users in the role 
will have access to. By default, the data permissions assigned to the role being 
copied are selected. Specify additional data permissions for this role by 
repeating this step.

For more information, see Chapter 10, “Managing data permissions.” 

Click Next.

10. Review the selections you made, then click Finish.

Remove a portal role

When you remove a portal role, the users assigned to the role no longer have access 
to the role’s associated permissions.

Default portal roles installed with Business Portal cannot be removed. See Chapter 27, 
“Default portal roles and security permissions,” for a list of these roles.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Roles. The Roles page appears.

3. Select Remove roles from the task area of the Role List web part. The Remove 
Roles page appears.

4. Select the portal roles to remove.

5. Click Remove.
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Chapter 10: Managing data permissions
Data permissions are used by the Microsoft Business Framework to control access to 
the back office data that can be displayed in Business Portal.

Use the Data Permissions page to create, view, modify, and remove data 
permissions. You also can check for and repair invalid queries.

Information about data permissions is divided into the following sections:

• Data permissions overview
• Row-level restrictions
• Data permission naming conventions
• Create a data permission
• Modify a data permission description
• Modify the roles associated with a data permission
• Modify access to individual entity properties
• Change row-level restrictions for a data permission
• Look up queries based on a data permission
• Check for and repair invalid queries
• Remove a data permission

Data permissions overview

Microsoft Business Framework (MBF) uses business entities to retrieve data from 
the Microsoft Dynamics GP database. A business entity is a representation of a 
record from the Microsoft Dynamics GP back office. Customer, purchase order, and 
item are examples of entities.

Entities contain properties, or attributes, that refer to specific data. For example, 
customer ID, customer name, and customer contact are attributes of the customer 
entity. You can set up data permissions that allow users to see only certain 
properties or attributes of an entity.

For example, the following illustration shows query data. A data permission can be 
used to control access to the Salesperson ID property in this query.

A column-level
restriction specifies

access to the
Salesperson ID

property.
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For each entity, you can exclude properties entirely, or you can set the following 
levels of access to entity properties.

Read/Write Access Access to view and modify data. Currently, write access is 
limited primarily to Business Portal applications that provide data entry forms. If 
you add applications to Business Portal that include data entry forms, you can grant 
read/write access to their entities as needed.

Read-Only Access Access to view data. Most data provided in Business Portal 
is read-only.

Customized Access Combines read/write access and read-only access to an 
entity’s properties. For example, you might set read/write access to employee 
address information and read-only access to employee IDs.

See Create a data permission on page 57 for additional information.

Row-level restrictions

A data permission is a column-level restriction, which controls access to entity 
properties. (For more information, see Data permissions overview on page 55.) You 
can also apply row-level restrictions to data permissions to control access to the 
individual rows of data in Microsoft Dynamics GP SQL tables.

The following illustration shows query data. A data permission can be used to 
specify access to the Document Number, Customer Name, Document Amount, and 
Sales Territory ID columns. A row-level restriction could be applied to that data 
permission, specifying that data for only a particular sales territory can be returned 
in the query.

Data permissions, with row-level restrictions applied, are installed by default for the 
Customer role. When query results are returned through these data permissions, users in the 
Customer role can see only records that contain their own customer ID.

You can’t create new row-level restrictions.

Apply a row-
level restriction

to return data
from a single

sales territory.
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Data permission naming conventions

To be consistent when creating data permissions, use the following format to name 
them: Entity Name - Access, where Entity Name is the name of the business entity for 
which you are creating a data permission and Access specifies the level of access to 
data.

Use the word All if there are no restrictions. Use the word Restricted if only certain 
properties can be accessed by the data permission. For example, a data permission 
named Sales Order - All would provide access to all properties of the Sales Order 
entity. A data permission named Sales Order - Restricted would provide access to a 
subset of the entity’s properties.

If you need to create several data permissions with restricted access, we recommend 
adding two or three words after the word Restricted to further indicate the type of 
data that is restricted.

Refer to Chapter 27, “Default portal roles and security permissions,” and Chapter 
28, “Default advanced roles and security permissions,” for examples of how data 
permissions are named.

Create a data permission

Data permissions provide rights to Microsoft Dynamics GP data for the various 
query functions in Business Portal. When you create a data permission, you specify 
which business entity properties are accessible, and the type of access that is 
granted. See Data permissions overview on page 55 for more information.

Use the following steps to create a data permission.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Data permissions. The Data 
Permissions page appears.

3. Select Create data permission from the task area of the Data Permission List 
web part. The Create a Data Permission wizard appears.

4. Review the Welcome page, then click Next.

5. Type a name and description for the data permission. For naming conventions, 
see Data permission naming conventions on page 57.

This name cannot be modified after the data permission is created; however, you can 
modify the data permission description. See Modify a data permission description on 
page 58 for additional information.

Click Next.

6. Select the entity to create the data permission for, then select a property access 
method. You can set read/write, read-only, or customized access to an entity’s 
properties. Click Next.

7. If you chose Customize attribute settings, set individual property access. Click 
Next.



P A R T  2 S E C U R I T Y

58 A D M I N I S T R A T O R ’ S G U I D E

8. Select a row-level restriction, if needed, for the selected entity. See Row-level 
restrictions on page 56 for additional information.

Click Next.

9. Review the selections you made, then click Finish.

Modify a data permission description

You can modify the description associated with a data permission at any time.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Data permissions. The Data 
Permissions page appears.

3. Expand the business entity associated with the data permission, then select the 
data permission.

4. Click the Description tab, then click Modify. The Modify Data Permission 
Description page appears.

5. Enter or modify the data permission description, then click OK.

Modify the roles associated with a data permission

You can assign additional roles to a data permission, allowing more users access to 
the entity data associated with the data permission. You also can remove roles from 
a data permission, taking away access to the business entity data. Use the following 
guidelines when assigning data permissions to roles.

• If a data permission is specific to a role, assign it to that role.

• You can assign a data permission to multiple roles.

• If a data permission should apply to all users, assign it to the User role.

• For roles assigned to users outside your company, such as Customer or Vendor, 
be especially careful to assign only data permissions that have been restricted to 
include only the user’s own data.

When access to a data permission is removed, any portal elements that depend on 
that data permission may not function. For example, any queries that are based on 
the data permission will no longer work if the user doesn’t have access to the 
underlying data permission.

Before you modify a data permission, you should view the queries based on that 
data permission, so you can determine the effects of a change. For information 
about viewing the queries that are based on a particular data permission, see Look 
up queries based on a data permission on page 60.
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Use the following steps to modify the roles associated with a data permission.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Data permissions. The Data 
Permissions page appears.

3. Expand the business entity associated with the data permission, then select the 
data permission.

4. Click the Roles tab, then click Modify. The Modify Roles page appears.

5. Select the check boxes for the roles you want to assign to the data permission, or 
clear check boxes for the role associations you want to remove.

6. Click OK.

Modify access to individual entity properties

You can modify the read and write access settings to a business entity’s properties 
(also called attributes). See Data permissions overview on page 55 for additional 
information about the levels of access. When you modify a data permission, all of 
the queries based on that data permission are affected.

Before you modify a data permission, you should view the queries that are based on 
that data permission, so you can determine the effects of a change. For information 
about viewing the queries that are based on a particular data permission, see Look 
up queries based on a data permission on page 60.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Data permissions. The Data 
Permissions page appears.

3. Expand the business entity associated with the data permission, then select the 
data permission.

4. Click the Attribute Settings tab, then click Modify. The Modify Attribute 
Settings page appears.

5. Click Customize.

6. Modify any of the entity’s properties by selecting or clearing the Read and 
Write check boxes.

7. Click OK. A message appears asking if you want to check for invalid queries 
based on the changes you made. See Check for and repair invalid queries on 
page 61 for additional information.
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Change row-level restrictions for a data permission

You can change which row-level data restriction is associated with a data 
permission. When you modify a restriction on a data permission, all of the queries 
based on that data permission are affected.

Before you modify a data permission, you should view the queries that are based on 
that data permission, so you can determine the effects of a change. For information 
about viewing the queries that are based on a particular data permission, see Look 
up queries based on a data permission on page 60.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Data permissions. The Data 
Permissions page appears.

3. Expand the business entity associated with the data permission, then select the 
data permission.

4. Click the Data Restrictions tab and click Modify. The Modify Restriction 
Policies page appears.

5. Select a restriction policy to associate with the data permission.

6. Click OK.

Look up queries based on a data permission

Queries are based on data permissions, so when data permissions are modified, 
queries may no longer work properly. Before you modify a data permission, you 
should view the queries based on that data permission, so you can determine the 
effects of a change.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Data permissions. The Data 
Permissions page appears.

3. Expand the business entity associated with the data permission, then select the 
data permission.

4. Click the Queries tab. The queries based on the selected data permission are 
displayed. Any changes made to the data permission will affect the queries that 
are listed.

For more information about the query Location field, refer to How queries are 
organized on page 77.
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Check for and repair invalid queries

Queries are based on data permissions, so when data permissions are modified, 
queries may no longer work properly. For example, you might remove access to an 
entity property that is used in a query restriction, which would make that query 
restriction invalid. We recommend searching for and repairing invalid queries after 
you modify a data permission.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Data permissions. The Data 
Permissions page appears.

3. Expand the business entity associated with the data permission, then select the 
data permission.

4. Click the Queries tab. The queries based on the selected data permission are 
displayed.

For more information about the query Location field, refer to How queries are 
organized on page 77.

5. Click Check for Invalid Queries.

If there are invalid queries, the Invalid Queries page appears. The name, status, 
and location of the invalid query appears at the top of the page. One of three 
values appears in the Status column:

Invalid An invalid property is used as a display column within a sort.

Invalid - Restriction An invalid property is used in a row-level restriction. 
This status also may appear if the invalid property is used as a display column 
within a sort.

Valid Appears only after an invalid query has been repaired.

6. Select the queries to repair, if necessary.

7. Click Repair. Repairing a query removes invalid fields, or properties, from the 
display, sort, and restriction properties of the query. The status of the repaired 
query changes to Valid.

If query restrictions are removed during repair, users could see data that is not intended 
for them. To modify a repaired query, select the query on the Invalid Queries page and 
click Open. The Modify Query page appears, where you can set the appropriate 
properties. 

For additional information about modifying queries, see Modify a query on a 
query page on page 71 and Modify a result viewer web part query on page 74.

8. Click OK.
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Remove a data permission

To remove a data permission (for example, if you’ve created a data permission that 
you no longer need), use the following procedure.

We recommend that you not remove default data permissions. If you do so, queries that use 
the data permission will become unusable. We suggest contacting Microsoft Dynamics GP 
Technical Support for assistance with removing default data permissions.

1. Remove all users and roles from the data permission. For additional 
information, see Modify a user’s permissions on page 48 and Modify the roles 
associated with a data permission on page 58.

2. Delete all queries based on the data permission you are removing. Refer to Look 
up queries based on a data permission on page 60 for more information about 
finding associated queries.

If you remove a data permission before deleting its associated queries, the queries can’t 
be removed from the system. 

3. Go to the Site Settings page for the top-level Business Portal web site. 

4. Under Business Portal Administration, click Data permissions. The Data 
Permissions page appears.

5. Select Remove data permissions from the task area of the Data Permission List 
web part. The Remove Data Permissions page appears.

6. Select the business entity associated with the data permission.

7. Select the check box for the data permission. You can select multiple data 
permissions.

8. Click Remove.
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Chapter 11: Managing web service users
Adding users to web 
service roles is 
required only if you’re 
using Business Portal 
with Office SharePoint 
Server, Enterprise 
Edition.

The Office SharePoint Server, Enterprise Edition version of Business Portal includes 
additional pages that retrieve data using Web Services for Microsoft Dynamics GP. 
If you’re using Business Portal with Office SharePoint Server, Enterprise Edition, 
you must set up users in web service roles, which are sets of web service operations 
and tasks, in addition to assigning them to MBF roles.

Only information related to web service user setup is included here. For more 
information about using Web Services for Microsoft Dynamics GP, refer to the 
Microsoft Dynamics GP Web Services Installation and Administration Guide.

This information is divided into the following sections:

• Add users to web service roles
• Assign back office IDs for data access

Add users to web service roles

Some pages in Business Portal retrieve data using the Microsoft Dynamics GP web 
service. In order for users to view the data, you must assign them to web service 
roles using the Dynamics Security Console.

A role assignment consists of the following:

• A role (with its associated tasks and operations)
• A company or companies
• A user or group for which access is being granted

When the role assignment is created, the users or groups of users will have access to 
the items in the role for the specified company or companies.

Adding users to web service roles is only one step in giving them access to Business Portal. 
Users also must be added to SharePoint groups for site and page access.

For more information about using Web Services for Microsoft Dynamics GP, refer to 
the Microsoft Dynamics GP Web Services Installation and Administration Guide.

To add a new role assignment, complete the following steps:

1. Open the Dynamics Security Console. (On a computer where the console is 
installed, click Start > Administrative Tools > Dynamics Security Console.)

2. Select the Role Assignments node in the left pane of the Dynamics Security 
Console.

3. In the Action menu, click Add. The Add Role Assignments window will 
appear.

4. In the Role list, select the role that you want to assign users or groups to.

5. Click the Add Windows Users button to add individual windows users to the 
role assignment. Click the Add Groups button to add application level groups 
or enterprise level groups to the role assignment.
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6. Select whether the access applies to all companies. If you choose Select 
Individual Companies, mark the appropriate companies in the list.

7. Click OK to save the new role assignment.

Assign back office IDs for data access

In some cases, you’ll want to map users to Microsoft Dynamics GP IDs, which 
provides access to specific information. For example, you can map users to their 
employee IDs so they can access their own information, such as paystubs and 
available time off. Similarly, you can map a salesperson, customer, or vendor to a 
salesperson ID, customer ID, or vendor ID.

The following table provides examples of users and their associated back office 
information.

Users may have multiple IDs, depending on the number of roles they hold in 
Microsoft Dynamics GP. For example, a user might be both an employee and a 
salesperson. Therefore, you may want to assign users to multiple IDs to give them 
access to all necessary Microsoft Dynamics GP information in Business Portal.

Use the Microsoft Dynamics Security Console to identify a specific user with a 
Microsoft Dynamics GP ID, such as a salesperson or a customer. You must be 
designated as an Entity ID Assignment Administrator in order to assign users to 
entity IDs.

For more information about using Web Services for Microsoft Dynamics GP, refer to 
the Microsoft Dynamics GP Web Services Installation and Administration Guide.

To assign a back office ID, complete the following steps:

1. Open the Dynamics Security Console. (On a computer where the console is 
installed, click Start > Administrative Tools > Dynamics Security Console.)

2. Select the Entity ID Assignments node in the left pane of the Dynamics 
Security Console. 

3. In the Action menu, click Add. The Add Entity ID Assignments window will 
appear. 

4. Click Select Windows User to select the user you would like to assign to a back 
office entity. 

5. In the Entity Type list, select the entity type you would like to assign to the 
user. 

User Web service role Back office ID Company

TestUser1 Employee ADAMPARK0001 Fabrikam, Inc.

TestUser2 Customer AARONFIT0001 Fabrikam, Inc.

TestUser3 Vendor Unspecified Fabrikam, Inc.
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6. In the Company list, select the company where the entity exists. A list of entity 
IDs for the selected entity type and company will appear. 

To filter results, enter search text in the Filter by ID field and click the associated 
button. Clearing the text and clicking the button again will clear any filters.

7. In the Entity list, select the ID you would like to assign to the user. 

8. Click OK to save the new assignment. 
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Part 3: Portal elements
This part of the documentation explains the elements that make up Business Portal, 
including queries and web parts.

• Chapter 12, “Creating queries,” explains how to create and modify Business 
Portal queries of back office data.

• Chapter 13, “Organizing queries,” explains how to organize Microsoft 
Dynamics GP queries that are used on query pages and in result viewer web 
parts throughout Business Portal.

• Chapter 14, “Managing web parts,” describes web parts, the building blocks for 
pages.
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Chapter 12: Creating queries
Queries are used to display Microsoft Dynamics GP data in Business Portal. When 
you run a query, Business Portal uses business entities to retrieve data from the 
Microsoft Dynamics GP database. 

You can create and modify queries from predefined query pages in functional area 
centers (such as Financial, Sales, and Inventory). You also can create and modify 
queries as you design new pages.

Query results can be displayed on query pages. In addition, you can display query 
results in result viewer web parts. You can save frequently used queries, and you 
can export query results to Excel.

Query information is divided into the following sections:

• Create a new query on a query page
• Query operators
• Advanced query restriction options
• Modify a query on a query page
• View query page results
• Change the appearance of query page results
• Print or export query page results
• The result viewer query menu
• Create a new result viewer web part query
• Modify a result viewer web part query

Create a new query on a query page

Use the Create a Query wizard to set up queries of your back office data. To start 
the wizard, click New Query on a query page. In the Create a Query wizard, you 
will be able to choose the following:

Data permission The subset of entity information that this query will be based 
on. You can create a new query based on the previous query’s data permission, or 
based on a new data permission.

You must create all of the necessary data permissions for your business entities 
before creating queries. For more information about data permissions, see Chapter 
10, “Managing data permissions.”

Columns The fields of data (also known as properties) you want to display. Many 
columns may be defined for a particular entity, and you can choose to display some 
or all of them.

For example, if you are creating a query about customers, you can select to display 
just the Customer Name and Balance Due, rather than all available properties of a 
customer. (If there are columns already selected that you don’t want to include, click 
the associated check boxes to clear them.)

Rows The restrictions to limit the number of records returned by the query. For 
example, you may choose to display only customers with balances between $1000 
and $2000. Rows can be restricted based on any column, even if that column is not 
displayed in the query results.
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Row restrictions can be basic or advanced. For an advanced restriction, you’ll be 
given a greater selection of operators to choose from, and you’ll be able to use more 
complex restrictions. For example, you could use variables or comparisons to 
restrict your query. For more information about restricting the data a query returns, 
see Query operators on page 70 and Advanced query restriction options on page 71.

With a query row restriction, the excluded rows are still available if the user modifies the 
query, but are excluded from the current view. With a row-level data restriction, the user 
does not have access to the excluded rows. For more information, refer to Row-level 
restrictions on page 56.

Sorting The order of the query results. You can sort by multiple columns, and 
indicate for each query column whether you want to sort results in ascending or 
descending order. For example, you may want to sort the list of customers 
alphabetically, or you may want to sort the list from largest balance due to smallest 
balance due.

Name The name of the query. Saved queries must be assigned names. The name 
you enter will identify the query in your personal query folder (viewable on the 
query page), and in the query menu of any result viewer web parts the query is 
associated with.

Query operators

For either a basic or advanced query restriction, you’ll select a column to base the 
restriction on, an operator, and the values you want to include or exclude.

For some operators, you can enter multiple values. To select additional values for a 
restriction, choose the lookup button; you can’t enter values using the keyboard. If 
you include multiple values in a restriction, the query will return results that fit any 
of the values.

The operators available will vary, depending on whether you’re using a basic or 
advanced restriction.

Basic restriction
With a basic restriction, you’ll be able to use the following operators, depending on 
the type of data contained in the column:

• Is equal to
• Is not equal to
• Is less than
• Is greater than
• Contains
• Begins with

Advanced restriction
With an advanced restriction, you can create more complex queries. The following 
additional operators are available, depending on the type of data contained in the 
column:

• Is one of
• Is not one of
• Is between
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Advanced query restriction options

Use advanced restriction options to create more complex queries. For example, to 
restrict a query based on columns that aren’t displayed in the results, you must use 
the advanced restriction. You must also use the advanced restriction to create a 
query that prompts the user to enter a value each time the query is selected.

To use advanced restrictions, select Advanced when you’re restricting the rows for 
the query. The type of data contained in the column you want to restrict on will 
determine which operators and which of the following advanced restriction options 
are available.

Values
For some operators, you can enter multiple values. Use this option to specify more 
than one value that should be used to select the results. If you include multiple 
values in a restriction, the query will return results that match any of the values.

Variables
You can restrict the results returned by a query by specifying a variable such as 
Current User or Last Month. The available variables depend on the data type of the 
property you chose to create a restriction for.

Compare to
You can restrict the results returned by comparing selected properties with one 
another. For example, you can create a query for customers whose balance due is 
greater than their credit limit. The properties you compare must have the same data 
type. For example, you can compare two date properties or two quantity properties, 
but you can’t compare a date property to a quantity property.

Parameters
A parameter is a placeholder for a query restriction. If a query uses a parameter, the 
user will be prompted to enter a value when that query is selected. You can create a 
query containing one or more parameters. When you create an advanced restriction 
using a parameter, you’ll specify the message that appears when the user is 
prompted to enter the parameter’s value, and if necessary, a default value for the 
parameter.

Modify a query on a query page

You can modify queries using the Modify Query option on query pages. There are 
many columns available for each query page entity. To make queries easier to 
review and understand, you should use as few columns as possible, while still 
providing the information you’re looking for. Even if you choose not to display a 
certain column, you can still create a query restriction based on that column. (Query 
page entities can’t be modified.)

Saving modified queries makes it easier to generate the same query in the future. 
Modified queries are saved to your My Queries folder and become personal 
queries. The changes affect only you. (For information about sharing queries, refer 
to Share a query among users on page 78.) 

Use the following steps to modify a query on a query page.



P A R T  3 P O R T A L  E L E M E N T S

72 A D M I N I S T R A T O R ’ S G U I D E

1. On a query page, select the query you want to change.

2. Click Modify Query.

3. You can change the columns that are displayed, column order, restrictions on 
rows returned by the query, column sort order, and query options. Click the 
tabs for the properties you want to modify, and make your changes.

4. To run the query, click OK. 

5. To save your changes, click Save Query. You will be asked to give the query a 
name and a location. Queries you save will appear under the My Queries 
heading on query pages.

You can’t create Internet Explorer favorites for queries; you must save modified queries 
using the Save Query button.

View query page results

Query results are returned in blocks. This means that if your query page options are 
set to display 1000 results at a time, and a query has 2000 result rows, you’ll see only 
the first 1000 records when you process the query.

To see the rest of the results, use the arrow buttons at the bottom of the page.

To always return all results of a query at one time, select the unlimited option on the 
Query Page Options page. For more information about query page options, see 
Change the appearance of query page results.

If your data includes a large number of records, returning all result rows may take a long 
time. Because queries return data from your back office database, returning a large number 
of records also may adversely affect back office performance.

Change the appearance of query page results

Use the Query Page Options page to change the way query results appear in your 
query pages. You can choose the font and font size for query results. You can also 
choose the number of query results returned at a time. Query page appearance 
settings apply to all query pages you have access to; not just the current query page.

Click to display 
all result rows.

Click to append
the next group

of results.
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1. Click the Options button on a query page to open the Query Page Options 
page. The Options button appears in the upper right corner of the query page, 
as shown in the following illustration.

2. Select the number of query result rows you want to return at a time.

For example, if you enter 1000 and a query has 2000 result rows, you’ll see only 
the first 1000 records when you process the query. To see the rest of the results, 
you would need to click the arrow button at the bottom of the page. For more 
information, see View query page results on page 72.

To return all query results at once, you can select the Unlimited option.

Selecting the Unlimited option may cause queries with large result sets to take a long 
time to process. Because queries return data from your back office database, returning a 
large number of records also may adversely affect back office performance.

3. Select the font style and size you want query results to appear in.

4. Click OK to save your changes.

Print or export query page results

Query results can be sent to Microsoft Office Excel for additional sorting and 
analysis. For example, you can search for information about customers, export the 
results to Excel, then use Excel and Microsoft Office Word to create promotional 
letters targeted to specific groups of customers based on those results.

To print or export query results, click Copy to Excel on a query page; your query 
results will be displayed in an Excel spreadsheet. From within Excel, you can 
perform calculations, create a chart or graph, or print a spreadsheet of your query 
results.

When you copy to Excel, a file is also placed on your desktop automatically. Add the .xls 
extension to the file name for the file to be recognized by Excel.

The result viewer query menu

The query menu on result viewer web parts displays the names of queries 
associated with the result viewer web part. Available queries are listed 
alphabetically, and a bullet appears next to the query that is currently being 
displayed.

For information about displaying a query in a web part, see Result viewer 
configuration options on page 86 and Configure a result viewer web part on page 89. For 
information about the query menu options available for each result viewer web part 
style, see Query menu on page 87.

Query page 
Options button
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If a result viewer web part has multiple queries associated with it, the query defined 
when the result viewer web part was first configured is displayed by default. If a 
user chooses a different query in the web part menu, that query displays by default 
the next time the user accesses the result viewer web part. 

Using the options in the query menu, users and administrators can modify the 
current query or create a new query based on the current data permission. For more 
information about modifying and creating queries, refer to Create a new result viewer 
web part query on page 74 and Modify a result viewer web part query on page 74. 

Create a new result viewer web part query

You can create a new query for a result viewer web part if the Create New Query 
option appears in the query menu.

Click Create New Query to launch the Create a Query wizard. The wizard steps are 
the same as those for creating a new query on a query page (see Create a new query on 
a query page on page 69), except that you will not select a data permission. The new 
query will be based on the data permission that was selected when the web part 
was first configured.

When the administrator creates a new query for a result viewer web part, the 
change applies to everyone who has access to the web part.

Modify a result viewer web part query

You can modify a result viewer web part query if the Modify Existing Query option 
appears in the query menu.

Query menu

Query menu
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Click Modify Existing Query to open a window for changing result viewer web 
part query properties. You can change the columns that are displayed, column 
order, the restrictions on rows returned by the query, and column sort order. When 
you modify a query this way, you are creating a personalized version of the query. 
The changes affect only you.

You can also use the Modify Query option on the web part tool pane, when a page 
is in edit mode. When you modify a query this way, you are modifying a shared 
version of the query. Changes affect all users who have access to the web part, if 
they aren’t using a personalized version of the query.
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Chapter 13: Organizing queries
From the Query Organization page, you can see all queries created by all users. Use 
the Query Organization page to move, share, rename, and delete queries. 
Information about organizing Business Portal queries is divided into the following 
sections:

• How queries are organized
• Share a query among users
• Move a query
• Delete a query
• Rename a query
• Set query permissions
• Set query folder permissions

How queries are organized

The Query Organization page displays the folder structure used to organize queries 
in Business Portal. The root directory includes these folders:

AdvancedRolesLookup The AdvancedRolesLookup folder contains the 
queries used on the Modify Portal and Advanced Roles page (opened by clicking 
Modify on the Roles tab of the Users page). The queries also are used in the Add 
Users wizard.

DataViewer The DataViewer folder contains subfolders for result viewer web 
parts. Each time you configure a result viewer, a subfolder for the result viewer 
automatically is created in the DataViewer folder. The subfolder stores queries that 
can be displayed by the result viewer. The name assigned to the subfolder is the 
same as the name of the result viewer.

Initially, a result viewer web part subfolder contains only the query created during 
result viewer configuration. You can move additional queries into a result viewer 
web part’s subfolder. For more information, see Move a query on page 79.

Each time a user creates or modifies a query for a result viewer web part, a 
subfolder is automatically created for that user in the result viewer’s subfolder. The 
user’s personal queries for the web part are stored in this subfolder. The following 
illustration provides an example.

Active Leads result viewer web part

Initial query created for the result viewer

Personal query created by user ‘Leila’
for the result viewer
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Dynamics The Dynamics folder contains predefined queries. You can use these 
queries in result viewers and on query pages.

Microsoft The Microsoft folder contains system queries that are used by 
Business Portal and Microsoft Business Framework applications. 

Predefined subfolders and queries in the AdvancedRolesLookup, Microsoft, and 
Dynamics folders should not be deleted, moved, or renamed. The Business Portal system 
requires them.

QueryPages The QueryPages folder contains subfolders for each Business Portal 
query page. Each of the subfolders contains another level of subfolders labeled 
Personal and Shared.

• When a user creates a query in one of the functional area centers, the query is 
saved in a subfolder named for the user inside the query page’s Personal folder. 
Queries in the Personal folder can be used by only the user who created them.

• Queries in the Shared folder were created by individual users but can be used 
by everyone who has access to the functional area center that corresponds to the 
folder.

Share a query among users

Only the Business Portal administrator can choose which queries to share; 
individual users cannot share the queries they create.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Query organization. The Query 
Organization page appears.

3. In the list of all existing queries in the tree view on the left, select the query to 
share among users. For information about finding a query, see How queries are 
organized on page 77.

4. Click Move to Folder to move the query to a shared query folder. The Browse 
for Folder dialog box appears, where you can select a shared folder for any one 
of the functional area center pages. This makes the query available to all users 
of the query page associated with that center page.

5. Click OK to save changes.

In order for other users to modify the original query, you need to give them 
permission to do so. You can set query permissions by user or by role. For more 
information about setting permissions, refer to Set query permissions on page 81.
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Move a query

You can move queries between the DataViewer and QueryPages folders. Queries 
moved to DataViewer folders become additional queries for the associated result 
viewer web part, if applicable. (Simple list, form viewer, and subscribing rich list 
result viewers can have only one query associated with them.) Queries moved to 
QueryPages folders become additional queries on the associated query page.

Do not move predefined queries from the AdvancedRolesLookup, Microsoft, or 
Dynamics folders. The Business Portal system requires these queries, and if you move them, 
parts of the system will be unusable. Also, do not move the root query folders—
AdvancedRolesLookup, DataViewer, Dynamics, Microsoft, or QueryPages—because 
this will cause all queries from the folders to be unusable.

This procedure does not create a copy of the query in the new location; it moves the 
query. To have the same query in multiple locations, for example in two different 
DataViewer folders, you need to create that query separately for each 
corresponding result viewer web part.

Use the following steps to move a query.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Query organization. The Query 
Organization page appears.

3. In the list of all existing queries in the tree view on the left, select the query to 
move. For information about finding a query, see How queries are organized on 
page 77.

4. Click Move to Folder to move the query to another query page or result viewer 
web part. The Browse for Folder dialog box appears, where you can select a 
different folder for the query. The folder you select determines where the query 
will appear and whether or not the query will be available to all users.

When you move a query to a Personal folder, you can allow the new user of the 
query to modify the original query, rather than saving modifications to a copy 
of the query. For more information about setting query permissions, see Set 
query permissions on page 81.

If you move the only query associated with a result viewer web part, that web part 
displays the “Query returned no results” message, because the query cannot be found. If 
you want to use a different query, you must remove all instances of the web part from 
pages and then recreate it with the new query. See Remove web parts from a page on 
page 96 and Adding web parts to a page on page 85.

5. Click OK to save changes.
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Delete a query

When you remove a result viewer web part from a page, delete a page, or remove a 
user, you should also delete the associated queries. You can delete subfolders and 
queries using the Query Organization page. 

Do not delete predefined queries from the AdvancedRolesLookup, Microsoft, or 
Dynamics folders. The Business Portal system requires these queries, and if you delete 
them, parts of the system will be unusable. Also, do not delete the root query folders—
AdvancedRolesLookup, DataViewer, Dynamics, Microsoft, or QueryPages—because 
this will cause all queries from the folders to be unusable.

Use the following steps to delete a query.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Query organization. The Query 
Organization page appears.

3. In the list of queries in the tree view on the left, select the query to delete. For 
information about finding a query, see How queries are organized on page 77.

4. Click Delete to delete the query. 

If you delete the only query associated with a result viewer web part, that web part 
displays the “Query returned no results” message, because the query cannot be found. If 
you want to use a different query, you must remove all instances of the web part from 
pages and then recreate it with the new query. See Remove web parts from a page on 
page 96 and Adding web parts to a page on page 85.

5. A message appears asking if you are sure that you want to delete the query. 
Click Yes.

Rename a query

Query names appear in the Queries list on query pages and in the title bars of result 
viewer web parts. If more than one query is associated with a result viewer web 
part (in the case of a primary publishing list or publishing rich list web part), query 
names appear as selections in the result viewer web part’s query menu.

Do not rename predefined queries from the AdvancedRolesLookup, Microsoft, or 
Dynamics folders. The Business Portal system requires these queries, and if you rename 
them, parts of the system will be unusable. Also, do not rename the root query folders—
AdvancedRolesLookup, DataViewer, Dynamics, Microsoft, or QueryPages—because 
this will cause all queries from the folders to be unusable.

Use the following steps to rename a query.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Query organization. The Query 
Organization page appears.

3. In the list of all existing queries in the tree view on the left, select the query to 
rename. For information about finding a query, see How queries are organized on 
page 77.
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4. Click Rename and type a new name for the query. Queries can have the same 
name if they are stored in separate folders.

If you rename a query associated with a result viewer web part, that web part will 
display the “Query returned no results” message, because the query cannot be found. If 
you want to rename a query associated with a web part, you must recreate the web part 
and associate it with the renamed query.

5. Click OK to save changes.

Set query permissions

When a user creates a query in one of the functional area centers, that query is saved 
to a subfolder for the user inside the query page’s Personal folder on the Query 
Organization page.

You can move a query from one user’s personal folder to another user’s folder. In 
order for the new user to modify the original query, you need to give them 
permission to do so. You can set query permissions by user or by role.

By default, all queries are accessible to the User role. However, information is 
returned based on data permissions. Do not change query permissions to control 
access to data. Instead, change the role applied to the underlying data permission. 
For more information, see Modify the roles associated with a data permission on page 58.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Query organization. The Query 
Organization page appears.

3. In the list of all existing queries in the tree view on the left, select the query to 
set permissions for. For information about finding a query, see How queries are 
organized on page 77.

4. Click Modify. In the Security dialog box, select the user or role that should be 
able to modify the original query.

5. Click OK to save changes.

Set query folder permissions

Use the Query Organization page to set folder permissions, which determine who 
can delete a folder.

1. Go to the Site Settings page for the top-level Business Portal web site. 

2. Under Business Portal Administration, click Query organization. The Query 
Organization page appears.

3. In the left column, select the folder to set permissions for. For information about 
folders, see How queries are organized on page 77.

4. Click Modify. In the Security dialog box, select the user or role that should be 
able to delete the folder.

5. Click OK to save changes.
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Chapter 14: Managing web parts
A web part is a modular unit of information on a page. In Business Portal, you can 
use several different types of web parts. You can use all of the web part types 
provided with Windows SharePoint Services; you also can use result viewer web 
parts or tab web parts, which are unique to Business Portal.

Information about web parts is divided into the following sections:

• Web parts overview
• Web part connections overview
• The web part gallery
• Adding web parts to a page
• Types of result viewer web parts
• Result viewer configuration options
• Configure a result viewer web part
• Create a SharePoint web part
• Back Office Tasks web parts
• Configure a tab web part
• Dynamics GP report viewer configuration options
• Configure a Dynamics GP report viewer web part
• Result viewer communication behaviors
• Connect result viewer web parts to one another
• Web part menu options
• Remove web parts from a page

Web parts overview

Web parts are modular units of information that are the building blocks of pages. 
You can use the following kinds of web parts in Business Portal.

Business Portal result viewer web parts Result viewers display the results 
of real-time queries of Microsoft Dynamics GP data. Result viewer web parts are 
unique to Business Portal. For information about the types of result viewer web 
parts, see Types of result viewer web parts on page 85.

Business Portal tab web parts Tab web parts organize information by 
placing it on separate tabs within a single web part. Tab web parts are unique to 
Business Portal. For more information about tab web parts, refer to Configure a tab 
web part on page 91.

Windows SharePoint Services web parts SharePoint web parts can display 
announcements, document libraries, surveys, and other SharePoint content. For 
more information about creating SharePoint web parts, refer to Create a SharePoint 
web part on page 90.

Business data web parts Business data web parts are used to display data 
from the Business Data Catalog in Office SharePoint Server. For more information, 
see Business data web parts on page 115.

Dynamics GP report viewer web parts Dynamics GP Report Viewer web 
parts are used to view company-specific Microsoft SQL Server Reporting Services 
reports. For more information about Dynamics GP report viewer web parts, refer to 
Configure a Dynamics GP report viewer web part on page 93.
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Web part connections overview

Some web parts on a page can be connected, with data passing back and forth 
between them. One web part provides the data (publisher), and the other web part 
acts on the data (subscriber). 

Types of web parts you can connect
You can create the following types of connections.

• You can connect result viewer web parts to one another. For information about 
connecting result viewers, refer to Connect result viewer web parts to one another 
on page 94.

• You can connect Windows SharePoint Services web parts to one another. For 
more information, refer to Windows SharePoint Services documentation.

• You can connect Office SharePoint Server business data web parts to one 
another. For more information, see the Office SharePoint Server documentation.

Connection methods
Business Portal provides two methods for connecting web parts: the standard 
method delivered with Windows SharePoint Services, and an alternative method 
delivered with Business Portal. You must use the alternative method when 
connecting result viewer web parts to one another. We recommend using the 
standard method in all other cases.

Standard method Windows SharePoint Services handles the communication 
between web parts. Using SharePoint for web part communication is referred to as 
the standard method of publishing and subscribing. 

Alternative method Result viewer web parts use the alternative method of 
publishing and subscribing. You can use the alternative connection between only 
result viewer web parts; you cannot use it with SharePoint web parts.

The web part gallery

Web parts are made available to users from the web part gallery, which is shared by 
all sites in a site collection. Web parts in the gallery are organized into groups. 
Business Portal result viewer and KPI web parts are contained in a group called 
Business Portal web parts.

By default, web parts in the gallery inherit permissions from the top-level site in the 
collection. However, the BP Internal User SharePoint group has access to web parts 
in the Business Portal web parts group.

For more information about the web part gallery, refer to the SharePoint 
documentation.
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Adding web parts to a page

To add web parts to a page, click Site Actions > Edit Page. The page will switch to 
edit mode, so you can select and configure web parts.

Once you have added a web part to a page, additional menus and tool panes 
become available, so you can define web part properties and, if applicable, connect 
web parts. Web part tool pane options differ depending on the type of web part.

Information about SharePoint web parts and their options is available in the 
Windows SharePoint Services documentation. For information about configuring 
result viewer or tab web parts after adding them to a page, see Configure a result 
viewer web part on page 89 and Configure a tab web part on page 91.

Types of result viewer web parts

There are four types of result viewer web parts you can use to display query results: 
primary publishing list, rich list, simple list and form viewer. Choose a result viewer 
web part based on the number and complexity of the query results you want to 
display. For more detailed information about how you can define the properties of 
result viewer web parts, see Result viewer configuration options on page 86.

Result viewer web parts can be used only on the top-level Business Portal site and 
its subsites.

Primary publishing list
Use a primary publishing list to display a list of query results with few columns of 
data. The primary publishing list is a publisher, which means that if you select an 
item in the list, that data can be transmitted to a subscriber web part. If a subscriber 
web part is connected to the publisher, the subscriber web part updates its content 
when selections in the publishing list change.

Rich list
Use a rich list to display a list of query results with many columns of data. A rich list 
can display data based a query, or based on an item selected in a publisher web part. 
The rich list web part can be a publisher, subscriber, or both at the same time.

Simple list
Use a simple list to display limited sets of data where there are between one and 50 
records in the list, and between one and five columns of data. For example, a simple 
list could show balances on a customer’s recent statements or a list of users in the 
MBF Administrator role.

Like the rich list, the simple list can be a publisher, subscriber, or both at the same 
time. However, the simple list doesn’t have paging, menu, or Find capabilities.

Form viewer
Use a form viewer to display a single row of data, in vertical format. Headings run 
down the left side, rather than across the top. The form viewer web part is a 
subscriber. A form viewer web part can include a menu and an action area; 
however, it has no Find capabilities.
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Result viewer configuration options

Following are descriptions of the properties you can define as you configure a result 
viewer web part on a page. The default settings for each result viewer type are also 
included. For more information about the different types of web parts, see Types of 
result viewer web parts on page 85.

Query selection
You can choose an existing query or create a new query for a result viewer web part. 
The Create New Query button on the web part tool pane launches the Create a 
Query wizard. (For more information about creating a query, see Chapter 12, 
“Creating queries.”) The Use Existing Query button allows you to select a query 
that has already been defined.

Once you’ve specified a query for the web part, a Modify Query button replaces 
those for selecting a query in the web part tool pane, so you can make changes 
whenever needed. For information about using this option, see Modify a result viewer 
web part query on page 74.

Number of rows returned
You can specify whether all results for a query should be displayed at once, or only 
a specific number of rows should be displayed. For example, if a query returns 2000 
result rows, a result viewer can be set to display 100 rows at a time.

If you choose to return a specific number of rows for a primary publishing list or 
rich list result viewer, then you also must choose to display the Status area, which is 
where paging buttons are displayed. See Status area on page 89. 

If a result viewer web part returns all results at once, and the query returns a large 
number of rows, it can take a long time to display the results. We recommend that 
result viewers display 50 or fewer rows at a time.

Automatic refresh
You can indicate whether information in a web part should be updated (refreshed) 
automatically, and if so, how often. If you do not choose automatic refresh, then the 
data will be updated only when the page is opened or when you click the browser’s 
Refresh button.

By default, data is not refreshed automatically for any of the result viewer types.

Result viewer type Default setting

Primary publishing list Yes. Display 50 rows.

Rich list

Simple list Not applicable

Form viewer
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Web part communication
The following table shows which result viewer web parts can be used to publish 
and which can be used to subscribe.

For information about setting up web parts to communicate with each other, see 
Connect result viewer web parts to one another on page 94.

Query menu
Primary publishing list and publishing rich list result viewers can have multiple 
queries. For these web parts, you can include a query menu, which allows users to 
choose which query they want to see results for. You can also provide menu options 
to create a new query or modify the existing query.

You can include the query menu on other web parts to provide the Modify Existing 
Query option. You also can choose not to include the menu on the web part, if you 
don’t want users to have any of these options.

For information about using the Modify Existing Query option, see Modify a result 
viewer web part query on page 74.

Find option
For some result viewers, you can allow users to search query results by displaying a 
Find option.

Result viewer type Publish Subscribe

Primary publishing list X

Rich list X X

Simple list X X

Form viewer X

Result viewer type Default setting

Primary publishing list Show “Create New Query” and Show “Modify Existing Query”

Rich list Show “Create New Query” and Show “Modify Existing Query” 
(When the rich list is used as a subscriber, the Create New Query 
option will not appear in the query menu, even if this option is 
selected in the tool pane.)

Simple list Not applicable

Form viewer Show “Modify Existing Query” (The option to show “Create New 
Query” is not applicable.)

Result viewer type Default setting

Primary publishing list Yes. Display the Find option.

Rich list

Simple list Not applicable

Form viewer
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The Find feature cannot search for custom data types. These include:

Column headings
Column headings allow users to resize and reorganize columns in a result viewer 
web part. By default, all result viewer types display column headings.

If a user changes columns, that modifies the query and therefore runs the query again. You 
may not want users to change column headings if the query is run on a large data table. It 
could take a long time to process results each time a column is changed.

Row selection
For some result viewers, users can select a single row of data to perform tasks or 
actions against, or to publish to another web part.

You must enable row selection if you are creating a publisher web part that will be 
connected to a subscriber web part. When a user clicks a row in the publisher web 
part, that data is published for the subscriber. For example, a user could click a 
customer name in a primary publishing list showing all customers, and then a 
subscribing rich list could display that customer’s recent orders.

Multiple row selection
For some result viewers, you can choose multiple rows to publish. Check boxes are 
displayed on the result viewer web part if you enable multiple row selection.

Custom data type Example

Money $342.19

Quantity 57

Phone number (312) 555-0101

Time 8:30

Date 08/30/03

Percent 15%

Account number 000-1103-00

Result viewer type Default setting

Primary publishing list Yes. Enable row selection.

Rich list

Simple list

Form viewer Not applicable

Result viewer type Default setting

Primary publishing list No. Do not display check boxes.

Rich list

Simple list Not applicable

Form viewer
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Status area
Result viewer web parts can contain a status area. On simple list and form viewer 
web parts the status area displays error messages. On primary publishing list and 
rich list result viewers, the status area displays error messages and buttons for 
paging through query results. If you have chosen to return a specific number of 
rows in a primary publishing list or rich list result viewer, then you must choose to 
display the status area, so paging buttons will be available.

By default, all result viewer types display a status area.

Custom “No Results” message
When a result viewer web part returns no results because no data for the query 
exists, the standard message that appears in the web part is “Query returned no 
results.” For all result viewer styles, you can use this default message or create a 
custom message for users.

Style sheet URL
You can link to a cascading style sheet (CSS) file, which will determine the size, 
color, and style of the web part.

Appearance, layout, and advanced web part properties
The result viewer web part tool panes include Windows SharePoint Services 
settings for the appearance, layout, and advanced behavior of web parts. These 
properties are described in Windows SharePoint Services documentation and in 
ToolTips that appear when you move the pointer over each option.

Configure a result viewer web part

Use the following procedure to configure a result viewer web part on a page. Result 
viewer web parts can be used only on sites in the Business Portal site collection. 

1. Click Site Actions > Edit Page. The page will switch to edit mode.

2. Click Add a Web Part in the zone where you want to add the web part. For 
more information, see Adding web parts to a page on page 85.

3. Click the link inside the web part to open its properties tool pane.

4. Set the properties for the result viewer web part. For more information about 
each option, see Result viewer configuration options on page 86.

For more information about connecting web parts, refer to Web part connections 
overview on page 84. 

5. To see the web part as it will appear to users, while keeping the tool pane open 
for additional configuration, click Apply. 

6. To save your settings and close the tool pane, click OK.

Result viewer type Default setting

Primary publishing list /BusinessPortal/UI/ResultViewer/Stylesheets/PPL.css

Rich list /BusinessPortal/UI/ResultViewer/Stylesheets/RichList.css

Simple list /BusinessPortal/UI/ResultViewer/Stylesheets/SimpleList.css

Form viewer /BusinessPortal/UI/ResultViewer/Stylesheets/Form.css
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Create a SharePoint web part

Result viewer web parts are used to display data that originates in Microsoft 
Dynamics GP. In addition to this data, you may want to display other content that is 
used by your organization, but that is not stored in the accounting system. For 
example, you may want to create a web part that displays your company’s 
employee handbook and related Human Resources documents.

To display these other types of content, use SharePoint web parts. The following 
steps explain how to create a SharePoint web part.

These steps apply to all SharePoint content types, such as document libraries, 
announcement lists, surveys, and discussion boards.

1. Go to the web site where you want to create a SharePoint web part and click 
Site Actions > Create.

2. Click the type of content that you want to create. (For example, Document 
Library.)

3. Follow the instructions displayed to create the new item.

4. After you have created the content item, go to the Business Portal page where 
you’d like to display it.

5. Click Site Actions > Edit Page. The page will change to edit mode. 

6. Click Add a Web Part in the zone where you want to add the new item.

7. On the Add Web Parts page, browse through the web parts listed until you find 
your new content item.

8. Mark the check box for the item and click Add. The web part is added to the 
page.

9. Click Exit Edit Mode.

Back Office Tasks web parts

Most center site home pages include a Back Office Tasks web part, which is a 
SharePoint task web part that displays links to windows in Microsoft Dynamics GP. 
Clicking a task link opens a new Terminal Services session. For information about 
setting up Terminal Services for Business Portal, see Set up Microsoft Dynamics GP 
Terminal Server access on page 21.

By default, each Back Office Tasks web part has an associated view, which shows 
only those tasks associated with the center site where the web part is displayed. 
There is also an All Links view that shows all available tasks, whether or not they’re 
assigned to center sites.

All users with access to a center site have access to the Back Office Tasks web part. 
However, users must log on to Microsoft Dynamics GP in order to access Microsoft 
Dynamics GP windows.
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To change the tasks listed in a Back Office Tasks web part, you’ll need to create a 
new view and associate that view with the web part.

1. Go to the center site home page where you want to modify the Back Office 
Tasks web part.

2. Click View All Site Content.

3. Under Lists, click the back office tasks list.

4. In the View menu, select the All Links view. Make note of the IDs of the tasks 
you want to include in the new view.

5. Click Settings > Create View.

6. If you want to include the tasks that are already in the web part, click the 
current view name under Start from an existing view.

7. Enter a name for the view.

8. In the Filter section, add filters based on the task IDs you noted earlier. 

9. Click OK when you’re finished setting up the view.

10. Go back to the center site home page where the web part appears.

11. Click Modify Shared Web Part.

12. Under Selected View, select the view you just created.

13. Click OK to exit edit mode.

Configure a tab web part

Use a tab web part to organize information by placing it on separate tabs within a 
single web part. For example, employee profile information can be separated onto 
tabs for personal information, emergency contacts, dependents, position history, 
and more. Rather than create a page with individual web parts for each type of 
information—which can be difficult to organize and may require the user to scroll to 
find all of the web parts—you can create a tab web part with a separate tab for each 
type of information, as shown here.

To provide content for each tab in a tab web part, you can use .htm, .asp, and .aspx 
files that already have been created. 

Use the following steps to configure a tab web part on a page.

1. Click Site Actions > Edit Page. The page will change to edit mode. 

2. Click Add a Web Part in the zone where you want to add the tab web part.
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3. On the Add Web Parts page, under Business Portal web parts, select the check 
box next to Tab Web Part and click Add. The web part is added to the page.

4. In the web part title bar, click Edit > Modify Shared Web Part to open the web 
part’s properties tool pane.

5. In the tool pane, click Add to add a tab for the web part.

6. Type a name for the tab in the Name box.

7. To fill the content area of the tab, type the URL of any standard web page, 
including .htm, .asp, or .aspx files.

If you’re using a file you created (rather than an Internet address), you should 
place the file in the Business Portal folder on the web server, and use the path 
/businessportal/<subfolder>/<file name>.

8. To include an icon on the tab, type the path or address to the image file in the 
Icon box. You can use any image file format supported by Internet Explorer, 
including .gif, .jpeg, and .png. The image you use should be small (16 x 16 
pixels is recommended), because it cannot be resized in the tab.

We recommend placing the image file in the Business Portal folder on the web 
server, and using the path /businessportal/images/<image file name>.

9. To display a ToolTip when users move the pointer over this tab, type descriptive 
text in the ToolTip box.

10. To provide a shortcut for accessing this tab, type a single key in the Keyboard 
Shortcut box. When users type ALT + <key> (for example, ALT + S), this tab will 
be displayed.

You can use the same shortcut key for more than one HTML element on a page. Users 
would need to re-type the keyboard shortcut until they have found the desired link. (This 
is similar to using ALT + TAB to cycle through open applications.)

11. To update and save the web part with this tab, click Apply. 

12. Add tabs by repeating steps 5 through 11.

13. To close the tool pane, click OK.

Dynamics GP report viewer configuration options

Following are descriptions of the properties you can define as you configure a 
Dynamics GP report viewer web part on a page.

Report Information
You can enter a relative path to the Reporting Services report or use the report 
lookup window to select a report. A relative report path is the location of the 
Reporting Services report relative to the folder name of the company database 
where the Reporting Services reports were deployed. 
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Report view
The toolbar provides page navigation, refresh, search, export, and print 
functionality for reports. You can specify how to display the toolbar in the Web part. 

Parameters are values that are used to select or filter specific data for your report. 
After you specify a parameter, click View Report in the Web part to get the data. You 
can specify how to display the parameters in the Web part.

A report can contain links to other reports. The report that opens when you click the 
link in the main report is known as a drillthrough report. You can specify whether 
to have the drillthrough report to display in a new window.

Appearance, layout, and advanced web part properties
The Dynamics GP report viewer web part tool panes include Windows SharePoint 
Services settings for the appearance, layout, and advanced behavior of web parts. 
These properties are described in Windows SharePoint Services documentation and 
in ToolTips that appear when you move the pointer over each option.

You must define the height and width settings for the appearance of the Web part. If 
you don’t define the height and width, only the toolbar will appear when you 
render a report. 

Configure a Dynamics GP report viewer web part

Use the following procedure to configure a Dynamics GP report viewer web part on 
a page. Dynamics GP report viewer web parts should be used only on sites in the 
Business Portal site collection. 

1. Click Site Actions > Edit Page. The page will switch to edit mode.

2. Click Add a Web Part in the zone where you want to add the web part. For 
more information, see Adding web parts to a page on page 85.

3. Click the link inside the web part to open its properties tool pane.

4. Set the properties for the Dynamics GP report viewer web part. For more 
information about each option, see Dynamics GP report viewer configuration 
options on page 92.

5. To see the web part as it will appear to users, click Exit Edit Mode. 

6. To save your settings and close the tool pane, click OK.

Toolbar Display Mode Settings displayed

Full Page navigation controls, Page display controls, Search field, 
Refresh button, Export formats, Print Icon, Show and Hide icons

Navigation Page navigation controls, Search field, Show and Hide icons

Minimal Refresh button, Print Icon, Show and Hide icons

None The toolbar isn’t displayed in the Web part.

Parameter Area Display Mode Settings displayed

Collapsed The parameters can be hidden or shown in the Web part.

Displayed The parameters are displayed in the Web part.

Hidden The report parameters aren’t displayed in the Web part.
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Result viewer communication behaviors

When connected, there are several result viewer web part behaviors to keep in 
mind:

• Rich publishing list and simple list result viewer web parts can publish one 
business entity and subscribe to another; however, they cannot publish and 
subscribe to the same entity.

• Result viewer web parts cannot publish or subscribe to multiple entities.

• If a result viewer web part is a subscriber, current data won’t be displayed until 
a selection is made in its connected publisher web part.

• If a result viewer web part is a publisher but not a subscriber, its data is updated 
immediately upon opening the page. If it also is subscribing, it will not update 
its data until a selection is made in its connected publisher web part.

Connect result viewer web parts to one another

Once you’ve added result viewer web parts to a page, you can go to that page and 
connect parts. You can make this connection from the publisher to the subscriber or 
from the subscriber to the publisher.

Connecting result viewer web parts includes the following steps:

• Configuring the publishing result viewer web part
• Configuring the subscribing result viewer web part
• Setting the page to edit mode to connect the parts

The following procedure describes connecting result viewer web parts after they have been 
added to a page. If you prefer, you can also connect them as you add and configure them, 
with the page in edit mode. You can see which ones can be connected to each other using the 
Connections submenu of the web part menu.

1. To configure the publishing result viewer web part, select Modify Shared Web 
Part from the web part menu.



A D M I N I S T R A T O R ’ S G U I D E 95

C H A P T E R  1 4    M A N A G I N G  W E B  P A R T S

2. In the result viewer tool pane that appears, you can create a new query, use an 
existing query, or modify the query already associated with the web part. For 
information about modifying a result viewer query, refer to Modify a result 
viewer web part query on page 74. 

3. Click the plus sign next to Web Part Communication and click Configure 
Publishing to open the Web Part Communication dialog box. Select the entity 
the result viewer should publish data from, and click Save.

Also, select Use alternative publishing method. 

4. Set any other configuration options needed in the tool pane. For descriptions, 
see Result viewer configuration options on page 86. Click OK to save changes and 
close the tool pane.

5. To configure the subscribing result viewer web part, select Modify Shared Web 
Part from the web part menu.

6. In the result viewer tool pane, you can create a new query, use an existing query, 
or modify the query already associated with the web part. Be sure the query 
uses the same business entity as the publishing result viewer web part’s query.

7. Click the plus sign next to Web Part Communication and click Configure 
Subscribing to open the Web Part Communication dialog box. Select the same 
entity you chose for the publisher part, and click Save.
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Also, select Use alternative subscribing method.

8. Set any other configuration options needed in the tool pane. For descriptions, 
see Result viewer configuration options on page 86. Click OK to save changes and 
close the tool pane. Query results should appear in publishing and subscribing 
web parts as soon as the page is refreshed.

Web part menu options

The following options can be available on the web part menu, depending on the 
type of web part, its configuration, and your level of permission.

• Delete removes the web part from the page and permanently deletes it from the 
web part gallery. For more information, see Remove web parts from a page on 
page 96.

• Minimize collapses the web part so only the title bar is visible. To expand the 
web part, choose Restore from the web part menu.

• Close removes the web part from the page. The web part is stored in the web 
part gallery and can be added back to the page later.

• Modify starts edit mode and opens the web part tool pane, so you can change 
web part properties. SharePoint web part properties are explained in Windows 
SharePoint Services documentation. For information about result viewer or tab 
web part properties, see Result viewer configuration options on page 86 and 
Configure a tab web part on page 91.

• Connections shows which web parts can be connected to each other and which 
connection methods can be used. For more information about web part 
connections, refer to Web part connections overview on page 84.

• Export allows you to save web part files for use outside of Business Portal. For 
more information about this option, refer to the Windows SharePoint Services 
documentation.

• SharePoint web parts also include a Help option, which opens Windows 
SharePoint Services help.

Remove web parts from a page
You can remove web parts from a page either in edit mode or when you browse to 
the page.
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Use edit mode
There are two main ways to remove web parts from a page in edit mode:

• Click Close in the upper right corner of the web part or click the web part menu 
and select Close. This removes the web part from the page and stores it in the 
web part gallery.

• Click the web part menu and select Delete. This removes the web part from the 
page and permanently deletes it from the web part gallery.

When a result viewer web part is removed using the Delete option, the associated query 
subfolder should be removed from the corresponding DataCenter folder using the 
Organize Queries page. See Delete a query on page 80.

Browse to the page
If the Allow Close option was selected when the web part was configured, you can 
open the page, then click the Close button in the upper right corner of the web part 
or click the web part menu and select Close. The web part is stored in the web part 
gallery and can be added back to the page later.

If Allow Close was not enabled during web part configuration, the web part cannot 
be closed by users. For more information about web part configuration, see 
Configure a result viewer web part on page 89 and Configure a tab web part on page 91.
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Part 4: Reports administration
Providing users with easy access to the Microsoft Dynamics GP reports they need is 
a key feature of Business Portal. Depending on your implementation, this capability 
is provided by either the Reports Catalog or the Report Center site.

Reports Catalog is available if you’re using Business Portal with Windows 
SharePoint Services. The Report Center site is available if you’re using Business 
Portal with Office SharePoint Server, Enterprise Edition. 

The following information is included:

• Chapter 15, “Reports Catalog,” explains the steps necessary for getting the 
Reports Catalog ready to use and describes administrative tasks associated with 
the Reports Catalog.

• Chapter 16, “Report Center,” describes how to use the Report Center site in 
Office SharePoint Server, Enterprise Edition. The Report Center site serves as a 
central location to manage business-critical information sources, such as 
reports, spreadsheets, and SQL Reporting Services data connections.
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Chapter 15: Reports Catalog
Reports Catalog is 
available only if you’re 
using Business Portal 
with Windows 
SharePoint Services.

The Reports Catalog stores and manages Microsoft Dynamics GP reports for 
display in Business Portal.

The Reports Catalog is a file location on a server, plus a SQL table and a business 
entity. Reports in the Reports Catalog are static—data is displayed as of the date 
they were published. You determine how often each report is published.

To get started using the Reports Catalog to store Microsoft Dynamics GP reports, 
you must complete two procedures. First, you’ll need to map report sets to Business 
Portal center sites, using the Set Up Reports Catalog page. Then you’ll need to 
create the reports so they are available to users. After you’ve set up Reports Catalog, 
you can change the center site or MBF role assigned to a particular report.

If you’re using Business Portal with Office SharePoint Server, Enterprise Edition, see 
Chapter 16, “Report Center.”

Information about Reports Catalog is divided into the following sections:

• Assign report sets to centers
• Publish Microsoft Dynamics GP reports to Reports Catalog
• How users view reports
• Assigned/not assigned reports
• Change the center site assigned to a report
• Change the MBF roles assigned to a report

Assign report sets to centers

The first step in setting up Reports Catalog is to decide which Business Portal center 
site, such as Finance, Sales, or Inventory, each report set should be associated with. 
A report set includes all reports specific to a particular series in Microsoft Dynamics 
GP. 

After you’ve mapped report sets to center sites, you can change the default center 
site for an individual report using the Manage Reports Catalog page. For more 
information, see Change the center site assigned to a report on page 103.

1. Go to the Administration Home page on the Business Portal web site.

2. Under Reports Catalog, click Reports Catalog setup. The Reports Catalog 
Setup page appears.

3. Using the Business Portal Center Pages lists, select a center site to map to each 
corresponding Microsoft Dynamics GP report set.

4. Click Save.
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Publish Microsoft Dynamics GP reports to Reports 
Catalog

When Business Portal is installed, sample reports are installed in a shared folder 
(called SampleReports) on the web server. The first time you open the Reports 
Catalog Management page (Site Actions > Site Settings > under Reports Catalog, 
click Reports Catalog management) and select Reports - All from the Reports 
query menu, sample reports will appear in the Reports list.

To publish your own reports, we recommend setting up a new shared folder to 
make your reports more secure. You can set up the shared folder on the web server, 
on the Microsoft Dynamics GP server, or on a file server on your network. For more 
information about creating and granting access to the shared reports folder, refer to 
the Business Portal Installation Guide.

Once the shared folder has been set up, you will need to run the Report Scheduler to 
publish reports. Report Scheduler is a Microsoft Dynamics GP application that 
enables flexible, secure scheduling and publishing of your Report Writer reports. 
Use the Microsoft Dynamics GP Report Scheduler to indicate when and how often a 
particular Report Writer report should be published to the shared reports folder. 

Besides viewing reports associated with their Business Portal roles, users who have 
a Microsoft Dynamics GP user ID can create, schedule, and publish new reports and 
assign these reports to center sites and MBF roles using Report Scheduler. 

Report Scheduler is installed automatically when you install Microsoft Dynamics 
GP. You can access Report Scheduler by choosing Microsoft Dynamics GP > Tools 
> Routines > Company > Report Schedule in Microsoft Dynamics GP. For 
information about using Report Scheduler, refer to the Report Scheduler 
documentation.

Report Scheduler report publishing can slow down Microsoft Dynamics GP performance, so 
it is best to have reports run during off-peak hours.

How users view reports

In order for users to view reports in the Reports Catalog, you must modify their 
MBF roles to include the ReportCatalog_All and ReportCatalog_RoleDAP data 
permissions. This applies to all users except those in the Administrator and Reports 
Catalog Administrator roles. See Modify the permissions associated with a role on 
page 53 for more information.

On center site home pages—such as Finance Home or Inventory Home—there is a 
Top 5 Reports web part. As a user views reports, a list of the five reports reviewed 
most often is built and displayed in the Top 5 Reports web part. The list changes 
based on the user’s viewing habits. The user can click on a report in this web part to 
display the report.
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Assigned/not assigned reports

In the Reports list on the Reports Catalog Management page, you can use the query 
menu to show all reports, assigned reports, or not assigned reports.

A report is considered assigned when it has been assigned to one or more Business 
Portal center sites or MBF roles. If a report has not been assigned to any center sites 
or MBF roles, the report is considered not assigned and will not appear on the 
Reports page of any Business Portal center sites.

Change the center site assigned to a report

During Reports Catalog setup, you assigned sets of reports to Business Portal center 
sites. You can change this information for individual reports using the Reports 
Catalog Management page.

For example, you may have assigned all inventory reports to the Inventory Center 
site during setup. Using the Reports Catalog Management page, you can select an 
individual inventory report, such as an inventory items list, and assign it to the 
Purchasing Center site. 

Use the following steps to change the center site assigned to a report, or to assign a 
center site to a report that hasn’t yet been set up in Reports Catalog.

1. Go to the Administration Home page on the Business Portal web site.

2. Under Reports Catalog, click Reports Catalog management. The Reports 
Catalog Management page appears.

3. In the Reports list, select the report to assign to a different Business Portal 
center site.

4. In the Business Portal Center Pages web part, click Modify and select or clear 
the necessary check boxes.

5. Click OK to save changes.

Change the MBF roles assigned to a report

The Roles web part on the Reports Catalog Management page displays MBF roles 
assigned to the report selected in the Reports list. These roles are assigned when 
you schedule a report to be published using Report Scheduler. You can change the 
assigned roles using the Reports Catalog Management page.

1. Go to the Administration Home page on the Business Portal web site.

2. Under Reports Catalog, click Reports Catalog management. The Reports 
Catalog Management page appears.

3. In the Reports list, select the report for which to change roles.

4. In the Roles web part, click Modify and select or clear the necessary check 
boxes.

5. Click OK to save changes.
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Chapter 16: Report Center
The Report Center site 
is available only if 
you’re using Business 
Portal with Office 
SharePoint Server, 
Enterprise Edition. 

The Report Center is a site in Office SharePoint Server, Enterprise Edition, that 
serves as a central location to manage business-critical information sources, such as 
reports, spreadsheets, and SQL Reporting Services data connections. 

If you’re using Windows SharePoint Services only, see Chapter 15, “Reports Catalog.” 

Information about using the Report Center site is divided into the following 
sections:

• Report Center overview
• Microsoft Dynamics GP report libraries
• Security for Microsoft Dynamics GP report libraries
• Publishing reports to the Report Center site
• Viewing reports with versioning or content approval

Report Center overview

The Report Center site in Office SharePoint Server is essentially a group of 
SharePoint libraries. A library is a location on a site where you can create, collect, 
update, and manage files with team members. A library displays a list of files and 
key information about the files, which helps people to use the files to work together. 
You can create and manage documents, spreadsheets, presentations, forms, and 
other types of files in a library. 

When you install Office SharePoint Server, Enterprise Edition, a Report Center site 
is created under the top-level SharePoint site (at the same level as the top-level 
Business Portal site). Users in the BP Internal User SharePoint group automatically 
have access to the Report Center site.

When you install Business Portal, additional report libraries are automatically 
created on this Report Center site for Microsoft Dynamics GP reports. For more 
information about the report libraries created with Business Portal, see Microsoft 
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Dynamics GP report libraries on page 107. Links to these report libraries appear in the 
Quick Launch on the Report Center site, as shown in the following illustration.

Microsoft Dynamics GP reports can be published to the Report Center site in many 
different file formats. You can choose which file formats can be uploaded to your 
Report Center site. You can also publish other types of reports, such as FRx reports 
or reports from applications like Microsoft Office Excel.

Reports contained in Report Center document libraries are static—data is displayed 
as of the date they were published. You determine how often each report is 
published using either the Microsoft Dynamics GP Report Scheduler or standard 
SharePoint document library functionality. For more information about publishing 
reports to the Report Center site, see Publishing reports to the Report Center site on 
page 108.

Using SharePoint functionality, users can receive alerts when new reports are added 
to the Report Center, create document workspaces to collaborate on reports, set up 
workflows to review reports, and even access reports offline through the Microsoft 
Office Outlook® integration.

For more information about Report Center sites and how to manage them, see the 
Office SharePoint Server documentation.
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Microsoft Dynamics GP report libraries

When you install Business Portal, the following report libraries are created on the 
Report Center site: 

• Executive Reports
• Financial Reports
• Human Resources Reports
• Inventory Reports
• Manufacturing Reports
• Payroll Reports 
• Purchasing Reports
• Sales Reports

Use these libraries to publish your Microsoft Dynamics GP reports. 

Within each report library, a folder is automatically created for each company in 
Microsoft Dynamics GP. Each folder name consists of the name of the report library 
followed by the company name. For example, folders in the Executive library for 
companies 1, 2, and 3 would appear as shown in the following example. 

Some special characters can’t be used in folder names, so they will be removed from company 
names when folders are created. The following characters are prohibited: tilde (~), quotation 
mark (“), number sign (#), percent (%), ampersand (&), asterisk (*), colon (:), angle brackets 
(< and >), question mark (?), slash mark (/), backslash (\), pipe (|), apostrophe ('), plus sign 
(+), equal sign (=), comma (,), semicolon (;), brackets ([ and ]), at sign (@), and braces ({ and 
}).

If you add a new company to the database after installing Business Portal, you must 
create the appropriate company folder in each report library; it won’t be created 
automatically.

Security for Microsoft Dynamics GP report libraries

When you install Business Portal, SharePoint groups are automatically created to 
enable you to secure reports by company on the Report Center site. For each 
company-specific reports folder in a report library, a corresponding SharePoint 
group is created that permits read-only access to that reports folder. (For more 
information about company folders, refer to Microsoft Dynamics GP report libraries on 
page 107.)

You can add users to SharePoint groups for just the companies that they have access 
to. For example, assume the Financial Reports library contains a folder called 
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Financial Reports - Fabrikam. In order to grant access to this folder, a corresponding 
SharePoint group called BP Financial Reports - Fabrikam is created. The group is 
granted read-only access to that folder. Users in the BP Financial Reports - Fabrikam 
group have access only to the reports in the Financial Reports - Fabrikam folder; 
they don’t have access to other folders for other companies.

Some special characters can’t be used in group names, so they will be removed from company 
names when groups are created. The following characters are prohibited: tilde (~), quotation 
mark (“), number sign (#), percent (%), ampersand (&), asterisk (*), colon (:), angle brackets 
(< and >), question mark (?), slash mark (/), backslash (\), pipe (|), apostrophe ('), plus sign 
(+), equal sign (=), comma (,), semicolon (;), brackets ([ and ]), at sign (@), and braces ({ and 
}).

If you’re using versioning or content approval on the Report Center site, you may 
need to change your settings so that users in company-specific SharePoint groups 
can view reports. For more information, see Viewing reports with versioning or content 
approval on page 109.

If you add a new company to the database after installing Business Portal, you must 
create the appropriate company groups and give them access to the appropriate 
folders; groups won’t be created or assigned automatically.

Publishing reports to the Report Center site

There are two ways to publish reports to the Report Center site in Office SharePoint 
Server. You can use the Microsoft Dynamics GP Report Scheduler, or you can use 
standard Windows SharePoint Services document library features.

You can also use a combination of the two methods. You can use the Report 
Scheduler to automatically publish reports, and then use SharePoint document 
library features to manage those reports on the Report Center site. You can also use 
SharePoint document library features to publish documents that can’t be published 
through the Report Scheduler, such as FRx reports or Excel spreadsheets.

Publishing using Report Scheduler
Users who have a Microsoft Dynamics GP user ID can create, schedule, and publish 
new reports and assign those reports to Report Center site libraries using Report 
Scheduler. If users are publishing reports to the report libraries created with 
Business Portal, they must also belong to the BP Report Publisher SharePoint group.

Use the Microsoft Dynamics GP Report Scheduler to indicate when and how often a 
particular Report Writer report should be published to the Report Center site. You 
can access Report Scheduler by choosing Microsoft Dynamics GP > Tools > 
Routines > Company > Report Schedule in Microsoft Dynamics GP. 

For more information about using Report Scheduler with Office SharePoint Server, 
refer to the Report Scheduler documentation.

Report Scheduler report publishing can slow down Microsoft Dynamics GP performance, so 
it is best to have reports run during off-peak hours.

Using SharePoint document library features
Uploading files to report libraries works just like uploading files to any other 
SharePoint document library. You can also use document library features to control 
how documents are viewed, tracked, managed, and created. You can track versions, 
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including how many and which type of versions, and you can limit who can see 
documents before they are approved.

If you’re using versioning or content approval on the Report Center site, you may 
need to change your settings so that users in company-specific SharePoint groups 
can view reports. For more information, see Viewing reports with versioning or content 
approval on page 109.

For more information about managing document libraries, see the Office SharePoint 
Server documentation.

Viewing reports with versioning or content approval

If you’re using versioning or content approval on the Report Center site, users in the 
default SharePoint groups may not be able to view reports as soon as they are 
published using Reports Scheduler or uploaded to a folder. 

By default, the SharePoint groups created with Business Portal do not have 
permission to view draft items. Drafts are created in two situations: 

• If the library tracks major and minor versions, and no major version of the file 
has been published. (Minor versions are considered drafts.)

• If content approval is required, and a file has been created or updated but not 
yet approved.

If major and minor versions are being tracked, a minor version of a file is only 
visible to people who have permission to see draft items. To make a report 
viewable, you must publish a major version. When a major version is published, the 
file is displayed to anyone with Read permission.

When content approval is required, a file remains in a draft state until it is 
approved. To make a report viewable, you must approve it. When the file is 
approved, it is assigned an Approved status in the library, and it is displayed to 
anyone with Read permission.

Use the Document Library Versioning Settings page to specify whether to track 
versions and require approval. You can also specify whether users with Read 
permission can view draft items. To modify versioning and content approval 
settings on the Report Center site, click Site Actions > Site Settings > Modify Pages 
Library Settings. Under General Settings, click Versioning settings.

For more information about versioning and content approval, see the Office 
SharePoint Server documentation.



110 A D M I N I S T R A T O R ’ S G U I D E



P
A

R
T

 5
: T

H
E

 B
U

S
IN

E
S

S
 D

A
T

A
 C

A
T

A
LO

G
 A

N
D

 S
E

A
R

C
H



112 A D M I N I S T R A T O R ’ S G U I D E

Part 5: The Business Data Catalog 
and Search

The Business Data 
Catalog is available 
only if you’re using 
Business Portal with 
Office SharePoint 
Server, Enterprise 
Edition.

The Business Data Catalog allows users to view and search for Microsoft Dynamics 
GP data. Information about the Business Data Catalog and Office SharePoint Server 
Search functionality is divided into the following sections:

• Chapter 17, “Business Data Catalog concepts,” provides an overview of how 
the Business Data Catalog works with Microsoft Dynamics GP and Business 
Portal.

• Chapter 18, “Search concepts,” explains how the Search Center in Office 
SharePoint Server can be used to search for data from Microsoft Dynamics GP.

• Chapter 19, “Search setup and maintenance,” describes how to set up and 
maintain search functionality for Microsoft Dynamics GP data.
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Chapter 17: Business Data Catalog concepts
The Business Data 
Catalog is available 
only if you’re using 
Business Portal with 
Office SharePoint 
Server, Enterprise 
Edition. 

Information about how the Business Data Catalog is used to make Microsoft 
Dynamics GP data accessible in Business Portal is divided into the following 
sections:

• Business Data Catalog overview
• Business data web parts
• List pages and dashboard pages
• Business data profiles
• Assign the application pool identity to the BDC Administrator role

Business Data Catalog overview

The Business Data Catalog is a service in Office SharePoint Server that is used for 
registering business data types and properties of applications such as Microsoft 
Dynamics GP.

When you install Business Portal on Office SharePoint Server, Enterprise Edition, 
the Microsoft Dynamics GP web service is registered with the Business Data 
Catalog. The web service for Microsoft Dynamics GP provides access to the primary 
documents in the accounting system. Registering the web service makes Microsoft 
Dynamics GP data accessible in the following ways on sites in the Business Portal 
site collection.

Business data web parts, dashboard pages, and list pages Microsoft 
Dynamics GP data can be displayed in business data web parts on Office SharePoint 
Server pages. By default, Business Portal includes list pages and dashboard pages 
that use business data web parts. For more information, see List pages and dashboard 
pages on page 115.

Search Some records available through the web service are also searchable, which 
makes data from Microsoft Dynamics GP available in Office SharePoint Server 
searches. For more information about Search, see Chapter 18, “Search concepts,” 
and Chapter 19, “Search setup and maintenance.”

When you click on a record in search results or in a business data web part, the 
business data profile, or detailed information, for that record is displayed. For more 
information about profiles, see Business data profiles on page 116.



P A R T  5 T H E  B U S I N E S S  D A T A  C A T A L O G  A N D  S E A R C H

114 A D M I N I S T R A T O R ’ S G U I D E

The following illustration shows how Microsoft Dynamics GP data is returned for 
display in Office SharePoint Server.

Because the Microsoft Dynamics GP web service is used to retrieve data for the 
Business Data Catalog, web service security is used to secure the data. For more 
information about data security, see Web service security overview on page 31 and 
Securing search data on page 128.

For more information about the Business Data Catalog, refer to the Office 
SharePoint Server documentation. 
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Business data web parts

Business data web parts are used to display data from the Business Data Catalog. 
For example, data can be displayed in a list using the Business Data List web part. 
Using a data list web part is much like using any SharePoint list, except that the 
data is connected to a data source and is updated automatically.

How Business Portal uses business data web parts
In its default configuration, Business Portal includes list pages and dashboard pages 
that use business data web parts. List pages contain lists of commonly used data, 
such as a list of customers. Users can click an item in the list to show detailed 
information about the selected object. Dashboard pages provided for salespeople 
and sales managers are designed to give an overview of relevant sales information.

For more information, see List pages and dashboard pages on page 115. 

Create a new business data web part
For information about adding a business data web part to a page, refer to the Office 
SharePoint Server documentation. To use Microsoft Dynamics GP data in a business 
data web part, you must select a business data type from the Microsoft Dynamics 
GP application in the web part tool pane.

The business data web parts provided with Business Portal have special formatting 
applied to them. Business data web parts you create may not have the same 
appearance unless you use the XSL editor in the web part tool pane. 

You can copy XSLT from a web part that uses the same entity and paste it in the new 
web part to display the data in the correct format. If you’re familiar with XSLT, you 
may also choose to make your own modifications to the default XSLT for a web 
part.

List pages and dashboard pages

In its default configuration, Business Portal includes list pages and dashboard pages 
that retrieve data using the Microsoft Dynamics GP web service and the Business 
Data Catalog. Data from Microsoft Dynamics GP is displayed in Office SharePoint 
Server business data web parts on these pages.
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List pages contain lists of commonly used data. Users can click an item in the list to 
show detailed information about the selected object. For example, the Salesperson 
List page appears on the Sales Center site. You can click on a salesperson in the list 
to view the business data profile, or detailed information, for that salesperson. List 
pages appear on most Business Portal center sites, and can be identified by the word 
“list” in their names.

Dashboard pages bring together varied information to help people perform their 
jobs effectively. Dashboard pages appear by default only on the Sales Center site, 
and are available for salespeople and sales managers. For example, the Salesperson 
Dashboard includes the Sales and Commissions page, the Customer Balances page, 
and the Customer Documents page.

While page security for list and dashboard pages works the same as for all other 
Business Portal pages, data security is handled through web services instead of 
through MBF. For example, users in the BP Inventory Manager SharePoint group 
have access to the Sales Item List page by default. In order to view the data on that 
page, those users must also belong to the WMS role in web services. For more 
information about adding users to web service roles, see Add users to web service roles 
on page 63.

Business data profiles

Business data profiles are lists of properties associated with business data types 
from applications registered in the Business Data Catalog. If they have access to the 
data, users can view the business data profile for an entity by clicking a link to that 
entity in a business data web part. For example, clicking an account number in a 
posting account list displays the GL Posting Account Details page, which includes 
properties such as alias, description, and created date.

Business data profiles for Microsoft Dynamics GP data types are created when the 
web service is registered with the Business Data Catalog.

Business data profile information is protected by web service security, which means 
that users can see only the business data they have been given access to. For more 
information about assigning users to web service roles, see Add users to web service 
roles on page 63.
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Assign the application pool identity to the BDC 
Administrator role

In order to display data from the Business Data Catalog on Business Portal pages, 
the account used as the identity for the Business Portal application pool must be a 
member of the BDC Administrator role in web services. Use the following 
procedure to add this account to the BDC Administrator role.

1. Determine which application pool Business Portal is using:

• On the Business Portal web server, open Internet Information Services (IIS) 
Manager by choosing Start > Administrative Tools > Internet Information 
Services (IIS) Manager.

• Click the plus sign next to your server name.

• Click the plus sign next to Web Sites.

• Right-click the web site where Business Portal is installed. Click Properties.

• In the properties window that appears, click the Home Directory tab.

• Find the Application pool field. The application pool that is entered in this 
field is the Business Portal application pool.

2. Determine which account the Business Portal application pool is running as:

• In IIS Manager, click the plus sign next to your server name.

• Click the plus sign next to Application Pools.

• Right-click the Business Portal application pool. Click Properties.

• In the properties window that appears, click the Identity tab. The account 
shown in this tab is the account the application pool is running as.

3. Add the account to the BDC Administrator role in web services. For more 
information, refer to Add users to web service roles on page 63.
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Chapter 18: Search concepts
Search functionality is 
available only if you’re 
using Business Portal 
with Office SharePoint 
Server, Enterprise 
Edition. 

The Search Center in Office SharePoint Server, Enterprise Edition, provides a single 
location for employees to find content, processes, people, and business data 
relevant to their needs.

The Search feature uses the Business Data Catalog, SharePoint Search Engine, and 
the Microsoft Dynamics GP web service to allow users to locate Microsoft Dynamics 
GP data in addition to content stored on SharePoint sites.

Information about Search concepts is divided into the following sections:

• Search overview
• Microsoft Dynamics GP data that can be searched
• About crawling content
• Crawl schedule guidelines
• Making Search available to users

For more information about the Search feature and the Search Center, see the Office 
SharePoint Server documentation.

Search overview

When the Microsoft Dynamics GP web service is registered with the Business Data 
Catalog and Search is activated for your companies, the Search feature can be used 
to locate Microsoft Dynamics GP data along with data stored in Windows 
SharePoint Services.

Users can access Office SharePoint Server Search functionality from a Business 
Portal web site, or through a desktop search. 

Portal search Portal users can access the Search feature through a Search box 
located in the upper-right corner of all portal pages.

Windows Desktop Search If you set up Windows Desktop Search, users can 
locate Microsoft Dynamics GP data and Windows SharePoint Services content 
along with content from their desktops.

For more information, see Making Search available to users on page 122.

Search results are displayed in the Search Center in Office SharePoint Server. Users 
can select the Dynamics tab in the Search Center to search only Microsoft Dynamics 
GP data. Users can choose to search data for all companies or for a single company.

Summary information is displayed with each Microsoft Dynamics GP data result. If 
the user selects a record on the results page, the business data profile for that record 
is displayed. While all users can view the summary information on the results page, 
detailed business data profiles are protected by web service security. For more 
information about profiles, see Business data profiles on page 116.
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Microsoft Dynamics GP data that can be searched

All data available through the Microsoft Dynamics GP web service is registered 
automatically with the Business Data Catalog when Business Portal is installed. 
However, not all data is designated as searchable. By default, the following data is 
available for searches.

About crawling content

Data in the Microsoft Dynamics GP databases must be indexed in order to be 
searchable. This is known as the crawl process.

Content sources are used to crawl content in your site collections and in Microsoft 
Dynamics GP. A content source is the set of options used to specify what type of 
content is crawled, the URLs to crawl, how detailed the crawl should be, and when 
to crawl.

Entity Work Open History

General Ledger account Posting account
Fixed allocation account
Variable allocation account
Unit account

N/A N/A N/A

General Ledger transaction Yes Yes Yes

Item Sales item
Kit item
Fee item
Service item

N/A N/A N/A

Inventory transaction Adjustment
Variance
Transfer

Yes N/A Yes

Payables document Invoice
Finance charge
Miscellaneous charge
Return
Credit Memo

Yes Yes Yes

Purchase order Yes N/A Yes

Receivables document Invoice
Debit memo
Service repair
Finance charge
Warranty
Return
Credit memo

Yes Yes Yes

Sales document Order
Fulfillment order
Invoice
Back order
Quote
Return

Yes N/A Yes

Customer N/A N/A N/A

Vendor N/A N/A N/A

Salesperson N/A N/A N/A

Sales territory N/A N/A N/A
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There are two types of crawls: full and incremental. A full crawl indexes everything 
in the content source. An incremental crawl indexes only new or updated records. 
Because only “parent” entities are indexed in an incremental crawl, some changed 
content may not be indexed. For example, changes to a customer record may be 
indexed, but customer address changes may not. The initial crawl must be a full 
crawl in order to make all of the data searchable. Subsequent crawls can be 
incremental crawls.

When you activate Search for a company, you’ll select a default crawl schedule 
which includes both types of crawls. You can adjust the crawl schedule later, if 
necessary. For more information, see Change the default crawl schedule on page 131.

The user account that runs the crawl process must be given access to Microsoft 
Dynamics GP data so that all of the data can be indexed. For more information, refer 
to Give the crawl account access to Microsoft Dynamics GP data on page 123.

Crawl schedule guidelines

In order for data to be searched, it must first be indexed, or crawled. There are two 
types of crawls: full and incremental. A full crawl indexes everything in the content 
source. An incremental crawl indexes a smaller set of content. (For more 
information, see About crawling content on page 120.) When you activate Search for a 
company, you’ll select a default crawl schedule. 

Crawl schedules should be planned based on the availability, performance, and 
bandwidth of both the Business Portal web server and the Microsoft Dynamics GP 
database server. For best results, plan crawl schedules based on the following 
considerations:

• Schedule incremental crawls during times when the Microsoft Dynamics GP 
server is available but the demand on the server is low. 

• Schedule full crawls less frequently, when demand on the server is low. 

• Schedule administration changes that require a full crawl to occur shortly 
before the planned schedule for full crawls. 

• When specifying crawl settings for a company, you’ll have the option to exclude 
open and history records. Excluding these records will reduce the number of 
records to be indexed, and therefore reduce crawl time. However, users will not 
be able to search for these records, even if they had been crawled previously. 

• Schedule crawls less frequently if history records are included in crawls. 
History records can add a significant amount of content to be indexed, which 
will increase crawl time.

For information about changing crawl schedules, see Change the default crawl 
schedule on page 131. For more information about crawl schedules, see the Office 
SharePoint Server documentation.
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Making Search available to users

Users can access Office SharePoint Server Search functionality from a Business 
Portal web site, or through a desktop search. When the Microsoft Dynamics GP web 
service is registered as searchable with the Business Data Catalog, the Search feature 
can be used to locate Microsoft Dynamics GP data along with data stored in 
Windows SharePoint Services.

Portal search
Business Portal users can access the Search feature through a Search box located in 
the upper-right corner of all Business Portal pages.

The Search Box web part is available in the Web Part Gallery, so you can also add it 
to any pages you create.

Windows Desktop Search
When Windows Desktop Search (WDS) is installed, a shortcut is added to the Start 
menu and to the task bar for all users of the system. If your system administrator 
sets up WDS to include your Office SharePoint Server, a user can locate information 
normally included in a SharePoint search—including Microsoft Dynamics GP data, 
if the web service is registered with the Business Data Catalog— along with content 
from the user’s desktop.

The administrator can use Group Policy to deliver and apply WDS configurations 
or policy settings to a set of users and computers in Active Directory®. 
Administrative template files (.adm files) for WDS provide the majority of available 
policy settings. To include your Office SharePoint Server in desktop searches, use 
the Add Primary Intranet Search Location policy when setting up WDS.

For more information about deploying and using Windows Desktop Search, go to 
www.microsoft.com/windows/desktopsearch and download the Windows 
Desktop Search Administration Guide.

http://www.microsoft.com/windows/desktopsearch/default.mspx
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Chapter 19: Search setup and maintenance
Search functionality is 
available only if you’re 
using Business Portal 
with Office SharePoint 
Server, Enterprise 
Edition. 

In order to include Microsoft Dynamics GP data in Office SharePoint Server 
searches, you must first activate Search for your Microsoft Dynamics GP companies. 
After you’ve activated Search for a company, you can adjust security on search data 
or change the default crawl schedules.

This information is divided into the following sections:

• Give the crawl account access to Microsoft Dynamics GP data
• Adjust logging
• Activate Search for a company
• Securing search data
• Repair or remove search data for a selected company
• Remove search data for all companies
• Change the default crawl schedule

Give the crawl account access to Microsoft Dynamics 
GP data

In order to properly crawl your data, the account used for crawling must belong to 
the BDC Administrator role in web services, and must belong to the DYNGRP role 
in SQL Server for all Microsoft Dynamics GP databases. Use the following 
procedure to add the crawl account to the BDC Administrator role and the 
DYNGRP role.

1. Determine which account is being used for crawling:

• On the Business Portal web server, open SharePoint Central Administration 
by choosing Start > Administrative Tools > SharePoint 3.0 Central 
Administration.

• In the Quick Launch, click the name of the Shared Service Provider used for 
Business Portal.

• Under Search, click Search settings.

• Under Crawl settings, click Default content access account. The account 
used for crawling is displayed.

2. Add the account to the BDC Administrator role in web services. For more 
information, refer to Add users to web service roles on page 63.
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3. Add the account to the DYNGRP role in the Microsoft Dynamics GP SQL 
databases:

• On the Microsoft Dynamics GP server, open SQL Server Management 
Studio (if you’re using SQL Server 2005.

• Add the user as a SQL login.

• In the Login-New window, under Select a page, click User Mapping.

• Select the check box for each Microsoft Dynamics GP database.

• For each Microsoft Dynamics GP database, under Database role 
membership, select the check box for the DYNGRP role.

Adjust logging

Using default settings, Office SharePoint Server log files can become very large 
when you perform a full crawl of your Microsoft Dynamics GP data. If the log files 
become too large, crawling will stop until space becomes available. We recommend 
adjusting the level of logging in order to prevent interruptions in the crawl process.

For more information about event logging, see the Office SharePoint Server 
documentation.

1. On the Business Portal web server, open SharePoint Central Administration by 
choosing Start > Administrative Tools > SharePoint 3.0 Central 
Administration.

2. Click Operations.

3. Under Logging and Reporting, click Diagnostic Logging.

4. In the Event Throttling section, select an event category, the least critical event 
level to report to the event log, and the least critical event level to report to the 
trace log. Events that are equally critical to or more critical than the selected 
level will be recorded in the logs. 

We recommend selecting a category of All, an event log level of Warning, and a 
trace log level of Unexpected. This will reduce the size of the logs, but error 
information will remain available for troubleshooting.

Log file sizes will vary depending on the number of companies and amount of data being 
crawled. Recommended settings may need to be adjusted to suit the needs of your 
business.

5. Click OK to save your settings.
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Activate Search for a company

To activate Search, you must run the Microsoft Dynamics GP Search Setup wizard 
to register Microsoft Dynamics GP companies with the Business Data Catalog. Use 
the wizard to specify which companies to activate Search for and to select which 
entities and fields to include in searches. You’ll also select a default crawl schedule. 

You can register up to 20 Microsoft Dynamics GP companies with the Business Data 
Catalog. Each Microsoft Dynamics GP company represents two applications in the 
Business Data Catalog. In addition, a general “Microsoft Dynamics GP” application 
is automatically registered when you install Business Portal.

While the Business Data Catalog can register up to 100 applications, the metadata 
limit may be reached before 100 applications are registered. When choosing the 
number of companies for which to activate Search, leave room for other 
applications that you may want to register with the Business Data Catalog. In 
addition, keep in mind that more registered companies will mean decreased 
performance when crawling and searching.

You must use the installation and registration tools provided with Business Portal to 
manage the Microsoft Dynamics GP application and companies registered in the Business 
Data Catalog. While Office SharePoint Server tools are available, the Business Portal tools 
have been designed specifically to manage Microsoft Dynamics GP data. If you use the 
Office SharePoint Server tools, data may not be added or removed correctly.

In order to run the Search Setup wizard, you must belong to the BDC Administrator 
web service role. You also must be a site collection administrator and have rights to 
add stored procedures to the back office SQL databases.

Use the following procedure to activate Search for your companies.

1. Start the Microsoft Dynamics GP Search Setup wizard. (On a Business Portal 
web server, go to Start > Administrative Tools > Microsoft Dynamics GP 
Search Setup.)
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2. If this is the first time you’re running the wizard, click Activate. The Company 
Selection window appears.

If you’ve run the wizard before, you must click Modify/Repair to activate Search for 
additional companies. For more information, see Repair or remove search data for a 
selected company on page 129.

In the Company Name list, select the check boxes for the companies that you 
want to activate Search for. If you clear the check box for a company for which 
Search has previously been activated, the search data for that company will be 
removed.

If you added a new company after Web Services for Microsoft Dynamics GP was 
installed, you must add eConnect and web service support before you can make the 
company available for Search. For more information about adding eConnect and web 
service support for a company, see the Web Services Installation and Administration 
Guide.

Click Next. 



A D M I N I S T R A T O R ’ S G U I D E 127

C H A P T E R  1 9    S E A R C H  S E T U P  A N D  M A I N T E N A N C E

3. The Entity and Field Selection window opens. 

Select the entities or entity fields that you want to include in searches. If you 
clear the check box for an entity or field, that entity or field won’t be available to 
any of your users through Search.

You can also select whether to include open and history records in searches. 
Open records include unpaid transactions and transactions that have been 
posted, but not moved to history. History records include paid transactions or 
transactions from a previous year. 

Some entity fields are designated to be returned with summary search results. 
You can’t exclude these fields.

4. The Crawl Options window appears.

Select a default crawl schedule. You can change the crawl schedule later, if 
necessary. For more information about crawl schedules, see Crawl schedule 
guidelines on page 121.
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Select whether you want to start a full crawl after completing the setup wizard. 
A full crawl will take some time to complete. If you don’t start a full crawl 
immediately after the wizard, one will be performed at the next scheduled time.

Click Next.

5. The Setup Confirmation window appears. Review the summary of your 
selections, then click Process.

6. The Setup Progress window appears. It will take several minutes to set up 
initial data for a company.

7. The Search Setup Complete window appears. Click Finish.

Securing search data

When you perform an Office SharePoint Server search, summary information is 
displayed with each Microsoft Dynamics GP data result. Summary data that 
appears in search results is not protected by web service security. All summary data 
for a company is viewable by all users, even those who don’t have permission to 
view the particular data record. (Detailed records are protected by web service 
security.)

Data security is especially important if you’re deploying Business Portal for users 
outside your company, such as customers or vendors. See the Business Portal 
Installation Guide for information about deploying separate server farms for 
internal and external users. 

Regardless of whether you have external users, you should pay close attention to 
permissions on the Search Center site and on individual business entities.

Securing the Search Center site
If you plan to deploy Office SharePoint Server for all of your employees, but want to 
allow only a certain group of employees to use Search, you can use SharePoint 
groups to secure the Search Center site. Assign the users that should be able to 
search to a SharePoint group that has permission to the Search Center site. Verify 
that users who shouldn’t search are in groups that don’t have permission to the 
Search Center site.

By default, the Search Center site inherits permissions from the top-level site. You may need 
to break inheritance for the Search Center site if both Search users and non-Search users 
need access to the top-level site.

If you have deployed a single SharePoint server farm for both internal and external 
users, you can also use this method to help prevent external users from accessing 
the Search Center site. 

Securing business entities
If you plan to deploy Office SharePoint Server for all of your employees and want 
all employees to have the ability to search, you can set permissions on individual 
business entities to limit the Microsoft Dynamics GP data that can be searched by 
certain employees.
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To secure individual business entities in the Business Data Catalog, perform the 
following steps.

1. Create Windows groups based on the permissions required for your users. You 
can use existing groups, if you have them.

You can also define permissions for individual Windows user accounts. However, 
because it is not efficient to directly maintain large numbers of user accounts, we don’t 
recommend assigning permissions at the individual level. 

2. Go to SharePoint Central Administration (Start > Administrative Tools > 
SharePoint 3.0 Central Administration).

3. In the Quick Launch, click the name of the Shared Service Provider used for 
Business Portal.

4. Under Business Data Catalog, click View Applications.

5. For each search company, click the drop-down arrow and click Manage 
Permissions. Remove the “Authenticated Users” group.

6. Click the drop-down arrow for the search company for which you want to 
secure entities and select View Application.

7. For each entity you want to secure in the selected search company, click the 
drop-down arrow and select Manage Permissions.

8. Add or remove Windows users and groups.

9. After you’ve set permissions, perform a full crawl.

Repair or remove search data for a selected company

You can repair search data for a company if you believe the data has become 
corrupted. This process will remove and re-create the information in the Business 
Data Catalog for the selected company.

You must use the installation and registration tools provided with Business Portal to 
manage the Microsoft Dynamics GP application and companies registered in the Business 
Data Catalog. While Office SharePoint Server tools are available, the Business Portal tools 
have been designed specifically to manage Microsoft Dynamics GP data. If you use the 
Office SharePoint Server tools, data may not be added or removed correctly.

In order to run the Search Setup wizard, you must belong to the BDC Administrator 
web service role. You also must be a site collection administrator and have rights to 
add stored procedures to the back office SQL databases.

Use the following procedure to repair Microsoft Dynamics GP search data.

1. Start the Microsoft Dynamics GP Search Setup wizard. (On a Business Portal 
web server, go to Start > Administrative Tools > Microsoft Dynamics GP 
Search Setup.)

2. Click Modify/Repair. The Company Selection window appears.
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3. In the Company Name list, select the check boxes for the companies that you 
want to activate, repair, or remove Search for.

If you clear the check box for a company for which Search has previously been 
activated, the search data for that company will be removed. If you do not clear 
the check box for a company for which Search has been previously been 
activated, Search data will be removed and re-created for that company.

If you added a new company after Web Services for Microsoft Dynamics GP was 
installed, you must add eConnect and web service support before you can make the 
company available for Search. For more information about adding eConnect and web 
service support for a company, see the Web Services Installation and Administration 
Guide.

Click Next. 

4. The Setup Confirmation window appears. Review the summary of your 
selections, then click Process.

5. The Setup Progress window appears.

6. The Search Setup Complete window appears. Click Finish.

Remove search data for all companies

This process will remove search information from the Business Data Catalog for all 
companies.

You must use the installation and registration tools provided with Business Portal to 
manage the Microsoft Dynamics GP application and companies registered in the Business 
Data Catalog. While Office SharePoint Server tools are available, the Business Portal tools 
have been designed specifically to manage Microsoft Dynamics GP data. If you use the 
Office SharePoint Server tools, data may not be added or removed correctly.

In order to run the Search Setup wizard, you must belong to the BDC Administrator 
web service role. You also must be a site collection administrator and have rights to 
add stored procedures to the back office SQL databases.

1. Start the Microsoft Dynamics GP Search Setup wizard. (On a Business Portal 
web server, go to Start > Administrative Tools > Microsoft Dynamics GP 
Search Setup.)

2. Click Inactivate All. 

3. The Setup Confirmation window appears. Click Process.

4. The Setup Progress window appears.

5. The Search Setup Complete window appears. Click Finish.
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Change the default crawl schedule

When you activate Search for a company, you’ll select a default crawl schedule 
which includes both full crawls and incremental crawls. You can adjust the crawl 
schedule later using this procedure.

1. Go to SharePoint Central Administration (Start > Administrative Tools > 
SharePoint 3.0 Central Administration).

2. In the Quick Launch, click the name of the Shared Service Provider used for 
Business Portal.

3. Under Search, click Search settings.

4. Under Crawl settings, click Content sources and crawl schedules.

5. Click the content source for a company and click Edit in the menu that appears.

Microsoft Dynamics GP content sources are named “Content Source - <company 
name>” and “Database Content Source - <company name>.” 

6. In the Crawl Schedules section, click Create schedule or Edit schedule for the 
type of crawl you are scheduling.

7. On the Manage Schedules page, indicate schedule settings.

8. Click OK to save the schedule and close the Manage Schedules page, then click 
OK to save changes to the content source.
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Part 6: Customizations
This part of the documentation describes how to customize Business Portal. The 
following information is provided:

• Chapter 20, “Customizing Business Portal,” explains how to create sites and 
pages and describes how to manage navigation.

• Chapter 21, “Setting up a customer portal,” contains information about setting 
up secure access to Business Portal for external users, such as customers.
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Chapter 20: Customizing Business Portal
Information about customizing Business Portal is divided into the following 
sections:

• Create a new center site
• Create a page
• Customize navigation
• Remove access to a center site

Create a new center site

You can create additional subsites of the top level Business Portal site. When you 
create a new Business Portal subsite, you should apply the Business Portal master 
page. A master page contains the page design and layout elements that you want to 
repeat on multiple pages in a site. The Business Portal master page contains the 
company selection list that appears in the upper-right corner of Business Portal 
pages.

• When you create a new subsite in Office SharePoint Server, you can apply the 
Business Portal master page. Click Site Actions > Site Settings > under Look 
and Feel, click Master page. Under System Master Page, select 
BusinessPortalDefault.master.

• If you’re using Windows SharePoint Services only, you can’t change the master 
page through site settings. If you want to use the Business Portal master page, a 
developer must apply it using SharePoint application programming interfaces.

For more information about sites and master pages, see the SharePoint 
documentation.

Create a page

You can create additional pages, either on the default Business Portal center sites, or 
on new sites that you create.

1. Go to the site where you want to create the page and click Site Actions > 
Create. 

2. Under Web Pages, click Business Portal Web Part Page.

Business Portal page templates can be used only on the top-level Business 
Portal site and its subsites. For more information about the site hierarchy, refer 
to Business Portal site structure on page 10 and The Business Portal subsite on 
page 35.

3. On the New Web Part Page page, you can select a layout either with or without 
a Quick Launch. After you’ve named and chosen a location for the page, click 
Create.

4. To add web parts, go to the page and click Site Actions > Edit Page. The page 
will switch to edit mode, so you can select and configure web parts. For more 
information, see Adding web parts to a page on page 85.
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Business Portal web parts can be used only on the top-level Business Portal site 
and its subsites. For more information about the site hierarchy, refer to Business 
Portal site structure on page 10 and The Business Portal subsite on page 35.

5. Modify page permissions, if necessary. By default, the page will inherit 
permissions from the site. For more information about setting security on pages 
that you create, refer to Chapter 6, “Managing page security.”

Customize navigation

Links for navigation (called navigation items) appear in the link bar at the tops of 
pages and on the left side of pages in the Quick Launch. Your options for 
customizing the navigation depend on whether you’re using Windows SharePoint 
Services or Office SharePoint Server.

• If you’re using Office SharePoint Server, Enterprise Edition, use the Site 
Navigation Settings page to configure which navigation items appear under 
which headings, and to specify their order. (On the home page for the site, click 
Site Actions > Site Settings > under Look and Feel, click Navigation.)

• If you’re using Windows SharePoint Services only, you can choose to inherit the 
top link bar from the parent site. You can also modify the Quick Launch for a 
site. (On the home page for the site, click Site Actions > Site Settings > under 
Look and Feel, click Tree view or Quick Launch.)

For more information about Business Portal navigation, see Business Portal 
navigation on page 11. For more information about customizing navigation, see the 
SharePoint documentation.

Remove access to a center site

If you don’t want to use a default center site, we recommend hiding it from users 
rather than deleting it. To hide a site, you can remove security to it so that it doesn’t 
appear in the user’s navigation.

1. Go to the Site Settings page for the site.

2. Under Users and Permissions, click People and groups.

3. Click Site Permissions in the Quick Launch.

4. Select the users and groups for which you want to remove access to the site.

5. Click Actions > Remove User Permissions.
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Chapter 21: Setting up a customer portal
This documentation explains the procedures you must perform to provide secure 
Business Portal access to external users.

Typically, external users are people in other companies, such as customers or 
vendors; internal users are people within your company, such as employees and 
salespeople. 

You can give external access to Business Portal to employees from your company, but they 
are still considered internal users.

This information is divided into the following sections:

• Customer portal checklist
• Set up user accounts for external users
• Restrict data for customers

Customer portal checklist

If you’re going to allow customers access to Business Portal through the Internet, 
you should create a portal tailored to those customers. Creating a customer portal is 
much like setting up Business Portal for internal employee access. You’ll perform 
many of the same tasks.

When you’re setting up your customer portal, keep the following in mind:

• We don’t recommend assigning external users to internal roles.

• We don’t recommend assigning an external role to any data permission without 
a row-level restriction applied to it.

• When creating result viewer web parts for customers, you may want to turn off 
the Create New Query and Modify Query options in the web part menu, to 
further restrict their access to your data.

Step For more information

1. Set up an ISA server or perimeter 
network, if you don’t already have one.

Business Portal Installation Guide

2. Create user accounts for your external 
users.

Set up user accounts for external users on page 138

3. Be sure the Customer MBF role has 
appropriate data permissions assigned to 
it, and create queries using those data 
permissions. 

Restrict data for customers on page 138

4. Create pages and web parts to display 
customer data.

Create a new center site on page 135
Create a page on page 135
Chapter 14, “Managing web parts”

5. Create a SharePoint group for 
customers and give the new SharePoint 
group access to your customer pages.

Chapter 7, “Managing SharePoint groups and 
permissions”
SharePoint documentation

6. Assign users to the Customer MBF role 
and an associated ID. 

Add users to MBF roles on page 43

7. Assign users to the customer 
SharePoint group you created.

Add users to SharePoint groups on page 40
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Set up user accounts for external users

A user’s access type (internal or external) is determined by role assignments. 
Typically, internal users are people within your company, such as employees and 
salespeople; external users are people in other companies, such as customers or 
vendors.

Both internal and external users must have valid Windows user accounts. Internal 
users typically have domain accounts on your internal network, with access to 
internal network resources. External users can have either domain accounts or local 
accounts on the web server.

Use caution when assigning external users to Windows accounts or groups. You 
should give external users the least amount of access that is necessary. Typically, 
you’ll want to give external users access to resources only in your perimeter 
network.

When to use local Windows accounts
We recommend using local Windows accounts for external users in an extranet 
configuration with a single web server. Local accounts, with the default permissions 
assigned to the Everyone group in Windows Server® 2003, limit access to only the 
web server.

If you have performed security hardening steps on your web server, create a test local 
Windows account and verify that it has sufficient permissions to use Business Portal before 
creating external user accounts.

When to use domain accounts
If your configuration includes multiple web servers, use domain accounts or 
shadow accounts for external users. You also may want to use domain accounts or 
shadow accounts if the external users need access to resources or applications on 
your other networks.

Restrict data for customers

If you want to give those outside your organization access to Business Portal, you 
need to restrict their access to only those records that contain their own Customer 
ID. To limit the data external users can view, set row-level restrictions on customer 
information. A row-level restriction is used along with a data permission, which 
restricts the columns or fields of data that are available. For more information about, 
and examples of, data permissions and row-level restrictions, refer to Data 
permissions overview on page 55 and Row-level restrictions on page 56.

Default data permissions, with row-level restrictions, are provided for customer-
related data in Business Portal. By default, the Customer MBF advanced role is 
assigned to the data permissions. The ID associated with a user in that role 
determines which data is displayed. Users in the role will be allowed to see only 
their own data on Business Portal pages.

Before using the default data permissions, you should verify that the available 
properties are appropriate for your customers. It is up to your organization to 
determine which data should be made available. Refer to Chapter 28, “Default 
advanced roles and security permissions,” for a list of restricted data permissions 
provided with Business Portal.
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Each row-level restriction can be used with any data permission that is based on the 
same entity. You can’t use the restrictions with data permissions based on other 
entities. We don’t recommend making other entities available to your customers. If 
you don’t use row-level restrictions, customers may be able to view each other’s 
information.

You must create your own queries and pages using these data permissions; no 
default queries or pages are provided. For more information about creating a 
customer portal, refer to Customer portal checklist on page 137.
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Part 7: Tuning, troubleshooting, and 
maintenance
This part of the documentation contains procedures you can use to improve 
Business Portal performance, and to troubleshoot the installation.

The following information is included:

• Chapter 22, “Performance tuning,” describes some adjustments you can make 
to your Business Portal installation to ensure peak performance.

• Chapter 23, “Troubleshooting,” describes common problems and their 
solutions, including information about disabling the prompt for credentials 
when you open an Administration page.

• Chapter 24, “Maintenance,” contains procedures for adding companies, adding 
sample users, or removing Business Portal. Information about changing 
passwords and backing up Business Portal is also included.

• Chapter 25, “Configuration changes,” includes information about changing 
your Business Portal configuration, including configuring Business Portal for 
Secure Sockets Layer (SSL) and moving from a single web server to a server 
farm environment.
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Chapter 22: Performance tuning
To ensure that you’re getting the best possible performance from your Business 
Portal configuration, review this information.

This information is divided into the following sections:

• Performance-tuning overview
• Restrict access to long queries
• Page tuning
• Publish scheduled reports at off-peak times
• Allow sufficient space for temporary Internet pages
• Tune Windows SharePoint Services
• Application domain recycling
• Antivirus software and ASP.NET
• SQL optimization
• Hardware requirements
• Load balancing with multiple web servers

Performance-tuning overview

After configuring your Business Portal system, you should test it and evaluate the 
results. It is possible that you’ll need to fine-tune your system to achieve optimal 
performance. Once you’ve achieved the desired results, create a maintenance plan; 
server performance changes over time based on the number of users and the types 
of queries your users are generating.

Performance tuning tasks can be grouped into two areas: Business Portal tuning 
and system configuration tuning.

Business Portal tuning
The performance of Business Portal can be greatly influenced by the activities and 
settings of Business Portal and Microsoft Dynamics GP users. Refer to the following 
topics to learn more:

• Restrict access to long queries on page 144
• Page tuning on page 144
• Publish scheduled reports at off-peak times on page 144
• Allow sufficient space for temporary Internet pages on page 145

System configuration tuning
There are also changes you can make to your Business Portal configuration to 
improve performance. Refer to these topics:

• Tune Windows SharePoint Services on page 145
• Application domain recycling on page 145
• Antivirus software and ASP.NET on page 146
• SQL optimization on page 146
• Hardware requirements on page 147
• Load balancing with multiple web servers on page 147
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Restrict access to long queries

When a user creates or runs a query, the data tables on the Microsoft Dynamics GP 
SQL server are scanned. SQL Server processing will take more time if one or more of 
the following is true:

• The query is long. A long query joins data from different entities and has 
advanced restrictions, or is run against a large table in Microsoft Dynamics GP.

• The user sorts the results on a non-indexed field. For more information about 
indexed views, refer to SQL Server Books Online.

• The user restricts the results on a non-indexed field.

If users frequently use complex queries, or sort or restrict the results, performance 
will drop for both Business Portal users and Microsoft Dynamics GP users. You can 
take the following steps to reduce query-related performance issues:

• Carefully consider which Business Portal users will be given access to the query 
pages. Educate users about the implications of performing long queries or 
sorting large amounts of data in the Business Portal.

• Optimize your SQL Server settings. For more information, refer to SQL 
optimization on page 146.

• Extend the query time-out value by editing the BusinessFramework.config file. 
For more information, refer to Extending the query time-out value on page 150.

Page tuning

The number of result viewer or business data web parts on a page directly affects 
how long it takes the page to display. Reducing the number of data web parts on 
Business Portal pages reduces page display times.

You might also want to limit the number of web parts that are included on any new 
pages you create. For example, instead of creating one slower Business Portal page 
with six web parts on it, you might want to create two pages with three web parts 
on them.

Publish scheduled reports at off-peak times

You can use the Report Scheduler to schedule Microsoft Dynamics GP reports and 
publish them to Business Portal. If you are frequently updating many reports in 
Microsoft Dynamics GP, you should carefully consider the timing of publishing 
updated reports to Business Portal.

In order for a report to be created and published to Business Portal, the user who 
publishes that report must be logged on to Microsoft Dynamics GP. To publish 
reports at off-peak times, you might want to set up a scheduled Windows task to log 
on to Microsoft Dynamics GP, start the scheduled reports, and then log off when 
publication is complete.
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Allow sufficient space for temporary Internet pages

Be sure that the browser settings allow sufficient space for storing temporary 
Internet files. Internet Explorer options are set for each user on a single computer. If 
multiple users share a single client workstation, these settings will need to be made 
with each of the users logged in to the workstation.

To adjust temporary file settings in Internet Explorer 7.0 
or Internet Explorer 8.0:
1. Start Internet Explorer and open the Internet Options window.

Tools > Internet Options

2. Click the General tab.

3. Under Browsing History, click Settings. 

4. Increase the value in Disk space to use.

5. Click OK to save your changes and close the Temporary Internet Files and 
History Settings window. Click OK to close the Internet Options window.

Tune Windows SharePoint Services

As with any software, some features of Windows SharePoint Services use more 
resources than others. For example, features that rely on the Microsoft SharePoint 
Timer service, such as alerts and usage analysis log processing, can have a 
substantial impact on your server performance. You can control the impact these 
features have on performance by configuring appropriate settings or choosing to 
disable them.

The following features have a greater impact on performance than other features in 
Windows SharePoint Services:

• Antivirus protection
• HTML viewing
• Usage analysis logging and processing
• Site use confirmation and auto-deletion
• Alerts

For more information about Windows SharePoint Services performance, refer to the 
Windows SharePoint Services 3.0 Technical Library on Microsoft TechNet 
(technet.microsoft.com).

Application domain recycling

ASP.NET applications like Business Portal sometimes are “recycled” or restarted 
when file changes occur. When the application domain is recycled, performance can 
be affected. The application domain is most commonly recycled when:

• The Business Portal web server is restarted.
• Configuration files are changed.
• Any files in the \bin folder are changed.
• Files are scanned by antivirus products. (For more information, refer to 

Antivirus software and ASP.NET on page 146.)

http://technet.microsoft.com
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You can use the Event Viewer to determine how often the application domain is 
being recycled. Investigate why it is being recycled, and then work to minimize 
those occurrences. To use the Event Viewer, click Start > Administrative Tools > 
Event Viewer, then click Application.)

When you check the Event Viewer, note the number of times the application domain 
is restarted and determine what other applications or utilities on the computer 
could be causing those events. Turn off one application at a time and continue to 
monitor the Event Viewer until you’ve identified the application or utility causing 
the application to recycle. When you have that information, you can decide what 
action is appropriate. For example, you might be able to move that application to 
another computer.

Antivirus software and ASP.NET

A small number of antivirus products cause ASP.NET to recycle the application 
domain. Refer to Microsoft Knowledge Base Article #312592 for more information 
and recommendations. (Go to support.microsoft.com and type 312592 in the Search 
box.)

Only a few antivirus products cause this, but we recommend reviewing the antivirus 
product you use.

Some antivirus software makes changes each time a file is scanned. These instances 
are indistinguishable from real, intentional file changes. When ASP.NET detects 
these file changes, other events are triggered. If the change is to a configuration file 
or a file in the /bin folder, for example, the application (application domain) is 
restarted. When that happens, the global state of the application is lost and the 
application must be reloaded. If this happens several times in a minute, there will be 
a severe drop in performance.

SQL optimization

SQL Server has several tools that you can use to tune your company’s SQL server 
performance. Some of those tools are described here, but it’s best to get a database 
administrator to make these changes.

Indexes
If your company has a SQL database administrator (DBA), that person might be 
able to add SQL indexes to some tables, reducing the impact of queries that sort on 
certain fields. However, adding indexes to SQL tables will also slow down 
Microsoft Dynamics GP performance.

SQL Profiler
After you’ve installed Business Portal, you can use SQL Profiler (Start > Programs > 
Microsoft SQL Server > Performance Tools > SQL Profiler) to view information 
about the events that are occurring on your SQL Server. Using the Profiler can help 
you to pinpoint bottlenecks.

SQL Server Management Studio
If you’re using SQL Server 2005 or SQL Server 2008, you can use SQL Server 
Management Studio (Start > Programs > Microsoft SQL Server > SQL Server 
Management Studio) to get a better understanding of the SQL tables and queries.

http://support.microsoft.com
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SQL Server settings
You can use SQL Server Management Studio to check your SQL Server memory 
settings. If you’ve configured SQL Server to dynamically configure its memory, be 
sure that the maximum memory setting is not 100 percent of what’s available.

Hardware requirements

Depending on the issues you’re facing in your configuration, you might want to 
consider upgrading your hardware. For more information about system 
requirements, refer to the System Requirements area of CustomerSource (https://
mbs.microsoft.com/customersource/support/documentation/
systemrequirements).

Scalability If your issues have to do with the scalability of Business Portal—if 
you’ve added several Business Portal users, for example, and then found that many 
users are timing out—you should review your hardware configuration. Specifically, 
you should compare the specifications of your Microsoft Dynamics GP server to 
those that have been recommended. You might want to upgrade the processors, 
increase the number of processors, or add RAM. 

You should also be sure that your network bandwidth—especially between the web 
server and the Microsoft Dynamics GP server—is optimal. For more information 
about network requirements, refer to the Business Portal Installation Guide.

Responsiveness If the issue has to do with the performance of a particular user 
or group of users, you might see a dramatic improvement if you upgrade client 
hardware. You should compare the client workstation’s specifications with the 
recommendations for client workstations.

Load balancing with multiple web servers

If you have a large number of Business Portal users, you may want to use multiple 
web servers to run Business Portal. Having a group of Business Portal web servers 
enables you to use Network Load Balancing.

Network Load Balancing distributes incoming TCP/IP traffic between multiple 
servers. When you use Network Load Balancing, programs on the group of servers, 
especially web-server programs, can handle more traffic and provide faster 
response times. You can specify the load percentage that each web server will 
handle, or the load can be equally distributed across all the web servers.

https://mbs.microsoft.com/customersource/support/documentation/systemrequirements
https://mbs.microsoft.com/customersource/support/documentation/systemrequirements
https://mbs.microsoft.com/customersource/support/documentation/systemrequirements
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For more information about Network Load Balancing, refer to the Windows Server 
2003 Technical Reference at: http://www.microsoft.com/resources/
documentation/WindowsServ/2003/all/techref/en-us/Default.asp. You can also 
refer to the SharePoint documentation for information about capacity planning.

Query performance may still be an issue with multiple web servers, because all users who 
run queries will still access data on a single Microsoft Dynamics GP server.

http://www.microsoft.com/resources/documentation/WindowsServ/2003/all/techref/en-us/Default.asp
http://www.microsoft.com/resources/documentation/WindowsServ/2003/all/techref/en-us/Default.asp
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Chapter 23: Troubleshooting
This documentation includes information about how to find and fix common 
problems that might occur in Business Portal.

This information is divided into the following sections:

• Error message: An unexpected error has occurred
• Error message: Only one usage of each socket address is normally permitted
• Domains aren’t listed in the Add Users wizard
• Extending the query time-out value
• Configuration file not set up properly for the Add Users wizard

Error message: An unexpected error has occurred

Your users may receive the message “An unexpected error has occurred” when 
trying to access Business Portal in the following situations. 

• The attempt to load the page has timed out. Click the Refresh button in Internet 
Explorer to attempt to load the page again.

• The user is assigned to a SharePoint group that has access to the page, but has 
not been assigned to an MBF role that has access to the data. Be sure that the 
user is assigned to all necessary roles and groups.

Error message: Only one usage of each socket address 
is normally permitted

When you perform a full crawl of Microsoft Dynamics GP data, you may see the 
error “Only one usage of each socket address (protocol/network address/port) is 
normally permitted” in the Windows Event Viewer.

This error typically occurs when multiple threads are attempting to access the 
Microsoft Dynamics GP web service at the same time using the same connection 
method.

If no exceptions are logged in the Dynamics GP Web Service Exception 
Management Console and no corresponding errors or warnings appear in the Office 
SharePoint Server trace log, you can disregard this error. 

To check for web service exceptions:
1. Open the Dynamics GP Web Service Exception Management Console. (On a 

computer where the console is installed, click Start > Administrative Tools > 
Dynamics GP Web Service Exception Management Console.)

2. Select the All Exceptions node.

3. Be sure that the From and To dates are set appropriately.

4. Review any errors that appear in the list.



P A R T  7 T U N I N G ,  T R O U B L E S H O O T I N G ,  A N D  M A I N T E N A N C E

150 A D M I N I S T R A T O R ’ S G U I D E

To check for trace log errors:
1. Open the appropriate Office SharePoint Server trace log. By default, trace logs 

are located at \Program Files\Common Files\Microsoft Shared\web server 
extensions\12\LOGS. 

Trace logs are named in the following format: Computer_name-YYYYMMDD-
HHMM.log, where YYYYMMDD is the date and HHMM is the time.

2. Look for errors occurring at the same time as the errors in the Windows Event 
Log.

Domains aren’t listed in the Add Users wizard

On some networks, the Domain list on the Select Domain Users page of the Add 
Users wizard may not display a complete list of domains. If this occurs, you should 
modify the BusinessFramework.config file to use a different method of locating 
domains.

To modify the BusinessFramework.config file, complete the following procedure on 
the Business Portal web server.

1. Create a backup copy of the BusinessFramework.config file located in the bin 
folder. (The bin folder is located in C:\inetpub\wwwroot\wss
\VirtualDirectories\<port number>, where <port number> is the port number of 
the IIS web site where Business Portal is installed.)

2. Open the BusinessFramework.config file using a text editor, such as Notepad.

3. Search for the <Microsoft.BusinessFramework.Portal.Administration.Active
DirectoryReaderConfig> section.

4. In the following line, change the value to True.

<useAlternativeDomainLookup type="Boolean" value="False" />

5. Save and close the BusinessFramework.config file.

6. Restart the Add Users wizard.

Extending the query time-out value

If users frequently use complex queries or sort the results, performance will drop 
for both Business Portal users and Microsoft Dynamics GP users. You can improve 
performance by extending the query time-out value.

For other suggestions for improving query performance, refer to Restrict access to 
long queries on page 144.

To extend the query time-out value:
1. Create a backup copy of the BusinessFramework.config file located in the bin 

folder. (The bin folder is located in C:\inetpub\wwwroot\wss
\VirtualDirectories\<port number>, where <port number> is the port number of 
the IIS web site where Business Portal is installed.)

2. Open the BusinessFramework.config file using a text editor, such as Notepad.
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3. Search for the Microsoft.BusinessFramework.Data.Storage.StorageUtil-
StorageTrace section.

4. If this section does not exist, add the following to the file:

<Microsoft.BusinessFramework.Data.Storage.StorageUtil-StorageTrace>

<commandTimeout type="Int32" value="30" />

</Microsoft.BusinessFramework.Data.Storage.StorageUtil-StorageTrace>

If you add the section, place it somewhere between the first and last lines in the 
file, as shown here:

<Microsoft_BusinessFramework_Configuration>

Add new section

</Microsoft_BusinessFramework_Configuration>

5. If the Microsoft.BusinessFramework.Data.Storage.StorageUtil-StorageTrace 
section does exist, then add only the following line:

<CommandTimeout type="Int32" value="30" /> 

The line must be added between the first and last lines of this section, as shown 
here:

<Microsoft.BusinessFramework.Data.Storage.StorageUtil-StorageTrace>

<Other configuration parameter>

<Other configuration parameter>

<commandTimeout type="Int32" value="30" />

</Microsoft.BusinessFramework.Data.Storage.StorageUtil-StorageTrace>

6. In this section, the default command time-out value is 30 seconds. Increase the 
value to up to 160 seconds.

7. Save and close the BusinessFramework.config file.

Configuration file not set up properly for the Add 
Users wizard

If you get an error message stating, “The BusinessFramework.config file is not set 
up properly for the Add Users wizard,” you should verify that the appropriate .dll 
files are in the bin folder. This message occurs if a .dll file is missing, the wrong 
version of a .dll file is found, or a .dll file has the wrong name.

1. Open the BusinessFramework.config file using a text editor, such as Notepad.

The BusinessFramework.config file is located in the bin folder. (The bin folder is 
located in C:\inetpub\wwwroot\wss\VirtualDirectories\<port number>, 
where <port number> is the port number of the IIS web site where Business 
Portal is installed.)

2. Search for the Microsoft.BusinessFramework.Portal.RoleMatchingConfig 
section.
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3. Note the assembly (.dll) names listed in this section. In the following example, 
the assembly name is Microsoft.Dynamics.RoleMatching.

<assemblyName_1 type="String" value="Microsoft.Dynamics.RoleMatching, 

Version=3.0.0.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35" />

4. Verify that the assemblies listed in the Microsoft.BusinessFramework.Portal.
RoleMatchingConfig section are located in the same folder as the 
BusinessFramework.config file.

5. If you are unable to locate the appropriate .dll files, contact Microsoft Dynamics 
GP Support.
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Chapter 24: Maintenance
This documentation contains information about adding companies, adding sample 
users, and removing Business Portal. Information about changing passwords and 
backing up Business Portal also is included.

This information is divided into the following sections:

• Change passwords
• Back up Business Portal
• Repair Business Portal files
• Initialize databases
• Remove Business Portal

Change passwords

In order to function properly, Business Portal uses a SQL Server user account to 
access data; a Windows account for Windows SharePoint Services; and a Windows 
account to display reports. If you change the password for any of these accounts, 
you will need to update the information used by Business Portal. The following 
procedures explain which user accounts are used by Business Portal, and how to 
update password information.

SQL Server user account
A SQL Server user account is entered in the Business Portal SQL Configuration 
window during the installation, and is used to access your Microsoft Dynamics GP 
data. If the password for this user account changes, complete the following 
procedure.

1. On the computer where Business Portal is installed, double-click the 
DBAuthenticationUtility.exe file, which is stored in the bin folder. 

The bin folder is located in C:\inetpub\wwwroot\wss\VirtualDirectories
\<port number>, where <port number> is the port number of the IIS web site 
where Business Portal is installed.

2. The User Name and Password Utility window appears. Expand the tree until 
you see BusinessPortalUser.

3. Right-click BusinessPortalUser and choose Edit.

4. The Edit User window appears. Type and confirm the new password for the 
SQL Server user account. 

5. Click OK to save changes and close the window.

FileServices user account
Reports are displayed on Reports pages by the FileServices component service, 
which runs under a user account. If the password for this user account changes, 
complete the following procedure.
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1. On the computer where Business Portal is installed, choose Start > 
Administrative Tools > Component Services.

2. Expand the Component Services > Computers > My Computer > COM+ 
Applications node. 

3. Right-click Microsoft.BusinessFramework.Reports.FileService and select 
Properties. 

4. The Microsoft.BusinessFramework.Reports.FileService Properties window 
appears. On the Identity tab, be sure the correct user is selected, and type and 
confirm the new password.

5. Click OK to save changes and close the window.

WSS user account
Windows SharePoint Services requires a user account to start services, run 
processes, and connect to the SQL server. When the password for this account 
expires or changes, you’ll receive a “service unavailable” message when you try to 
view the Business Portal site or the administration pages for the site or server.

To restore access to Business Portal and SharePoint, you’ll need to update the 
password in IIS.

You also may see a “cannot connect to configuration database” error message if you are 
using SQL Server authentication and the password associated with the system account for 
SQL Server has expired or changed. If you see this message, you must reset the password in 
SQL Server. For more information about changing passwords in SQL Server, see the SQL 
Server Enterprise Manager documentation.

1. Open Internet Information Services (IIS) Manager.
Start > Administrative Tools > Internet Information Services (IIS) Manager

2. Click the plus sign next to your server name.

3. Click the plus sign next to Application Pools.

4. Right-click the Business Portal application pool, and then click Properties.

5. In the Application Pool ID Properties dialog box (where Application Pool ID is the 
ID for the Business Portal application pool), click the Identity tab.

6. Under Application pool identity, in the Password box, type the new password, 
and then click OK.

7. In the Confirm Password dialog box, type the password again, and then click 
OK. 

8. After you change the password in IIS, you must restart IIS to connect with the 
new password. To restart IIS, type iisreset at the command prompt. 
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Back up Business Portal

You should make regular backups of the SharePoint databases and web applications 
for Business Portal.

To back up your SharePoint web applications, indexes, and databases, open 
SharePoint Central Administration (Start > Administrative Tools > SharePoint 
Central Administration) on the web server where SharePoint and Business Portal 
are installed. Click Operations in the Quick Launch. Under Backup and Restore, 
click Perform a backup. Select the items you want to back up, and specify other 
backup options.

You should back up SharePoint content at the same time as you back up your 
Microsoft Dynamics GP databases. For more information about backing up and 
restoring, see the SharePoint documentation.

Repair Business Portal files

Use the repair option to fix Business Portal files installed on your web server. If you 
need to repair SQL objects, refer to Initialize databases on page 155 instead.

1. Depending on your operating system, open the Add or Remove Programs 
control panel or the Programs and Features control panel, and select Business 
Portal for Microsoft Dynamics GP. Click Change to open the Modify Business 
Portal Installation window.

2. Click Repair.

3. The Ready to Repair window appears. Click Repair to continue.

4. After the repair process is complete, the Finish window appears. Click Finish.

Initialize databases

When Business Portal is installed, SQL objects are added to your company 
databases. If the SQL objects aren’t added to your company databases, or if you add 
companies after you’ve installed Business Portal, you can use this procedure to add 
the SQL objects. If you reinstall the sample company data in the Microsoft 
Dynamics GP application you will also need to complete this procedure.

If you install Business Portal and then remove a company from Microsoft Dynamics GP, the 
Business Portal tables and information associated with that company automatically are 
removed.

1. Depending on your operating system, open the Add or Remove Programs 
control panel or the Programs and Features control panel, and select Business 
Portal for Microsoft Dynamics GP. Click Change to open the Modify Business 
Portal Installation window.

2. Click SQL Configuration.
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3. The Connection Information window appears.

Select the type of authentication that should be used when the Business Portal 
software accesses your SQL data to create the SQL tables and objects in 
Microsoft Dynamics GP. These credentials are used only during this process.

• If you select Windows Trusted Authentication, you don’t need to enter 
any other information. Click Next.

• If you select SQL Authentication, enter a SQL Server administrator ID and 
password. Click Next.

For more information about authentication methods, refer to the Business 
Portal Installation Guide.

4. The Ready to Install window appears. Click Install.

5. After the installation process is complete, the Finish window appears. Click 
Finish.

Remove Business Portal

Use the installation wizard to remove Business Portal from your computer.

1. Depending on your operating system, open the Add or Remove Programs 
control panel or the Programs and Features control panel, and select Business 
Portal for Microsoft Dynamics GP. Click Change to open the Modify Business 
Portal Installation window.

2. Click Remove. 

3. The Ready to Remove window appears. Select Remove Business Portal data to 
remove SQL data related to Business Portal.

When you remove Business Portal data, the Business Portal subsites, the 
SharePoint data contained on those sites, and your Business Portal users, roles, 
and permissions are removed. Your Microsoft Dynamics GP data will be 
unaffected.

If you’ve installed Business Portal on multiple web servers and are removing Business 
Portal from one of them, do not select the option to remove Business Portal data. If you 
do, the Business Portal installations on the remaining web servers will not work.

Click Next.

4. The Connection Information window appears. Select the type of authentication 
to use when the removal process accesses your SQL Server.

• If you select Windows Trusted Authentication, you don’t need to enter 
any other information. Click Next.

• If you select SQL Authentication, enter a SQL Server administrator ID and 
password. Click Next.

5. After processing is finished, click Finish to close the wizard.
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Chapter 25: Configuration changes
This documentation includes information about changing your Business Portal 
configuration, including configuring Business Portal for Secure Sockets Layer (SSL) 
and moving from a single web server to a server farm environment.

The following sections are included:

• Configure Business Portal to use Secure Sockets Layer
• Disable Secure Sockets Layer for Business Portal
• Update SQL logon information for a moved database

Configure Business Portal to use Secure Sockets Layer

If you’ve installed Business Portal and you decide to use Secure Sockets Layer (SSL) 
for the web site at a later time, you must complete some additional procedures. The 
procedures you must complete depend on which Business Portal features you have 
installed. The procedures include:

• Configuring Secure Sockets Layer.

• Modifying the BusinessFramework.config file.

• Modifying the registry.

• Changing public URLs for the site collection.

• Repairing URLs for the Business Data Catalog and Search.

Additional procedures may be required for other Business Portal applications. Refer 
to the Administrator’s Guide for each Business Portal application for more 
information.

If your web site was set up to use SSL before you installed Business Portal, you 
don’t need to perform any of these procedures.

To configure Secure Sockets Layer:
1. Set up the web site to use SSL. For more information, refer to your Windows 

documentation.

2. Import the SSL certificate to the default web directories, including Business 
Portal.

Refer to the IIS documentation on Microsoft TechNet (www.microsoft.com/
technet) for more information about certificates.

To modify the BusinessFramework.config file:
1. Create a backup copy of the BusinessFramework.config file, located in the 

Business Portal bin folder.

The bin folder is located in C:\inetpub\wwwroot\wss\VirtualDirectories
\<port number>, where <port number> is the port number of the IIS web site 
where Business Portal is installed.

http://microsoft.com/technet
http://microsoft.com/technet
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2. Using a text editor, such as Notepad, open the BusinessFramework.config file.

If any workflow process instances are active, do not change SSL settings in the 
BusinessFramework.config file. Doing so will cause errors when users try to perform 
actions on the tasks associated with those processes.

3. In the Microsoft.BusinessFramework.Portal.PortalConfig section of the 
configuration file, modify the WSSSiteServer node. Replace http with https, 
and replace the TCP port number with the SSL port number. 

The URL should be similar to the following:

To find out which port is used by the Business Portal virtual server, view the web site’s 
properties in IIS Manager (Administrative Tools > Internet Information Services 
(IIS) Manager > right-click the Business Portal web site > choose Properties).

4. Save and close the BusinessFramework.config file.

To modify the registry:
1. Start the registry editor.

Start > Run > type regedit > click OK

2. Locate the entry HKEY_LOCAL_MACHINE\Software\Microsoft\Business 
Portal\Install.

3. Right-click SiteCollection and select Modify. The Edit String window is 
displayed.

4. In the Value data field, change http to https and replace the TCP port number 
with the SSL port number.

To find out which port is used by the Business Portal virtual server, view the web site’s 
properties in IIS Manager (Administrative Tools > Internet Information Services 
(IIS) Manager > right-click the Business Portal web site > choose Properties).

Refer to the following table for an example:

5. Click OK to close the Edit String window.

6. Right-click URIPath and select Modify. The Edit String window is displayed.

7. In the Value data field, change http to https and replace the TCP port number 
with the SSL port number.

To find out which port is used by the Business Portal virtual server, view the web site’s 
properties in IIS Manager (Administrative Tools > Internet Information Services 
(IIS) Manager > right-click the Business Portal web site > choose Properties).

Line Entry

WSSSiteServer https://ServerName:SSLPort/BP

SSL not enabled SSL enabled

http://ServerName:TCPPort/BP https://ServerName:SSLPort/BP
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Refer to the following table for an example:

8. Click OK to close the Edit String window and save changes.

To change public URLs for the site collection:
1. Go to SharePoint Central Administration (Start > Administrative Tools > 

SharePoint 3.0 Central Administration).

2. Click Operations in the Quick Launch.

3. Under Global Configuration, click Alternate access mappings.

4. On the Alternate Access Mappings page, click Edit Public URLs.

5. Select the URL for the Business Portal site collection and change “http” to 
“https” for the site collection’s URLs.

6. Click Save.

To repair URLs for data in the Business Data Catalog:
If you’re not using Business Portal with Office SharePoint Server, Enterprise Edition, do 
not complete this procedure.

1. Edit the registry.

• Start the registry editor.
Start > Run > type regedit > click OK

• Locate the entry HKEY_LOCAL_MACHINE\Software\Microsoft\
Business Portal\Install.

• Right-click SiteCollection and select Modify. The Edit String window is 
displayed.

• In the Value data field, change http to https and replace the TCP port 
number with the SSL port number.

To find out which port is used by the Business Portal virtual server, view 
the web site’s properties in IIS Manager (Administrative Tools > Internet 
Information Services (IIS) Manager > right-click the Business Portal web 
site > choose Properties).

• Click OK to close the Edit String window and save changes.

2. Run the BDCAppAdmin tool.

• Open a command prompt and change the directory to the bin folder. The 
bin folder is located in C:\inetpub\wwwroot\wss\VirtualDirectories\
<port number>, where <port number> is the port number of the IIS web site 
where Business Portal is installed.

SSL not enabled SSL enabled

http://ServerName:TCPPort/BP https://ServerName:SSLPort/BP
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• Type BdcAppAdmin -d “MicrosoftDynamicsGP” and press ENTER.

• Type BdcAppAdmin -i “<Path to Dynamics>/Business Portal/Utilities/
BDCMetadata/BaseApplication/MicrosoftDynamicsGPApplication.xml" 
and press ENTER. 

3. Return the registry entry from step 1 to its original value.

To repair URLs for Search:
If you’re not using Business Portal with Office SharePoint Server, Enterprise Edition, do 
not complete this procedure.

1. Start the Microsoft Dynamics GP Search Setup wizard. (On the Business Portal 
web server, go to Start > Administrative Tools > Microsoft Dynamics GP 
Search Setup.)

2. Click Modify/Repair. For more information about repairing search data, refer to 
Repair or remove search data for a selected company on page 129.

3. Perform a full crawl of the data.

Disable Secure Sockets Layer for Business Portal

If you decide to disable Secure Sockets Layer (SSL) for the Business Portal web site, 
you must complete some additional procedures. The procedures you must complete 
depend on which Business Portal features you have installed. The procedures 
include:

• Modifying the BusinessFramework.config file.

• Modifying the registry.

• Changing public URLs for the site collection.

• Repairing URLs for the Business Data Catalog and Search.

Additional procedures may be required for other Business Portal applications. Refer 
to the Administrator’s Guide for each Business Portal application for more 
information.

Before you perform these procedures, disable SSL for the web site where Business 
Portal is installed. For more information, refer to your Windows documentation.

To modify the BusinessFramework.config file:
1. Create a backup copy of the BusinessFramework.config file, located in the 

Business Portal bin folder.

The bin folder is located in C:\inetpub\wwwroot\wss\VirtualDirectories
\<port number>, where <port number> is the port number of the IIS web site 
where Business Portal is installed.

2. Using a text editor, such as Notepad, open the BusinessFramework.config file.
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If any workflow process instances are active, do not change SSL settings in the 
BusinessFramework.config file. Doing so will cause errors when users try to perform 
actions on the tasks associated with those processes.

3. In the Microsoft.BusinessFramework.Portal.PortalConfig section of the 
configuration file, modify the WSSSiteServer node to have the same 
information as the WSSObjectModelSiteURL node.

The URL should be similar to the following:

To find out which port is used by the Business Portal virtual server, view the web site’s 
properties in IIS Manager (Administrative Tools > Internet Information Services 
(IIS) Manager > right-click the Business Portal web site > choose Properties).

4. Save and close the BusinessFramework.config file.

5. Use Internet Explorer to navigate to Business Portal. The URL should be 
something like:

http://ServerName:TCPPort/BP

where ServerName is the name of the computer where you’ve installed Business 
Portal.

To modify the registry:
1. Start the registry editor.

Start > Run > type regedit > click OK

2. Locate the entry HKEY_LOCAL_MACHINE\Software\Microsoft\Query 
Services\1.0\Install.

3. Right-click URIPath and select Modify. The Edit String window is displayed.

4. In the Value data field, change https to http and replace the SSL port number 
with the TCP port number.

To find out which port is used by the Business Portal virtual server, view the web site’s 
properties in IIS Manager (Administrative Tools > Internet Information Services 
(IIS) Manager > right-click the Business Portal web site > choose Properties).

Refer to the following table for an example:

5. Click OK to close the Edit String window and save changes.

Line Entry

WSSObjectModelSiteURL http://ServerName:TCPPort/BP

WSSSiteServer http://ServerName:TCPPort/BP

SSL enabled SSL not enabled

https://ServerName:SSLPort/BP http://ServerName:TCPPort/BP
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To change public URLs for the site collection:
1. Go to SharePoint Central Administration (Start > Administrative Tools > 

SharePoint 3.0 Central Administration).

2. Click Operations in the Quick Launch.

3. Under Global Configuration, click Alternate access mappings.

4. On the Alternate Access Mappings page, click Edit Public URLs.

5. Select the URL for the Business Portal site collection and change “https” to 
“http” for the site collection’s URLs.

6. Click Save.

To repair URLs for data in the Business Data Catalog:
If you’re not using Business Portal with Office SharePoint Server, Enterprise Edition, do 
not complete this procedure.

1. Edit the registry.

• Start the registry editor.
Start > Run > type regedit > click OK

• Locate the entry HKEY_LOCAL_MACHINE\Software\Microsoft\
Business Portal\Install.

• Right-click SiteCollection and select Modify. The Edit String window is 
displayed.

• In the Value data field, change https to http and replace the SSL port 
number with the TCP port number.

To find out which port is used by the Business Portal virtual server, view 
the web site’s properties in IIS Manager (Administrative Tools > Internet 
Information Services (IIS) Manager > right-click the Business Portal web 
site > choose Properties).

• Click OK to close the Edit String window and save changes.

2. Run the BDCAppAdmin tool.

• Open a command prompt and change the directory to the bin folder. The 
bin folder is located in C:\inetpub\wwwroot\wss\VirtualDirectories\
<port number>, where <port number> is the port number of the IIS web site 
where Business Portal is installed.

• Type BdcAppAdmin -d “MicrosoftDynamicsGP” and press ENTER.

• Type BdcAppAdmin -i “<Path to Dynamics>/Business Portal/Utilities/
BDCMetadata/BaseApplication/MicrosoftDynamicsGPApplication.xml” 
and press ENTER. 

3. Return the registry entry from step 1 to its original value.
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To repair URLs for Search:
If you’re not using Business Portal with Office SharePoint Server, Enterprise Edition, do 
not complete this procedure.

1. Start the Microsoft Dynamics GP Search Setup wizard. (On the Business Portal 
web server, go to Start > Administrative Tools > Microsoft Dynamics GP 
Search Setup.)

2. Click Modify/Repair. For more information about repairing search data, refer to 
Repair or remove search data for a selected company on page 129.

3. Perform a full crawl of the data.

Update SQL logon information for a moved database

If you restore your SQL database on a different instance of SQL Server than the one 
on which the backup was created, you should perform the following steps to 
update logon information.

1. Run sp_change_users_login to update logon information in SQL Server. For 
more information, refer to the SQL Server Books Online (search for 
sp_change_users_login).

2. Create a backup copy of the BusinessFramework.config file located in the 
Business Portal bin folder.

The bin folder is located in C:\inetpub\wwwroot\wss\VirtualDirectories
\<port number>, where <port number> is the port number of the IIS web site 
where Business Portal is installed.

3. Open the BusinessFramework.config file using a text editor.

4. In the Microsoft.BusinessFramework.Portal.PortalConfig section of the 
configuration file, replace the old server name in the WSSSiteURL node and the 
WSSObjectModelSiteURL node with the new server name.

5. Save and close the BusinessFramework.config file.

6. Create a backup copy of the ~privatefile.dbauthentication.config file, also 
located in the bin folder.

7. Open the ~privatefile.dbauthentication.config file using a text editor.

8. Find the old server name and replace it with the name of the new server.

9. Save and close the ~privatefile.dbauthentication.config file.



164 A D M I N I S T R A T O R ’ S G U I D E



P
A

R
T

 8
: R

O
LE

 A
N

D
 G

R
O

U
P

 R
E

FE
R

E
N

C
E



166 A D M I N I S T R A T O R ’ S G U I D E

Part 8: Role and group reference
This part of the documentation lists default roles, groups and security permissions 
for Business Portal. The following information is included:

• Chapter 26, “Default SharePoint groups and security permissions,” lists the 
SharePoint groups installed with Business Portal, along with the default site 
and page permissions associated with each group.

• Chapter 27, “Default portal roles and security permissions,” lists the portal roles 
installed with Business Portal, along with the default data permissions 
associated with each role.

• Chapter 28, “Default advanced roles and security permissions,” lists the 
advanced roles installed with Business Portal, along with the default data 
permissions associated with each role.
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Chapter 26: Default SharePoint groups and 
security permissions
The default SharePoint groups installed with Business Portal are listed below. 
Default site and page permissions associated with each SharePoint group also are 
included.

Note that some Business Portal applications include their own default SharePoint 
groups and permissions, which are added to Business Portal when you install the 
applications. Those default groups and permissions are listed in each individual 
application’s administrator documentation.

To view group permissions in SharePoint, go to a Site Settings page and under 
Users and permissions, click People and groups. Click Groups in the Quick 
Launch, then click the name of the group you want to view permissions for. Click 
Settings > View Group Permissions.

BP Accounting Specialist

This group is used to manage access to pages provided for members of your 
accounting department.

BP Administrator

This group is used to manage access to the entire Business Portal. Users in this 
group can manage page access for all other Business Portal users.

BP Employee

This group is used to manage access to pages provided for all employees in your 
company.

Site Page library Page Permission level

Financial Center Financial Center Common Pages All Contribute

Financial Center Pages All Read

Transaction Flowcharts All Read

Site Page library Page Permission level

Reports All report libraries N/A Full Control

Business Portal top-
level site

All All Full Control

All Business Portal 
subsites

All All Full Control

Site Page library Page Permission level

Company Center Company Center Common Pages All Read

Company Center Pages All Read

Employee Center Employee Center Common Pages All Read

Employee Center Pages All Read
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BP Executive

This group is used to manage access to pages provided for CEOs and CFOs in your 
company.

BP Executive Reports - Company Name

This group is used to manage access to reports provided for CEOs and CFOs in 
your company.

BP Field Service Reports - Company Name

This group is used to manage access to reports provided for Field Service users in 
your company.

BP Financial Reports - Company Name

This group is used to manage access to reports provided for users in the Financial 
department of your company.

BP HR Administrator

This group is used to manage access to pages provided for members of your 
Human Resources department.

Site Page library Page Permission level

Executive Center Executive Center Common Pages All Read

Site Document library Folder Permission level

Reports Business Portal Executive Reports <Company> Read

Site Document library Folder Permission level

Reports Business Portal Field Service Reports <Company> Read

Site Document library Folder Permission level

Reports Business Portal Financial Reports <Company> Read

Site Page library Page Permission level

Company Center Company Center Common 
Pages

All Contribute

Employee Center Employee Center Common 
Pages

All Contribute

Manager Center Manager Center Common Pages All Contribute

Human Resources Center Human Resources Center 
Common Pages

All Contribute

Human Resources Center Pages All Read
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BP Human Resources Reports - Company Name

This group is used to manage access to reports provided for members of your 
Human Resources department.

BP Internal User

All internal Business Portal users must be assigned to the BP Internal User group. 
(External users, such as customers, shouldn’t be assigned to this group.)

BP Inventory Manager

This group is used to manage access to pages provided for employees who manage 
inventory information.

BP Inventory Reports - Company Name

This group is used to manage access to reports provided for employees who 
manage inventory information.

BP Manager

This group is used to manage access to pages provided for managers in your 
company.

Site Document library Folder Permission level

Reports Business Portal Human Resources 
Reports 

<Company> Read

Site Page library Page Permission level

Top-level site in the 
collection

N/A N/A Read

Business Portal top-level 
web site

Business Portal Common Pages All Read

Site Page library Page Permission level

Inventory Center Inventory Center Common 
Pages

All Contribute

Inventory Center Pages All Read

Site Document library Folder Permission level

Reports Business Portal Inventory Reports <Company> Read

Site Page library Page Permission level

Manager Center Manager Center Common Pages All Read

Manager Center Pages All Read
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BP Manufacturing Reports - Company Name

This group is used to manage access to reports provided for employees who 
manage production operations of your company.

BP Operations Manager

This group is used to manage access to pages provided to employees who manage 
the sales, purchasing, inventory, and production operations of your company.

Site Document library Folder Permission level

Reports Business Portal Manufacturing 
Reports 

<Company> Read

Site Page library Page Permission level

Inventory Center Inventory Center Common 
Pages

All Contribute

Inventory Center Pages All Read

Manufacturing 
Center

Manufacturing Center Common 
Pages

All Contribute

Manufacturing Center Pages All Read

Purchasing Center Purchasing Center Common 
Pages

All Contribute

Purchasing Center Pages All Read

Sales Center Sales Center Common Pages All Contribute

Sales Center Pages Commission 
Totals by 
Salesperson

Read

Commission 
Totals by Territory

Read

Customer List Read

Customer 
Summary

Read

Documents by 
Customer

Read

Payments by 
Customer

Read

Prospects Read

Sales Back Order 
List

Read

Sales Fulfillment 
Order List

Read

Sales Invoice List Read

Sales Order List Read

Sales Queries Read

Sales Quote List Read

Sales Reports Read

Sales Return List Read

Salesperson List Read

Territories List Read
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BP Order Entry Clerk

This group is used to manage access to pages provided for employees who process 
sales orders.

BP Payroll Administrator

This group is used to manage access to pages provided for members of your payroll 
department.

BP Payroll Reports - Company Name

This group is used to manage access to reports provided for members of your 
payroll department.

Site Page library Page Permission level

Sales Center Sales Center Common Pages All Read

Sales Center Pages Customer List Read

Customer Summary Read

Documents by 
Customer

Read

Payments by 
Customer

Read

Prospects Read

Sales Back Order 
List

Read

Sales Fulfillment 
Order List

Read

Sales Invoice List Read

Sales Order List Read

Sales Queries Read

Sales Quote List Read

Sales Reports Read

Sales Return List Read

Site Page library Page Permission level

Business Portal top-level 
site

N/A N/A BP Administration

Payroll Center Payroll Center Common Pages All Contribute

Payroll Center Pages All Read

Site Document library Folder Permission level

Reports Business Portal Payroll Reports <Company> Read
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BP Production Manager

This group is used to manage access to the pages provided to employees who 
manage the production process.

BP Purchasing Manager

This group is used to manage access to pages provided for members of your 
purchasing department.

BP Purchasing Reports - Company Name

This group is used to manage access to reports provided for members of your 
purchasing department.

BP Report Publisher

This group is used to manage access to company report folders on the Report 
Center site for users who publish Microsoft Dynamics GP reports.

BP Reports Catalog Administrator

This group is used to manage access to pages used to set up and configure the 
Reports Catalog.

Site Page library Page Permission level

Manufacturing Center Manufacturing Center Common 
Pages

All Contribute

Manufacturing Center Pages All Read

Site Page library Page Permission level

Purchasing Center Purchasing Center Common 
Pages

All Contribute

Purchasing Center Pages All Read

Site Document library Folder Permission level

Reports Business Portal Purchasing Reports <Company> Read

Site Page library Page Permission level

Reports All report libraries N/A Contribute

Site Page library Page Permission level

Business Portal top-level 
site

N/A N/A BP Administration

Reports Catalog Pages All Read
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BP Sales Manager

This group is used to manage access to pages provided for sales managers in your 
company.

BP Sales Reports - Company Name

This group is used to manage access to reports provided for salespeople and sales 
managers in your company.

Site Page library Page Permission level

Inventory Center Inventory Center Common 
Pages

All Contribute

Inventory Center Pages All Read

Sales Center Sales Center Common Pages All Contribute

Sales Center Pages Commission 
Totals by 
Salesperson

Read

Commission 
Totals by Territory

Read

Customer List Read

Customer 
Summary

Read

Documents by 
Customer

Read

Payments by 
Customer

Read

Prospects Read

Sales Back Order 
List

Read

Sales Fulfillment 
Order List

Read

Sales Invoice List Read

Sales Order List Read

Sales Queries Read

Sales Quote List Read

Sales Reports Read

Sales Return List Read

Salesperson List Read

Territories List Read

Sales Manager Dashboard 
Pages

All Read

Site Document library Folder Permission level

Reports Business Portal Sales Reports <Company> Read
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BP Salesperson

This group is used to manage access to pages provided for salespeople in your 
company.

Site Page library Page Permission level

Inventory Center Inventory Center Common 
Pages

All Read

Inventory Center Pages All Read

Sales Center Sales Center Common Pages All Read

Sales Center Pages Customer List Read

Customer 
Summary

Read

Documents by 
Customer

Read

Payments by 
Customer

Read

Prospects Read

Sales Back Order 
List

Read

Sales Fulfillment 
Order List

Read

Sales Invoice List Read

Sales Order List Read

Sales Queries Read

Sales Quote List Read

Sales Reports Read

Sales Return List Read

Salesperson List Read

Salesperson Dashboard Pages All Read
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Chapter 27: Default portal roles and security 
permissions
The default portal MBF roles installed with Business Portal are listed below. Default 
data permissions associated with each portal role also are included.

Note that some Business Portal applications include their own default MBF roles 
and security permissions, which are added to Business Portal when you install the 
applications. Those default roles and permissions are listed in the individual 
application’s administrator documentation.

To view MBF role permissions in Business Portal, go to the Site Settings page for the 
top-level Business Portal web site. Under Business Portal Administration, click 
Roles. On the Roles page, select a role name and click the Permissions tab.

Accounting Specialist

This role is used to manage access to data provided for members of your accounting 
department, such as General Ledger account balances.

Data permissions

Account - All
AccountCategory - All
AllocationFinancialAccount - All
AllocationUnitAccount - All
Bank - All
Budget - All
Checkbook - All
Comment - All
CreditCard - All
Currency - All
CurrencyAccess - All
ExchangeTable - All
ExchangeTableAccount - All
FinancialAccount - All
FiscalYear - All
FixedAllocationFinancialAccount - All
FixedAllocationUnitAccount - All
Ledger Transaction Detail - All
LedgerTransactionSummary - All
LedgerTransactionSummaryHistory - All
MulticurrencyAccount - All
MulticurrencyDefaults - All
SingleFinancialAccount - All
SingleUnitAccount - All
UnitAccount - All
VariableAllocationFinancialAccount - All
VariableAllocationUnitAccount - All
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Administrator

This role is used to give full control of Business Portal data. No data permissions are 
assigned to this role, but users in the role have access to all data. Users in this role 
can manage data access for all other Business Portal users. 

Executive

This role is used to manage access to data provided for CEOs and CFOs in your 
company.

Fixed Assets Stakeholder

This role is used to manage access to data provided for fixed asset stakeholders in 
your company.

Data permissions

Account - All
Budget - All
Checkbook - All
Customer - All
InventoryPeriodSummary - All
InventorySummary - All
Item - All
ItemClass - All
LedgerTransactionDetail - All
LedgerTransactionSummary - All
ManufacturingOrder - All
ManufacturingOrderVariance - All
ReceivablesSummary - All
ReportCatalog_RoleDAP
SalesDocument - All
SalesReturn - All
Work Center - All
Work Center Loading - All

Data permissions

FA Books - All
FA Class ID - All
FA Location ID - All
FA Physical Location - All
Fixed Asset Book - All
Fixed Asset Financial Detail - All
Fixed Asset General Information - All
Fixed Asset Retirement - All
Fixed Asset Transfer - All
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Human Resources Administrator

This role is used to manage access to data (such as benefits and recruiting 
information) provided for members of your Human Resources department.

Data permissions

Applicant - All
Benefit - All
BenefitSetup - All
Course - All
Deduction - All
DeductionSetup - All
Department - All
Division - All
Employee - All
Employee - Restricted Directory Information
LocalTaxSetup - All
Location - All
MCDepartment - All
MCDivision - All
MCPosition - All
Paycode - All
PaycodeSetup - All
PayStub - All
Position - All
Requisition - All
RequisitionApplicant - All
RequisitionApplicantCost - All
Requisition - Restricted Current Company
Skill - All
SkillSet - All
SkillSetLine - All
StateTaxSetup - All
Supervisor - All
TestAndCertificationSetup - All
TimeCodeSetup
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Inventory Manager

This role is used to manage access to data (such as quantities and pricing) provided 
for employees who manage inventory information.

Data permissions

BatchHistory - All
DiscontinuedItem - All
FlatFeeItem - All
InventoryDocument - All
InventoryDocumentCommon - All
InventoryDocumentHistory - All
InventoryLineBase - All
InventoryPeriodSummary - All
InventoryPurchaseOrderReceiptLineHistory - All
InventorySalesInvoiceLineHistory - All
InventorySalesReturnLineHistory - All
InventorySummary - All
Item - All
ItemClass - All
ItemClassCurrency - All
ItemCurrency - All
ItemLotAttributeHistory - All
ItemQuantities - All
ItemSiteQuantities - All
Kit - All
LotAttribute - All
MiscellaneousChargesItem - All
PriceGroup - All
PriceLevel - All
ServicesItem - All
Site - All
UnitOfMeasureSchedule - All
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Operations Manager

This role is used to manage access to data provided to employees who manage the 
sales, purchasing, inventory, and production operations of the company.
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Data permissions

Batch - All
BatchHistory - All
Buyer - All
Checkbook - All
CorporateCustomer - All
CreditCard - All
Customer - All
CustomerClass - All
DiscontinuedItem - All
DropShipPurchaseOrder - All
Intrastat - All
InventoryDocument - All
InventoryDocumentCommon - All
InventoryDocumentHistory - All
InventoryLineBase - All
InventoryPeriodSummary - All
InventoryPurchaseOrderReceiptLineHistory - 
All
InventorySalesInvoiceLineHistory - All
InventorySalesReturnLineHistory - All
InventorySummary - All
Item - All
ItemClass - All
ItemClassCurrency - All
ItemCurrency - All
ItemLotAttributeHistory - All
ItemQuantities - All
ItemSiteQuantities - All
ItemVendor - All
Kit - All
LotAttribute - All
Manufacturing Order - All
Manufacturing Order Variance - All
MiscellaneousChargesItem - All
MRP Item - All
MRP Site - All
PayablesApply - All
PayablesApplyHistory - All
PayablesBatch - All
PayablesBatchHistory - All
PayablesCredit - All
PayablesCreditMemo - All
PayablesCreditMemoHistory - All
PayablesCreditMemoUnposted - All
PayablesCreditPosted - All
PayablesCreditUnposted - All
PayablesDebit - All
PayablesDebitPosted - All
PayablesDebitUnposted - All
PayablesDocument - All
PayablesDocumentMaster - All
PayablesFinanceCharge - All
PayablesFinanceChargeHistory - All
PayablesFinanceChargeUnposted - All
PayablesIntrastat - All
PayablesInvoice - All
PayablesInvoiceHistory - All

PayablesInvoiceUnposted - All
PayablesManualPaymentUnposted - All
PayablesMiscellaneousCharge - All
PayablesMiscellaneousChargeHistory - All
PayablesMiscellaneousChargeUnposted - 
All
PayablesPayment - All
PayablesPaymentHistory - All
PayablesPaymentUnposted - All
PayablesReturn - All
PayablesReturnHistory - All
PayablesReturnUnposted - All
PayablesScheduledPayment - All
PayablesScheduledPaymentDocument - All
PayablesScheduledPaymentHistory - All
PayablesTaxHistory - All
PaymentTerm - All
PriceGroup - All
PriceLevel - All
Prospect - All
PurchaseOrder - All
PurchaseOrderDocument - All
ReceivablesApply - All
ReceivablesApplyHistory - All
ReceivablesBatch - All
ReceivablesBatchHistory - All
ReceivablesCashReceipt - All
ReceivablesCashReceiptHistory - All
ReceivablesCashReceiptUnposted - All
ReceivablesCommission - All
ReceivablesCommissionHistory - All
ReceivablesCredit - All
ReceivablesCreditMemo - All
ReceivablesCreditMemoHistory - All
ReceivablesCreditMemoUnposted - All
ReceivablesCreditPosted - All
ReceevablesCreditUnposted - All
ReceivablesDebit - All
ReceivablesDebitMemo - All
ReceivablesDebitMemoHistory - All
ReceivablesDebitMemoUnposted - All
ReceivablesDebitPosted - All
ReceivablesDebitUnposted - All
ReceivablesDocument - All
ReceivablesDocumentMaster - All
ReceivablesFinanceCharge - All
ReceivablesFinanceChargeHistory - All
ReceivablesFinanceChargeUnposted - All
ReceivablesIntrastat - All
ReceivablesInvoice - All
ReceivablesInvoiceHistory - All
ReceivablesInvoiceUnposted - All
ReceivablesPeriodSetup - All
ReceivablesPeriodSummary - All
ReceivablesReturn - All
ReceivablesReturnHistory - All

ReceivablesReturnUnposted - All
ReceivablesScheduledPayment - All
ReceivablesScheduledPaymentDocument - 
All
ReceivablesScheduledPaymentHistory - All
ReceivablesServiceCharge - All
ReceivablesServiceChargeHistory - All
ReceivablesServiceChargeUnposted - All
ReceivablesSetup - All
ReceivablesStatement - All
ReceivablesSummary - All
ReceivablesTaxHistory - All
ReceivablesWarranty - All
ReceivablesWarrantyDocument - All
ReceivablesWarrantyHistory - All
ReceivablesWarrantyUnposted - All
SalesBackOrder - All
SalesBackOrderDocument - All
SalesBackOrderHistory - All
SalesDocument - All
SalesInventoryItem - All
SalesInvoice - All
SalesInvoiceDocument - All
SalesInvoiceHistory - All
SalesOrder - All
SalesOrderDocument - All
SalesOrderHistory - All
SalesOrderIntrastat - All
SalesOrderTaxHistory - All
Salesperson - All
SalespersonPeriodSummary - All
SalespersonSummary - All
SalesProcessHold - All
SalesProcessHoldDetail - All
SalesQuote - All
SalesQuoteDocument - All
SalesQuoteHistory - All
SalesReturn - All
SalesReturnDocument - All
SalesReturnHistory - All
SalesTerritory - All
SalesTerritoryPeriodSummary - All
SalesTerritorySummary - All
ServicesItem - All
ShippingMethod - All
SingleItem - All
Site - All
StandardPurchaseOrder - All
TaxDetail - All
TaxSchedule - All
UnitOfMeasureSchedule - All
Vendor - All
VendorClass - All
VendorPeriodSummary - All
VendorSummary - All
Work Center - All
Work Center Loading - All
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Order Entry Clerk

This role is used to manage access to data provided for employees who process 
sales orders.

Data permissions

CorporateCustomer - All
CreditCard - All
Customer - All
CustomerClass - All
Intrastat - All
Item - All
Prospect - All
ReceivablesApply - All
ReceivablesApplyHistory - All
ReceivablesBatch - All
ReceivablesBatchHistory - All
ReceivablesCashReceipt - All
ReceivablesCashReceiptHistory - All
ReceivablesCashReceiptUnposted - All
ReceivablesCommission - All
ReceivablesCommissionHistory - All
ReceivablesCredit - All
ReceivablesCreditMemo - All
ReceivablesCreditMemoHistory - All
ReceivablesCreditMemoUnposted - All
ReceivablesCreditPosted - All
ReceivablesCreditUnposted - All
ReceivablesDebit - All
ReceivablesDebitMemo - All
ReceivablesDebitMemoHistory - All
ReceivablesDebitMemoUnposted - All
ReceivablesDebitPosted - All
ReceivablesDebitUnposted - All
ReceivablesDocument - All
ReceivablesDocumentMaster - All
ReceivablesFinanceCharge - All
ReceivablesFinanceChargeHistory - All
ReceivablesFinanceChargeUnposted - All
ReceivablesIntrastat - All
ReceivablesInvoice - All
ReceivablesInvoiceHistory - All
ReceivablesInvoiceUnposted - All
ReceivablesPeriodSummary - All
ReceivablesReturn - All

ReceivablesReturnHistory - All
ReceivablesReturnUnposted - All
ReceivablesScheduledPayment - All
ReceivablesScheduledPaymentDocument - All
ReceivablesScheduledPaymentHistory - All
ReceivablesServiceCharge - All
ReceivablesServiceChargeHistory - All
ReceivablesServiceChargeUnposted - All
ReceivablesStatement - All
ReceivablesSummary - All
ReceivablesTaxHistory - All
ReceivablesWarranty - All
ReceivablesWarrantyDocument - All
ReceivablesWarrantyHistory - All
ReceivablesWarrantyUnposted - All
SalesBackOrder - All
SalesBackOrderDocument - All
SalesBackOrderHistory - All
SalesDocument - All
SalesInvoice - All
SalesInvoiceDocument - All
SalesInvoiceHistory - All
SalesOrder - All
SalesOrderDocument - All
SalesOrderHistory - All
SalesOrderIntrastat - All
SalesOrderTaxHistory - All
SalespersonPeriodSummary - All
SalesProcessHold - All
SalesProcessHoldDetail - All
SalesQuote - All
SalesQuoteDocument - All
SalesQuoteHistory - All
SalesReturn - All
SalesReturnDocument - All
SalesReturnHistory - All
ShippingMethod - All
TaxDetail - All
TaxSchedule - All
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Payroll Administrator

This role is used to manage access to data (such as employee and pay information) 
provided for members of your payroll department.

Production Manager

This role is used to manage access to the data provided to employees who manage 
the production process.

Data permissions

Benefit - All
BenefitSetup - All
ComputerCheck - All
Course - All
Deduction - All
DeductionSetup - All
Department - All
Division - All
Employee - All
Employee - Restricted Directory Information
LocalTax-All
Location-All
ManualCheck-All
Paycode-All
PaycodeSetup-All
PayStub-All
PayStubItem-All
Position-All
Skill-All
SkillSet-All
SkillSetLine-All
Supervisor-All
TestAndCertificationSetup-All
TimeCodeSetup

Data permissions

Item - All
ItemClass - All
Manufacturing Order - All
Manufacturing Order Variance - All
MRP Item - All
MRP Site - All
Site - All
Work Center - All
Work Center Loading - All
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Purchasing Manager

This role is used to manage access to data (such as vendor information) provided 
for members of your purchasing department. 

Reports Catalog Administrator

This role is used to manage access to data used to set up and configure the Reports 
Catalog.

Data permissions

Buyer - All
Checkbook - All
CreditCard - All
DropShipPurchaseOrder - All
ItemVendor - All
PayablesApply - All
PayablesApplyHistory - All
PayablesBatch - All
PayablesBatchHistory - All
PayablesCredit - All
PayablesCreditMemo - All
PayablesCreditMemoHistory - All
PayablesCreditMemoUnposted - All
PayablesCreditPosted - All
PayablesCreditUnposted - All
PayablesDebit - All
PayablesDebitPosted - All
PayablesDebitUnposted - All
PayablesDocument - All
PayablesDocumentMaster - All
PayablesFinanceCharge - All
PayablesFinanceChargeHistory - All
PayablesFinanceChargeUnposted - All
PayablesIntrastat - All
PayablesInvoice - All

PayablesInvoiceHistory - All
PayablesInvoiceUnposted - All
PayablesManualPaymentUnposted - All
PayablesMiscellaneousCharge - All
PayablesMiscellaneousChargeHistory - All
PayablesMiscellaneousChargeUnposted - All
PayablesPayment - All
PayablesPaymentHistory - All
PayablesPaymentUnposted - All
PayablesReturn - All
PayablesReturnHistory - All
PayablesReturnUnposted - All
PayablesScheduledPayment - All
PayablesScheduledPaymentDocument - All
PayablesScheduledPaymentHistory - All
PayablesTaxHistory - All
PaymentTerm - All
PurchaseOrder - All
PurchaseOrderDocument - All
StandardPurchaseOrder - All
UnitOfMeasureSchedule - All
Vendor - All
VendorClass - All
VendorPeriodSummary - All
VendorSummary - All

Data permissions

ReportCatalog_All
ReportCatalog_RoleDAP
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Sales Manager

This role is used to manage access to data (such as customer or sales territory 
information) provided for sales managers in your company.

Data permissions

Batch - All
CorporateCustomer - All
CreditCard - All
Customer - All
CustomerClass - All
Intrastat - All
InventoryPeriodSummary - All
InventorySummary - All
Item - All
ItemCurrency - All
ItemQuantities - All
ItemSiteQuantities - All
PriceGroup - All
PriceLevel - All
Prospect - All
ReceivablesApply - All
ReceivablesApplyHistory - All
ReceivablesBatch - All
ReceivablesBatchHistory - All
ReceivablesCashReceipt - All
ReceivablesCashReceiptHistory - All
ReceivablesCashReceiptUnposted - All
ReceivablesCommission - All
ReceivablesCommissionHistory - All
ReceivablesCredit - All
ReceivablesCreditMemo - All
ReceivablesCreditMemoHistory - All
ReceivablesCreditMemoUnposted - All
ReceivablesCreditPosted - All
ReceivablesCreditUnposted - All
ReceivablesDebit - All
ReceivablesDebitMemo - All
ReceivablesDebitMemoHistory - All
ReceivablesDebitMemoUnposted - All
ReceivablesDebitPosted - All
ReceivablesDebitUnposted - All
ReceivablesDocument - All
ReceivablesDocumentMaster - All
ReceivablesFinanceCharge - All
ReceivablesFinanceChargeHistory - All
ReceivablesFinanceChargeUnposted - All
ReceivablesIntrastat - All
ReceivablesInvoice - All
ReceivablesInvoiceHistory - All
ReceivablesInvoiceUnposted - All
ReceivablesPeriodSetup - All
ReceivablesPeriodSummary - All
ReceivablesReturn - All

ReceivablesReturnHistory - All
ReceivablesReturnUnposted - All
ReceivablesScheduledPayment - All
ReceivablesScheduledPaymentDocument - All
ReceivablesScheduledPaymentHistory - All
ReceivablesServiceCharge - All
ReceivablesServiceChargeHistory - All
ReceivablesServiceChargeUnposted - All
ReceivablesSetup - All
ReceivablesStatement - All
ReceivablesSummary - All
ReceivablesTaxHistory - All
ReceivablesWarranty - All
ReceivablesWarrantyDocument - All
ReceivablesWarrantyHistory - All
ReceivablesWarrantyUnposted - All
SalesBackOrder - All
SalesBackOrderDocument - All
SalesBackOrderHistory - All
SalesDocument - All
SalesInventoryItem - All
SalesInvoice - All
SalesInvoiceDocument - All
SalesInvoiceHistory - All
SalesOrder - All
SalesOrderDocument - All
SalesOrderHistory - All
SalesOrderIntrastat - All
SalesOrderTaxHistory - All
Salesperson - All
SalespersonPeriodSummary - All
SalespersonSummary - All
SalesProcessHold - All
SalesProcessHoldDetail - All
SalesQuote - All
SalesQuoteDocument - All
SalesQuoteHistory - All
SalesReturn - All
SalesReturnDocument - All
SalesReturnHistory - All
SalesTerritory - All
SalesTerritoryPeriodSummary - All
SalesTerritorySummary - All
ShippingMethod - All
SingleItem - All
Site - All
TaxDetail - All
TaxSchedule - All
UnitOfMeasureSchedule - All
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User

All users added to Business Portal automatically are assigned to the User role. No 
data permissions are assigned directly to this role.
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Chapter 28: Default advanced roles and security 
permissions
The default advanced MBF roles installed with Business Portal are listed below. 
Default data permissions associated with each advanced role also are included. We 
recommend that you not remove advanced roles, because new ones cannot be 
created.

Note that some Business Portal applications include their own default MBF roles 
and security permissions, which are added to Business Portal when you install the 
applications. Those default roles and permissions are listed in the individual 
application’s administrator documentation.

To view MBF role permissions in Business Portal, go to the Site Settings page for the 
top-level Business Portal web site. Under Business Portal Administration, click 
Roles. On the Roles page, select a role name and click the Permissions tab.

Customer

This role is used to manage access to data provided for your company’s customers. 
It can be linked to a Customer ID from Microsoft Dynamics GP.

Row-level restrictions are applied to all default data permissions assigned to the Customer 
role. The Customer ID associated with a user determines which data is displayed. For more 
information, refer to Chapter 10, “Managing data permissions.” Child entities—for 
example, CustomerAddress, a child entity of the Customer entity— are also restricted 
through these row-level policies.

Data permissions

Customer - Restricted Self
CustomerItem - Restricted Self
ReceivablesCashReceipt - Restricted Self
ReceivablesCashReceiptHistory - Restricted Self
ReceivablesCredit - Restricted Self
ReceivablesCreditMemo - Restricted Self
ReceivablesCreditMemoHistory - Restricted Self
ReceivablesDebit - Restricted Self
ReceivablesDebitMemo - Restricted Self
ReceivablesDebitMemoHistory - Restricted Self
ReceivablesDocument - Restricted Self
ReceivablesFinanceCharge - Restricted Self
ReceivablesFinanceChargeHistory - Restricted Self
ReceivablesInvoice - Restricted Self
ReceivablesInvoiceHistory - Restricted Self
ReceivablesReturn - Restricted Self
ReceivablesReturnHistory - Restricted Self
ReceivablesScheduledPayment - Restricted Self
ReceivablesScheduledPaymentHistory - Restricted 
Self
ReceivablesServiceCharge - Restricted Self

ReceivablesServiceChargeHistory - 
Restricted Self
ReceivablesSummary - Restricted Self
ReceivablesWarranty - Restricted Self
ReceivablesWarrantyHistory - Restricted Self
SalesBackOrder - Restricted Self
SalesBackOrderDocument - Restricted Self
SalesBackOrderHistory - Restricted Self
SalesDocument - Restricted Self
SalesInvoice - Restricted Self
SalesInvoiceDocument - Restricted Self
SalesInvoiceHistory - Restricted Self
SalesOrder - Restricted Self
SalesOrderDocument - Restricted Self
SalesOrderHistory - Restricted Self
SalesQuote - Restricted Self
SalesQuoteDocument - Restricted Self
SalesQuoteHistory - Restricted Self
SalesReturn - Restricted Self
SalesReturnDocument - Restricted Self
SalesReturnHistory - Restricted Self
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Employee

This role is used to manage access to data (such as company-wide information) 
provided for all employees in your company. It can be linked to an Employee ID 
from Microsoft Dynamics GP.

Manager

This role is used to manage access to data (such as human resource policies) 
provided for managers in your company. It can be linked to a Supervisor ID from 
Microsoft Dynamics GP.

Data permissions

Applicant - Restricted Self
Benefit - Restricted Self
BenefitSetup - All
Company - All
CompanyAddress - All
Course - All
Deduction - Restricted Self
DeductionSetup - All
Department - All
Division - All
Employee - Restricted Directory Information
Employee - Restricted Self
HRPayScheduleYear - Restricted Current 

Year
HRTransactionDetail - Restricted Self
LocalTax - Restricted Self
LocalTaxSetup - All
Location - All
MCDepartment - All
MCDivision - All

MCPosition - All
Note - All
PayCode - Restricted Self
PaycodeSetup - All
PayStubItem - Restricted Self
PayStub - Restricted Self
Position - All
ReportCatalog_RoleDAP
RequisitionApplicant - Restricted Manager
RequisitionApplicant - Restricted Self
Requisition - Restricted Open or Immediate Status 
Skill - All
SkillSet - All
SkillSetLine - All
StateTax - Restricted Self
StateTaxSetup - All
Supervisor - All
TestAndCertificationSetup - All
TimeCodeSetup

Data permissions

Applicant - All
Course - All
Department - All
Division - All
Employee - Restricted Directory Information
Employee - Restricted Manager
Location - All
MCDepartment - All
MCDivision - All
MCPosition - All
PaycodeSetup - All
Position - All
RequisitionApplicant - All
RequisitionApplicantCost - All
Requisition - Restricted Current Company
Requisition - RestrictedManager
Skill - All
SkillSet - All
SkillSetLine - All
Supervisor - All
TestAndCertificationSetup - All
TimeCodeSetup
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Salesperson

This role is used to manage access to data (such as sales or customer information) 
provided for salespeople in your company. It can be linked to a Salesperson ID from 
Microsoft Dynamics GP. 

By default, data permissions for the Salesperson Summary, Salesperson Period 
Summary, Receivables Commission, and Receivables Commission History entities 
are not available to users in the Salesperson role. To make this information 
available, we recommend creating new data permissions for these entities using 
row-level restriction policies. When a row-level restriction is applied, the 
Salesperson ID associated with a user determines which data is displayed. Row-
level restriction policies for these entities are provided by default.

Data permissions

CorporateCustomer - All
CreditCard - All
Customer - All
CustomerClass - All
Intrastat - All
InventoryPeriodSummary - All
InventorySummary - All
Item - All
ItemCurrency - All
ItemQuantities - All
ItemSiteQuantities - All
PriceGroup - All
PriceLevel - All
Prospect - All
ReceivablesApply - All
ReceivablesApplyHistory - All
ReceivablesBatch - All
ReceivablesBatchHistory - All
ReceivablesCashReceipt - All
ReceivablesCashReceiptHistory - All
ReceivablesCashReceiptUnposted - All
ReceivablesCredit - All
ReceivablesCreditMemo - All
ReceivablesCreditMemoHistory - All
ReceivablesCreditMemoUnposted - All
ReceivablesCreditPosted - All
ReceivablesCreditUnposted - All
ReceivablesDebit - All
ReceivablesDebitMemo - All
ReceivablesDebitMemoHistory - All
ReceivablesDebitMemoUnposted - All
ReceivablesDebitPosted - All
ReceivablesDebitUnposted - All
ReceivablesDocument - All
ReceivablesDocumentMaster - All
ReceivablesFinanceCharge - All
ReceivablesFinanceChargeHistory - All
ReceivablesFinanceChargeUnposted - All
ReceivablesIntrastat - All
ReceivablesInvoice - All
ReceivablesInvoiceHistory - All
ReceivablesInvoiceUnposted - All

ReceivablesPeriodSummary - All
ReceivablesReturn - All
ReceivablesReturnHistory - All
ReceivablesReturnUnposted - All
ReceivablesScheduledPayment - All
ReceivablesScheduledPaymentDocument - All
ReceivablesScheduledPaymentHistory - All
ReceivablesServiceCharge - All
ReceivablesServiceChargeHistory - All
ReceivablesServiceChargeUnposted - All
ReceivablesStatement - All
ReceivablesSummary - All
ReceivablesTaxHistory - All
ReceivablesWarranty - All
ReceivablesWarrantyDocument - All
ReceivablesWarrantyHistory - All
ReceivablesWarrantyUnposted - All
SalesBackOrder - All
SalesBackOrderDocument - All
SalesBackOrderHistory - All
SalesDocument - All
SalesInvoice - All
SalesInvoiceDocument - All
SalesInvoiceHistory - All
SalesOrder - All
SalesOrderDocument - All
SalesOrderHistory - All
SalesOrderIntrastat - All
SalesOrderTaxHistory - All
SalesProcessHold - All
SalesProcessHoldDetail - All
SalesQuote - All
SalesQuoteDocument - All
SalesQuoteHistory - All
SalesReturn - All
SalesReturnDocument - All
SalesReturnHistory - All
ShippingMethod - All
Site - All
TaxDetail - All
TaxSchedule - All
UnitOfMeasureSchedule - All
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After you’ve created new data permissions and assigned them to the Salesperson 
role, you must create new queries using the new data permissions. For more 
information about data permissions and row-level restrictions, see Chapter 10, 
“Managing data permissions.” For more information about queries, see Chapter 12, 
“Creating queries.” 

Vendor

This role is used to manage access to data provided for your company’s vendors. It 
can be linked to a Vendor ID from Microsoft Dynamics GP. There are no data 
permissions assigned to this role by default.
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crawl schedule guidelines 121
crawling content 120
data that can be searched 120
how users access 122
overview 119
removing for all companies 130
repairing or removing 129
securing data 128

Secure Sockets Layer (SSL)
Business Portal URL 18
disabling for Business Portal 160
enabling for Business Portal 157

secured tasks
modifying for a role 53
modifying permissions for users 48

security
adding users to MBF roles 43
adding users to SharePoint groups 40
adding users to web service roles 63
Business Portal and Windows 

SharePoint Services 28
data permissions 55
effect on navigation 38
for reports in Reports Catalog 102
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security (continued)
for reports in the Report Center 107
how Business Portal works with 

SharePoint 39
inheritance explained 36
mapping users to IDs in MBF 50
mapping users to IDs in web services 

64
Microsoft Business Framework 30
Microsoft Dynamics Security 

Synchronization Utility 33
overview 29
page permission guidelines 38
restricting data for customers 138
roles 49
Search data 128
SharePoint groups overview 39
SharePoint permission levels 

overview 40
synchronizing roles and groups 32
user accounts for external users 138
user setup checklist 32
Web Services for Microsoft Dynamics 

GP 31
Windows SharePoint Services 30

servers
effect of restarting 145
load balancing 147
moving to server farm 163
performance 147
SharePoint performance 145

setup
adding users to MBF roles 43
adding users to SharePoint groups 40
Business Data Catalog 117
checklist for Business Portal 18
creating MBF queries 69
creating MBF roles 51
creating pages 135
creating sites 135
general settings 21
managing content 14
modifying MBF role permissions 53
modifying navigation 136
planning content 17
Search

activating Search 125
crawl account data access 123
securing data 128

sharing MBF queries 78
SharePoint, see Windows SharePoint 

Services
SharePoint groups

default permissions 167
BP Accounting Specialist 167
BP Administrator 167
BP Employee 167
BP Executive 168
BP Executive Reports 168
BP Field Service Reports 168
BP Financial Reports 168

SharePoint groups (continued)
default permissions 167

BP HR Administrator 168
BP Human Resources Reports 

169
BP Internal User 169
BP Inventory Manager 169
BP Inventory Reports 169
BP Manager 169
BP Manufacturing Reports 170
BP Operations Manager 170
BP Order Entry Clerk 171
BP Payroll Administrator 171
BP Payroll Reports 171
BP Production Manager 172
BP Purchasing Manager 172
BP Purchasing Reports 172
BP Report Publisher 172
BP Reports Catalog 

Administrator 172
BP Sales Manager 173
BP Sales Reports 173
BP Salesperson 174

for Report Center security 107
SharePoint web parts, removing 96
simple list web part

communication behaviors 94
overview 85

site collections, explained 35
sites

Business Portal site structure 10
creating 135
how the site collection affects 

Business Portal 35
removing access 136

SMTP server, specifying 21
socket address error, troubleshooting 149
SQL, see Microsoft SQL Server
standard connection method, overview 84
starting Business Portal 18
status area, result viewer web parts 89
style sheets, for result viewer web parts 89
subscribing

setting up for result viewers 94
web part behaviors 94

substitutions, using in notification 
messages 25

support, obtaining 4
surveys

creating web parts 90
using in Business Portal 15

symbols, used in manual 3

T
tab web parts

configuring 91
removing 96

tasks, changing in web parts 90
technical support, obtaining 4
templates

for notification messages 25

templates (continued)
modifying notifications 25

Terminal Services, setting up in Business 
Portal 21

time-out value, extending for queries 150
Top 5 Reports web part, described 102
top link bar, explained 11
troubleshooting

administration pages unavailable 154
changing passwords for system 

accounts 153
disabling SSL 160
displaying domains in Add Users 

wizard 150
enabling SSL 157
moved databases 163
query performance 144, 150
repairing Business Portal files 155
repairing queries 61
repairing SQL objects 155
report viewing in Reports Catalog 102
report viewing in the Report Center 

107
socket address error 149
unexpected error when logging on 

149

U
unexpected error, causes 149
uninstalling, Business Portal 156
URL, for Business Portal 18
user groups, see SharePoint groups
User role, permissions 185
users

adding to MBF roles 43
adding to SharePoint groups 40
changing MBF role assignments 47
external 138
mapping to back office IDs in MBF 50
mapping to back office IDs in web 

services 64
matching to IDs 45
modifying data permission 

assignments 48
modifying for a web service role 63
modifying for an MBF role 52
modifying in MBF 46
permissions to reports in Reports 

Catalog 102
permissions to reports in the Report 

Center 107
removing from MBF 48
setup checklist 32

V
variables

using in notification messages 25
using in queries 71

Vendor role, permissions 190
virus-protection software, effect on 

performance 146
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web address, for Business Portal 18
web pages, see pages
web parts

see also  result viewer web parts
adding to a page 85
back office tasks 90
business data web parts 115
configuring Dynamics GP report 

viewers 93
configuring result viewers 89
configuring SharePoint web parts 90
configuring tab web parts 91
connecting result viewers 94
connections overview 84
deleting 96
effect on performance 144
exporting 96
gallery 84
minimizing 96
modifying 96
overview 83
publishers and subscribers 87
query menu 73
removing 96
retrieving closed web parts 97
Top 5 Reports 102

web servers
effect of restarting 145
load balancing 147
performance 147
SharePoint performance 145

Web Services for Microsoft Dynamics GP
assigning users to back office IDs 64
changing users assigned to a role 63
security overview 31

web sites, moving to server farm 163
Windows SharePoint Services

adding users to groups 40
alerts 15
changing password for user account 

153
groups overview 39
moving to server farm 163
performance 145
permission levels overview 40
security overview 30
viewing or modifying groups 41

workstations
hardware 147
performance 145
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